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FOR OUR SECURITY special last
month, we decided to conduct a little
social experiment. We added in a little
box on page 45 called “A forward you
should ignore”, which basically told you
that there was a way that you could get
Gmail passwords of other people.

There are several reasons why this
experiment should have failed:
1. The title of the box seemed
descriptive enough.
2. The article it appeared in was about
“social engineering”.
3. The entire magazine was centered
around “Security”.
4. It was in Digit, and our readers are
supposed to be “tech gurus”.

As of last count, over 1,100 people
had happily parted with their own
password, to try and get into someone
else’s account — with the number
increasing on a daily basis, this is hard-
ly a failed experiment.

So here I am, sitting with over 1000
passwords, and potential access to a lot
of your personal information. Although
I’m not voyeuristic (and am not going to
access your mail), all those of you who
have sent me your passwords, are cer-
tainly quite the opposite.

Since I had to put your passwords
to some good use, I decided to do a lit-
tle data mining...

The very first trend that emerged,
was that most of the respondents
were male, and looking for passwords
of females — so basically, a bunch of
voyeurs, or stalkers. We even got a few
dozen women looking for passwords
of male friends, so apparently stalk-
ing isn’t gender-specific. It’s also quite
apparent that no one really cares that
hacking someone else’s email
account is illegal — fines, jail terms,
that kind of illegal.

It’s not just about snooping either;
I found that most of you use really
poor passwords. Simple keyboard com-
binations like “qwerty”, “123456” and
“abcdefg” were common enough to
upset me. What’s worse, a few people

were actually silly enough to put “pass-
word” as their password!

Almost all of the passwords used
were under 8 characters long. Though it
was quite interesting to note that a few
of you were smart enough to use strong
passwords — over 8 characters, with
upper and lowercase letters, numbers
and even punctuations — but dumb
enough to fall for our little prank.

The most ridiculous trend was that
between 10 and 15 per cent of you were
using your mobile numbers as your
passwords — so anyone who has ever
called you could potentially hack into
your account. Also, some people used
their own names, or their postal codes.

A lot of guys out there seem to
use girls’ names as their passwords,
and of those, surprisingly, only about
10 per cent were looking for pass-
words for that same girl’s account.
Interestingly, an equal amount were
looking for the password to a differ-
ent girl’s account — you two-timers,
you know who you are.

Although fewer in number, the
girls were more faithful, with most of
the girls who had a boy’s name as their
password, looking for that same boy’s
login details — perhaps suspicious of
the two-timing guys mentioned above?

Celebrity names were quite com-
monly used as passwords, with Aamir
Khan and John Abraham being the
most popular. Religious terms were
also popular passwords, though
being caught trying to hack anoth-
er’s account is hardly ethical, let
alone religious.

“Syncmaster” seems to be a pop-
ular monitor model, with enough of
you using it as a password to get
noticed. A few of you had “thinkdig-
it” as your password, and we’re flat-
tered. One password actually read
“iamaloser”.

Quite a few of you got conned by
our little ruse, and tried to regain
access to accounts that you had for-
gotten the passwords to, so we’ll be a

little less harsh on you, but you
should realise that what you did
could have lost you another account.

So what does all this tell me?
From where I sit, a lot of us Indians

seem to be inquisitive — bordering on
voyeuristic. Perhaps that’s why I know
of women on our Thinkdigit forum
who prefer to pose as men, just so they
won’t get harassed. In this particular
case, it doesn’t seem like the women
are any less voyeuristic though.

I suppose I should be thankful
that less than 1 per cent of our read-
ership has fallen prey to this so far,
but with millions of hoax mails reach-
ing that same number on a regular
basis, even a few thousand victims is
cause for concern. Get your act togeth-
er people — re-read our last month’s
issue if necessary, but secure yourself
from your own gullibility.

Editorial

Robert Sovereign-Smith, Editor

Shame on you

“...no one really cares that
hacking someone else’s

email account is illegal —
fines, jail terms, that kind

of illegal.”

editor@thinkdigit.com
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MULTIMEDIA
Camstudio 2.5

This software is able to record all
screen and audio activity and create
industry-standard AVI video files and
SWF files

ID3 Renamer 3.0

Do you have loads of MP3 files in a
directory and need to write a single
common piece of information into
them ? Do you need to clean some
portion of the ID3 tag? Do you need
to remove the diacritics? ID3
Renamer can help.

� AfreecodecVT 2.0.88
� AIMP Classic 2.50 Build 320
� Any Video Converter 2.6.7
� Audioblast
� ATI Multimedia Center 9.16
� AviDemux 2.4.3 r4532 Beta
� Camtasia Studio 6.0.1 Build 782
� DarkWave Studio 2.4
� Dizzler Beta
� DownUtube
� DVD Flick 1.3.0.4
� Evan's AVI Screen Capture 0.2.0.0
� FAVC 1.07
� GB-PVR 1.3.7
� Gom Player 2.1.14.4525
� HandBrake 0.9.3
� ID3 Renamer 3.0
� iTunes 8.0.2.20
� KMPlayer 2.9.4.1434 Beta
� Media Graveyard 11.0
� MediaPortal 1.0
� MP3 Repair Tool 1.5
� MPEG Streamclip 1.2 Beta 2
� MPlayer for Windows (Full Package)

2008-12-11 Build 44
� Picasa for Windows
� QuickCam 1.0
� Real Alternative 1.9.0
� Soundbase 2008.12.18
� Stoik Video Converter
� taksi 0.7.5.7 beta
� TVersity Media Server
� Virtual VCR 2.6.9
� VirtualDub
� YamiPod 1.7

INTERNET
Poderosa 4.1.0
Poderosa is a tabbed terminal
emulator for Windows.

� SeaMonkey 1.1.14
� 2hotspot 1.4.0.7 Beta 4
� 3d Traceroute 2.4.39.2
� AllegroSurf 8.1.0.6
� BVRP Connection Manager Lite 1.0
� Dial-Up Optimiser 1.0
� FastNet99 4.3
� FeedFusion 0.92
� FreeProxy 3.92
� HappyFish 1.5.0.2
� Hitware Popup Killer Lite
� Hotspot Shield 1.06
� JDVoiceMail
� KidRocket
� LockJar
� NetAnts 1.25
� Netlimiter 2.0.10 Pro
� Poderosa 4.1.0
� Rss Bandit 1.8.0.870
� Skype for Windows
� Star Downloader 1.45
� SySpeed 2.1.01
� Transmute
� WebRipper
� WiFi SiStr 1.0.2678.17860
� WinHTTrack

SYSTEM
� Access Manager 2.1.58
� Cobian Backup 9.5.0.201
� DirSyncPro 1.0
� EraseTemp
� Filemon
� FileZilla v3 for Windows
� FreeFileSync 1.13
� lastpass 1.43 RC2
� Password Generator Pro 2008 1.4.02
� Process Explorer
� Universal Extractor
� VirtualBox 2.1.0
� Windows XP Pro Startup Disk

ESSENTIALS
� .net Framework 2.0
� .net Framework 3.5
� µTorrent 1.8.1
� Avast Home Edition 4.8
� Comodo Internet Security Pro

3.5.55810.432
� Foxit Reader 3.0
� Free Download Manager 2.5

build 758
� Irfan View 4.20
� Java(TM) 2 Runtime
� K-Lite Mega Codec Pack FULL 4.2.5
� Opera 9.6
� Silverlight
� Spybot Search and Destroy 1.6.0
� VLC Player 0.9.4
� WinRAR 3.80

UPDATES AND ADD-ONS
� Adobe Shockwave
� Avast Update
� AVG Update
� Java runtime update
� Kaspersky definition Update
� Norton Internet security update
� Spybot updates

Tools
PROGRAMMING
Visual Studio Express
Edition with SP1

The Visual Studio 2008 Express
Editions DVD will let you install the
following products: Visual Basic 2008
Express Edition, Visual Web Developer
2008 Express Edition, Visual C# 2008
Express Edition, Visual C++ 2008
Express Edition, Popfly, SQL Server
2005 Express Edition, SQL Server
Express, SQL Server Compact Edition.

� DEV-C++ 4.9.9.2
� MPSKWIN(IQ) 1.2
� Plotter 2.5.1
� Snippet Compiler 3.0.2

OFFICE
Dooble

Dooble is a Secure and Open Source
Web Browser that provides solid per-
formance, stability, and cross-platform
functionality

� BillQuick Lite 2008
� Jarte 3.3
� Microsoft Office Word Viewer 2003
� SmartDraw 2009
� Static Thunderbird Backup Free 2.8d
� EScan 10

CELLPHONE
Nokia PC Suite 7.1.18.0
Final

Free applications for Nokia phones that
lets you edit, synchronize and back up
many of your phone's files

� Nokia Synchronization 1.0.29
� Samsung PC Studio 3.2.1 GL6
� Sony Ericsson PC Suite 4.006

Productivity

Gaming
GAMES
BMW M3 Challenge

Start the ignition to see just what the
V8 high-rev engine is capable of. Shift
up through the gears to propel the
BMW M3 Coupé forwards as it
constantly pushes the boundaries of
driving pleasure even further. Brake

as you approach the first bend but
keep your steering tight, you don't
want to lose your advantage.

� Frets on Fire
� Gunbound
� HURRICAN

TRAILERS
Killzone 2
They said the morale of the Helghast
was at an all-time low, they were
dead wrong.

� Scorched 3D
� The Babylon Project 3.4b (Final)
� Tyrian 2000
� Ur-Quan Masters

OFFICE
MolliAdress

MolliAdress ist a professional
database program, to work with
adresses. The adressprogram is
written in Delphi, lazarus for linux.

� Bank Tao bank statement management
tool 1.1

� Bean Sheet 1.0.5

� CleanSheets
� eOfficeWare
� Icalc 0.1.2
� Matrex 1.3
� OBPM
� pdf2oo
� pyspread 0.0.10a
� Retromessenger-V0.2
� webxelleditor - v0.1.5
� XSheet
� ZK Spreadsheet 1.0.0-RC1

CREATE
� Asymptote 1.56
� DiscWrapper 1.1.0
� GTK+ collage 0.3
� GTKRawGallery 0.9.3
� LaTeXDraw 2.0.2
� Tint Photo Editor 1.0.1

DISTROS
� Open Suse 11.1
� Linux Mint 6

February 2009

Contents InteractiveContents Interactive

Entertainment
HD TRAILERS
Che

November 26, 1956; led by Fidel
Castro (Demian Bichir), a band of 80
rebels sails to Cuba. Among these
young rebels is Argentine physician,
Marxist, soldier, Ernesto “Che”
Guevara (Benicio Del Toro).

� Coraline

Fighting

A small-town boy with a natural
talent for street fighting becomes a
star brawler on the bare-knuckle
circuit, but soon realizes the dark
world he's entered may be impossible
to escape.

� Friday the 13th
� Night at the Museum: Battle of the

Smithsonian
� The Curious Case of Benjamin Button
� The Last House On the Left
� Valkyrie
� X-Men Origins: Wolverine

MOVIES
Death Rides a Horse

As a child, Bill witnesses the murder
of his family by four robbers. Fifteen
years later, he embarks on his
revenge...

� Jack and the Beanstalk
� Zeitgeist: Addendum

MUSIC
Galdson – Roots

Classical piano instrumental free
Music Album from Jamendo

NIN – The Slip
Nin Inch Nail's latest DRM free album,
the Slip.

� Do-Up – Acoustic Lounge
� Equals Conquest – Manifest Destiny
� Esgi – Echoes in Time
� JT Bruce – The Dreamer's Paradox
� Lull – Duo Acoustique

By Demand
MULTIMEDIA
DAEMON Tools 4.12.4

DAEMON Tools is an advanced
application for Microsoft Windows
which provides THE best optical
media emulation in the industry.

� Catalencoder 1.1 (French Only) / 0.7.9
� Floola for Windows 3.2
� Foxit PDF Reader 3.0 Build 1301
� Gizmo Project for Windows 4.0.3.383
� JetPhoto Studio 4.1.0
� K-MeleonCCF ME 0.09 Final

MAME 0.126

MAME stands for Multiple Arcade
Machine Emulator. When used in
conjunction with images of the
original arcade game's ROM and
disk data, MAME attempts to
reproduce that game as faithfully as
possible on a more modern general-
purpose computer. MAME can
currently emulate several thousand
different classic arcade video games
from the late 1970s through the
modern era.

� Visions 1.0.1.1613
� Windows Live Photo Gallery 2009

Build 14.0.8051.1204
� XNView
� Zune Software
� Beauty Pilot 1.10
� Maya
� Xilisoft Video Cutter 1.0.27.0307

DRIVERS
� Ati Graphics Card Drivers
� Creative Sound Card Drivers
� Nvidia Graphics Card Drivers
� Realtek Sound Card Drivers
� Driver Detective

DISTROS
� Fedora 10
� Vector Linux 6.0

Linux
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Learn one at a time. As for
software, ALL distros have
same set of software available.

I suggest keeping ubuntu
for some time longer and then
getting fedora next year after a
few months.

Keeping two distros on
same PC at a time would also
kill your internet connection.
Lots to download if you want
to keep both updated.

Linux Mint is best said as
Ubuntu for the casual user.
Don't consider it now that you
installed Ubuntu. Its pointless
now to install it. You would
learn much faster with

ubuntu.
And OpenBSD is not linux.

Its a BSD. Definitely not
recommended at this stage.
You have a long way to go
before you can find OpenBSD
comfortable to use. First learn
Linux.

Most collages are now
teaching Linux instead of Unix
and most Unix commands
work on Linux. However, if you
are one of the unlucky few
who need to learn using Unix,
the only 100% Unix compatible
OS which is free to use is Sun
Microsystems' Solaris OS. Its
not too hard to use BTW.

One of the basic things
everyone needs to learn is how
to compile your own kernel. Its
actually much much easier
than it sounds. You basically
need to scroll between
hundreds of options and
choose add, discard or
modulize. I recommend
modulizing whenever possible
and if some feature is
SERIOUSLY USELESS then
discard it. You get to optimise
the kernel for several things,
like support for upto 16GB
RAM on 32bit OS, no. of cores,
etc. Then compile using a
ready-made script.

Quite a simple job, but
irritates the hell out of you
and needs HUGE amount of
PATIENCE to read all those
descriptions.

Luckily, you get to do the
configuring in parts, and for a
guy who lacks patience, it may
take a whole week of 1 hour
long sittings. But if you are a
real gandhi, you can do it in a
single sitting. Experts don't
need to READ the descriptions
so it takes them only a few
minutes.

Before that, you need to
set your cflags right.

MetalheadGa
utham

Genuine Linux
User
[apple.jpg] 
Join Date: Sep
2007
Location:
Gotham City
Posts: 5,371

Re: which distro is well suited for study purpose? I mean for learning a Linux system.

A quick and easy registration
process that gives you access
to all the goodness on offer

Download only the
best software on
the Net

Read the best tech blogs
and submit and share
your own blog with
others

Find the best
product reviews
online, from the
Digit Test Centre

Interesting and
exciting videos
from across the
globe

Buy and sell tech products to
people from all over India at
our Digital Marketplace

India’s largest and
most influential
tech community can
be found on our
forum

Buy older issues
of your
favourite
technology
magazine online

Experts at the Tech
Q&A section
answers all those
niggling problems

Y O U R  T E C H N O L O G Y  N A V I G A T O R
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‘person’ than a service.
Currently the Pre is not
available in GSM version but
Palm is expected to
announce a GSM/UMTS
model for Europe and Asia
in mid-February. We’re
certainly eagerly awaiting it.

THE CLONE

MSI X320

Why this particular
notebook? Because
it’s the MacBook

Air’s twin. And a not so
pricey twin at that. While
the Macbook air will set you
back by $1600 this ultra
thin notebook’s price range
is from $800-$1,000. Still,
there is more to this utra-
thin notebook than just the
price. It’s not a cheap
knockoff. The X320, like the
Air, has an all-aluminium
body. It weighs, in-fact, a
little less than the Air; its
LED screen is not different
from the Mac Air, with a
screen resolution of
1,366x768 and a 16:9 form
factor. Where it differs is in
the keyboard and touch
pad. The keyboard does not
follow the isolated style of
the Air and of course there
are no gesture capabilities
on the touch-pad such as
pinching and three finger
swiping etc. Yet, some of the
X320’s features can actually
make the Air squirm. For
instance a total of three
USB ports. VGA and

Ethernet ports are built in,
and so are the SD slot and
webcam. The hard drive is
160 GB but expandable to
250 GB. There’s no internal
3G wireless, but Bluetooth
and Wi-Fi are present. MSI
claims the four cell battery
will give you 10 hours of
battery life, which will have
to be put to test. But fact
remains this is the closest
thing to a Mac without it
really being a Mac.

THE STUDIO NOTEBOOK

DELL XPS 16

Dell has positioned
this notebook as a
very high end

lifestyle product, for the
discerning consumer who
wants style, power and a
little bit of prestige that
comes along with owning a
pc like this. Many
manufacturers are currently
offering near desktop
configs in portable laptops,
be it 4gigs of RAM, home-
theater features, and big
screens. But dell has upped
the ante with its stunning
design and inbuilt
technology, while of course
keeping up with all other
specs. Take the screen for
instance; a 16 inch RGB LED
widescreen with a 1080p
resolution — perhaps a
graphics professionals
dream. Its bundled with a
blue ray reader and an HDMI
port. The XPS 16 doesn’t

come cheap; you’ll have to
shell out Rs. 90k
to own this bad
boy. Good bang
for the buck.

THERE WERE OTHER PHONES
TOO YOU KNOW

Mobinnova
Ice Phone

Though most of the
action was going on at
the Palm Pre booth,

another interesting handset
found on the show floor
was the Mobinnova Ice. It
looks quite funky with a
complete black body with
no visible buttons when it’s
off. So in effect it looks like
a big black shiny box until
you start operating it.
Everything on the front is
touch-sensitive and only
lights up as needed. Its got
a 3 inch 240x400 touch
screen, and the control
buttons next to the main
screen. The phone gives a
vibration feedback when
you touch buttons, so you
know what you’ve touched.
It runs Windows Mobile 6.1
Professional on a 528 MHz
Qualcomm 7201A processor
and has your standard 3G,
GPS, Wi-Fi, Bluetooth, a 3-
megapixel camera, TV out,
an FM radio and an
accelerometer.

THE TABLET NETBOOK

ASUS EEE
T101H and
EEE T91

ASUS, who probably
started the whole
Netbook craze with

its EEE PC, is nowhere close
to being overrun by
competitors in the fray. To
prove this point it
introduced its newest

Security Watch

Downadup worm
wrecking havoc

A worm by the name of
Win32.Worm.Downadup.B.
is fast spreading across the
net. Within four days, it
infected four times the
numbers of computers it
was on. The rapid spread is
because the worm skirts
around AV software by
using rarely-used APIs in
the system. The worm hides
in a folder in the recycle
bin, and updates itself by
checking upto 250
randomly generated
domain names, which have
componants.
The safest way to prevent
the spread of this particular
worm is to not switch USB
drives between computers.
If your USB drive has a
mysterious recycle bin
folder, there is a good
chance that you have this
worm. Keep your work USB
drives seperate from the
ones for personal use to
prevent either your
workplace or your home
computer from being
infected.
Microsoft has released a
patch, but the fix itself was
faulty.
The worm affects XP,
Windows 2000 and
Windows Server 2003.
There are no workarounds
as yet. The worm is
spreading by exploiting
multiple systemic
weaknesses, including weak
passwords. The worm
restricts some traffic (like
system updates), but is
otherwise not involved in
any malicious activity. The
main threat at this point of
time is the worm allowing
computers to be used by a
botnet. These can be used
to send spam for example.
Downadup is also known as
Conficker and Kido.

world print advertising � Qualcomm buys mobile technology from AMD, $65 million gets exchanged — in cash
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ULTRA PORTABLE NETBOOK

Sony Vaio P

It’s not a Netbook — and
don’t you forget it. Sony
calls their nifty little

device a Pocket Style PC. It’s
an ultra thin, 594 grams
fully functional PC. It was
one of the hottest item
numbers in Vegas and we
got our hand on one when
we were invited for its India

Launch. The India product
head for Vaio pulled a
familiar stunt by pulling
out the device from his
jacket pocket. But believe us
this is no stunt — it can
comfortably slip into a coat
pocket. The device is as
small as a PC can get
without compromising on
usability. Its got a 8-inch
ultra wide screen with a
stunning 1600 x 768 display,
and 2 gigs RAM which is
more than enough to allow
the preinstalled Vista OS to
not choke. Initially because
of its small size we were
sceptical about whether one

can really use the keyboard
comfortably. But Sony has
engaged in some good re-
engineering there; they’ve
got rid of the touch pad and
put in a ThinkPad style ‘dot’
to operate the cursor. The
additional space created is
engulfed by the keyboard,
making it 92 per cent of a
full size notebook keyboard.
Numbers aside, it’s very
easy to use with both hands
(unless of course you’ve got

sumo fingers) and the
tactile feedback is good.

Why is the Netbook tag
blasphemy? Sony says this is
because theirs is a fully
functional PC with no
compromises like other
Netbooks. We say it’s
because of the price. The
two variants to be available
in India will be priced
around Rs. 49,990 and
Rs. 64,990. The difference in
both models is in the
processor and the Version of
Vista. The higher variant
(P15) is based on the Atom
Z530 1.6 GHz processor,
while the lower P13 has a

Z520 1.33 GHz processor.
The P has a lot of little

features added to make it
even more easy to use than
it already is. If boot time is
a concern it launched into a
Linux based Cross Media
Bar within 20 seconds,
which lets you access
mostly everything you want
including internet access,
email, music, and photos.
Then there is the Window
arrangement utility button
which quickly arranges all
open windows side by side.
Plus the wide screen
actually lets you
comfortably work on both
windows. So no more alt-
tabbing. Sony has also
thrown in noise cancelling
in-earphones and
apparently the noise
cancelling circuitry is in the
Netbook... err... notebook
itself. With a supposed
battery life of 3 hours it’s
something that a lot of
people ought to be looking
forward to in 2009.

IPHONE KILLER?

Palm Pre

Perhaps the first real
iPhone killer, the Palm
Pre is being talked

about as the hottest product
of CES 2009. Its small, light,
has an intuitive touch
screen, but best of all its got
a neatly tucked in sliding
full qwerty keyboard! The
lack of a keyboard is the
most common complaint of

iPhone critics. The phone
comes with a 3.1 inch
multitouch display with a
resolution of 320 x 480. It
runs on Palm’s new webOS,
which from a usability
standpoint appears to be
top-notch. Its not at all
sluggish and seamlessly
floats from one ap (or ‘card’
as they call it) to another.
Still it remains somewhat of
a mystery as reportedly the
palm representatives were
quite cagey about handing
over the phone to people for
too long. Understandable,
since the phone is Palm’s
ticket for a big comeback,
after their sales plummeted
drastically over the years.
Overall the phone looks
pretty good and the slight
bend the keyboard offers
will definitely help in its
basic function — talking.
Another area where it scores
over the iPhone is the
camera. Its got a 3
megapixel camera with LED
flash. The touch screen has
its own motion--specific
commands. For instance to
close an application just
flick it upwards. What
about independent aps? As
of now there aren’t any but
the webOS allows
development in Javascript,
HTML and CSS. Other tid-
bits include incredible web
integration with services
such as Facebook and
Microsoft exchange. It
follows a unique form of
collecting info like mail,
messages, chats, around a

Enter

� Goolge replaced as best company to work for by NetApp in Fortune’s list � Mac turns 25 � Google discontinues its project on real

Like always, the Consumer Electronics Show this year had a
whole plethora of products; some were impressive and some
were absolutely jaw-dropping. Well some were weird but we’ll

get to them later. The two noticeable trends were ‘small is
beautiful’ and ‘low-cost’; the latter being quite in line with the
general economic climate. The flashy larger-than-life stuff was

there but a fair bit of emphasis was on consumer models than
prototypes. We saw the lines between Netbook, Notebook and
Ultra-portable blurring and hi-end camera’s becoming
unimaginably small. Now that the dust has settled its time for us to
sieve through the chaff and give you a round up of things that
caught out attention.
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convertible tablet PCs, the
ASUS EEE T91 and the EEE
T101H. Both essentially just
versions of each other, one
comes with 8.9-inch and
while the other with a 10-
inch screen respectively.
Both have a hinge swivel to
turn the display around and
lay it back on top of the
keyboard. They run a Linux-
based OS, but will probably
have enough juice to handle
XP. Not much about the
device is known but it is
speculated that
specifications will be
somewhere close to being in
the Netbook range.

TINY CAMERA

Casio Exilim
EX-FS10

Apint sized but
powerful 9 meagpixel
camera with the

ability to shoot up to 30fps
in burst mode, a speed
faster than a typical SLR.
The camera is even capable
of high speed video

recording with the ability
to shoot up to 1,000fps slow
motion video. A perfect
example of gadgets going
smaller without
compromising on anything.
The Exilim is equipped with
21 Best Shot (BS) modes,
including Multi-Motion
Image and High-Speed Best
Selection. There’s also a Pre-
Record function, YouTube
Capture mode and Lag
Correction, which comes to
the aid of those who are
slow to hit the shutter
button. Speaking of the
shutter, the camera is
extremely silent. Its got a
slow motion viewing mode
so you can capture the
screen shot of exactly the

fame you want while
viewing it on its 2.5 inch
LCD. Its got additional
features like 3x optical
zoom, 720P HD video
recording, Face Detection
and High-Speed Night Scene
mode but strangely lacks
image stabilisation.

EASY TO USE

Asus Eee Top

Its Asus again and their
EEE line up seems to be
getting increasingly

meatier and not to
mention more interesting.
This latest device is a 15
inch touchscreen desktop
pc. It has a special

Windows simplified
interface that allows for
easy touch operation and
big icons for the err simple
user. It also has Express
Gate, which is an instant
boot utility. It allows the
1.6GHz, 1GB RAM, 160GB
hard drive machine to
instantly boot up showing
only Firefox, Adobe Flash,
Skype, and a photo viewer
so the user has instant
access to almost all basic
functions. The best part is
— its slated to retail at only
$400. Good to have around
the house don’t u think?

FOR USE IN BED

The Choiix
Ucool
notebook
pad

There’s no place for a
laptop in between the
sheets right? But

people use their notebooks
just about everywhere,

A Round-up Of Technology News From Across The GlobeThe Digital World

US
New York city
gives Touris-ts
high tech
information
center based on
Google Maps

GERMANY
Supercomputers from
Germany become
environmentally
sustainable

AUSTRALIA
Linus Trovalds shaves
Bdale Garbee’s beard
to raise money for
preservation of the
Tasmanian Devil

JAPAN
Tmusk unveils
Robocop style
security robot
controlled by mobile
phoneINDIA

Ghajini inspired 3D
video game, dubiously
dubbed indias first,
hits the markets

SPAIN
Spain’s Prado
museum displays
its art through
Google Earth

MIDDLE EAST
Cellphones are
being used for
propoganda in
Gaza and Israel

� Dell XPS laptops to ship with 356 GB solid state drives � Video Games in the US to have health advisories, similar to cigarette packs

CHINA
The online population of
China reaches 3 million
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including the bedroom. So
often you’d be sitting in
bed with your laptop on a
pillow or precariously
balancing it on you lap in
weird kamasutra-like poses,
wondering there must be a
better way. Well there is.
The Choiix Ucool notebook
pad is designed specifically
for this purpose. Available
in your choice of blue,
black, or green, it is an
ergonomically designed
pad for when you want to
use your laptop in bed or
on the couch. The curvy
design allows for adequate
airflow beneath your
notebook and, at the same
time, the Ucool is stiff
enough to provide
sufficient support.

THE WEIRD STUFF

Neutrano’s
Wrist phone

Every tech show
apparently must have
a wristwatch phone.

Like some sort of a James
Bond fantasy that must be
fulfilled. This is the kind of
gadget we were referring to
when we said you will find
products at CES that’ll make
you wonder if they really are
useful. Nevertheless they are
hi-tech. This piece of spy
inspired equipment looks
like a standard chunky black
watch but has a 1.4-inch,
160x128 TFT LCD
touchscreen. A standard
phone keypad curves
halfway over the wrist band
while there is a speaker over
the screen. It has a media
player, 4 GB of space and fm
and all that kind of guy
stuff but at a price tag of
$250-300, we seriously
wonder if anyone will
willingly pick it up. Another
notable mention in this
category is the LG GD910
Watch Phone.

� Facebook starts allowing members to use its own markup language � Apple announces spectacular profit of $10 billion in the last quarter

A PHONE?

A Projector?

Everything seems to be
fusing with phones at
CES 2009. The latest to

follow the trend is the Logic
Bolt. Logic Wireless the
company behind the phone
claims it can project a two-
hour movie on a 36-64 inch
screen! And from almost
any source, including an
XBox or Nintendo Wii. The
phone uses an LCoS (liquid
crystal on silicon) projector
with an LED backlight. The
phone also has a 320x240
touch screen and a 3
megapixel camera. The
most interesting part, apart
from the projection
capabilities, is the fact that
it will be sold subsidized by
T-Mobile for $100. Lets make
a note about this one and
keep an eye on its
development.

LETS ROCK

Guitar Hero
Platform

Ace Bayou showcased
a specialized
wireless Guitar Hero

platform that vibrates and

surrounds you with some
rocking tunes out of its
built-in speakers. The
vibration will surely rock
your world. But the only
trouble is that it’s a 2
square feet platform, so
you can’t go Ac/Dc on it —
meaning if your style is to
jump around all over the
stage- you can’t. Other
than that it should be a
fun device for all the
wannabe guitar heroes out
there.

BLU-RAY NOW WITHIN REACH

VBR100

It’s a Blu-ray player. So
why is it being featured
here? For its affordable

under $150 price tag. The
player is being launched
as a part of Vizio’s effort
to bring Blu-ray to a wider
audience.

This is certainly good
news, because it looks like
the gap between DVD’s
and Blu-ray is narrowing.
A lower price will even
benefit Blu-ray disk sales.
But coming back to the
VBR 100 its low price
doesn’t appear to sacrifice
much in the way of
features.

The player provides 7.1-
channel analogue output
(using a 108MHz/11-bit
Digital to analogue
converter) and full
decoding support for
Dolby TrueHD, DTS-HD
Master Audio, and PCM
lossless audio formats as
well as common audio
formats including Dolby
Digital, Dolby Digital Plus,
and DTS. It will also
function as DVD player
capable of providing up to
1080p video output via its
HDMI port. It doesn’t look
too bad either with its
illuminated touch-
sensitive front panel
controls.

FROM LCD TO LED

Samsung
8000 Series
240-Hz LED
HDTV

Samsung wants to
focus on LED TV as its
new growth engine in

2009. So although it
showcased a whole lot of
home theater products at
CES 09, it has put a lot of
emphasis on its 8000 Series
of energy-efficient, mega-
fast-motion-capable 240Hz
LED-based 1080p HDTVs.
LEDs offer higher contrast
ratios, slimmer designs,
and lower power
consumption as compared
to the regular LCDs. The
most interesting aspect of
the 8000 series is its 240Hz
technology.

The cutting-edge “Auto
Motion Plus” technology
promises enhanced picture
quality even with lightning-
fast action scenes. It will be
available in 46 and 55 inch
variants. Its other features
include “Ultra Clear Panel”
for reduced reflection and
increased perceived
contrast which should give
u great contrast even in
bright light. The screens
are to include built-in
Ethernet along with Wi-Fi
capability so that it
displays widget-based
content from Yahoo, Flickr,
and other Web sites can be
displayed through its
propriety “internet@tv”
service.

COMPETITION FOR THE I-POD

Samsung P3

The Samsung p3
player tries to give
you something that

most touch based devices
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lack. A tactile response or
feedback like on a
keyboard. The P3, available
in 8, 16, and 32GB,
features “haptic feedback”
which means when you
press its 3-inch TFT LCD
you get a vibration
response.

It’s a direct competitor
to iPod touch which has
no such feature. The
screen has a true 16:9
aspect ratio, which serves
up video at 30 frames per
second.

It plays and reads
almost everything
including MPEG4, WMV,
WMA and MP3 for
audio, as well as JPEG and
TXT files.

It has fm and voice
recording but no internet
capabilities.

VoFi: VoFi stands for
Voice over IP over Wi-Fi.

This means using the Wi-Fi hotspots found around
major cities for making voice calls. While existing
software make this easily possible, VoFi
technology hopes to exploit the better sound

quality of Wi-Fi networks as compared to
traditional cell phone networks. What this means
for the user is a lot more of VoFi capable mobile
handsets coming into the market, which can
interface with both networks. Some phones, like
the G1 already have this capability.

Despite recession,
tech-related salaries
increased by 4.6%

in 2008

Job Cut counts:
Logitech — 600
Autodesk — 750

AMD — 1100
Sony — 2000

Motorola — 4000
Microsoft — 5000
Ericsson - 5000

Intel - 6000

VoFi

AMD announces
$1.4 Billion

losses

3% Global IT
business

predicted to fall
by in 2009

Venture capital
goes down to

$3.4 billion
in 2008 from
11.7 billion

in 2007

� Google lays of just 100 staff — all of them recruiters � USB 3.0 poised to outperform nextgen eSATA and FireWire

NOT FOR FUN

3D TV

Well 3d TVs have
been around for
quite some time

but the biggest complaint
is that they require those
annoying glassed. They’re
irritating and they make

THE BROWSER CAM

Sony
Cyber-Shot

Currently there are
very few Wi-fi
enabled camera’s out

there and none that come
with a built in browser. The
G3 then is the first Wi-Fi
camera with a built in web
browser. Now you can
access networks on the fly
and start uploading
pictures and video to
popular sharing sites as
soon as you click em. Sony’s
got its own “easy upload
home page” set up to make
the process simpler and has
partnered with YouTube,
Dailymotion, Picasa, and
Shutterfly. Features include
a slim build, a high-
resolution, 3.5-inch 16:9
touchscreen (with 921,000
pixels), 4 gigabytes of built-
in storage, a 4X optical
zoom and 10.1 megapixel
captures. Its Wi-Fi radio will
be compatible with
802.11b/g networks.

you look like a dork. But
finally there is a 3d screen
that doesn’t require them.
Lets define first what 3d
means. It doesn’t mean
effects that just create only
an illusion of depth like
your 3d wallpapers; it
means that things
occasionally do jump out
of the screen. But strangely
Alioscopy does not plan to
put the TV into the
obvious entertainment
application (for now).
They are looking into
using the technology in
medical applications
because you would be able
to view body systems in 3
dimensions.
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NOKIA

Bringing
developers
together

Ibelieve that in two
years time, many of you
would be sitting on

multi-million dollar
fortunes earned by your
ideas and innovations”,
said Kenny Mathers, Head,
Developer Relations,
Forum Nokia addressing a
packed audience at the
Nokia Developers
Conference 09, held at Taj
Residency in Bangalore on
the 20th January. The one
day event was attended by
over 550 people, including
developers, mobile
operators, industry
watchers, vendors, to
share their experiences
and explore the future of
possiblities and challenges
in the world mobile
market.

“Indian developers are
the most valued people in
the world. Their quality,
output and levels of
interest are amazing. They
are our partners as they

add value to Nokia’s
service and software
experience”, says Srikanth
Raju, Director and Head of
Product Marketing, Forum
Nokia.”The best way to
predict the future is to
invent it,” said Mahmood
Kalantar, inviting the
developers to take a
Customer Oriented
Approach to developing
mobile applications.
According to Kalantar, the
future of mobile operating
system is Symbian OS
which is Open Source and
developed not for profit by
an independent
foundation and its source
code is available from day
one. Annirudh Mathuria,
Vice President, Symbian
India, identified Massive
Data Holding, Graphic
experience, Power
Management and High
Speed Networking as the
major challenges for
technology developers
today. “As the bandwidth
increases, experience
changes. When people
start using more and more
data, operators can earn
greater revenue,” said
Annirudh while talking
about Symbian to the

Web 3.0
What is Web 3.0
The semantic web that has been
talked about for so long is one of
the central themes — basically
the machines understand human
needs better. The best way to
explain this is the music portal
Last.fm which throws up music
artists and bands similar to the
artists and bands you like.

Why do we need Web 3.0?
Web 1.0 was about information,
where users could go online and
access and download data. Web
2.0 was about production, users
would create and post content.
YouTube, blogging, Flickr were
all web 2.0 revolutions. Web 3.0
will go a step further, where the
internet can execute processes
and have practical applications.

When will it hit us?
Not soon. Web 3.0 will be
dependant on a lot of
technologies reaching their
maturity, which will not happen
for at least another two years.
The time period for Web 3.0 is
expected to be 2010 to 2020.

Where will its weight be felt?
The biggest change in Web 3.0
content will be the audiovisual
aspect. Text based web pages
will give way to high definition
audio and visual content. Some
experts are even talking about a
totally 3D web experience, a la
second life. Expect a much more
fluid interface to the web.

Which technologies are likely
to be used?
Dramatic improvements will be
seen in data interpretation, that
is how a website is parsed or
processed before being thrown
up to the user.

How will it benefit users?
Open standards, and APIs that
everyone can access are two
things people are talking about.
Online collaboration on projects
will become a mainstay.
Distribution of software and
games will become easier, and
cheaper. Multimedia sales may
shift completely to online
markets.

audience. Titled Infinite
Possibilities, the event
partners NAVTEQ unveiled
the LBS Challenge for
developers, an online
competition with over
US$5.25 million prize
money, in cash and data
licenses. “We have seen
the evolution of mobile
devices from Navigation to
User Generated Content in
the past 15 years.
Consumers are now
mature and demand more
personal security and eco
(-friendly) Applications,”
said Tom Tierney, Head of
Partner Alliances, NAVTEQ.
Digit Magazine was the
media partner at the event
also showcased
innovations by Nokia’s
partner developers. These
included Quillpad-a
language tool, Nano
Hanuman- an application
for remote controlling of
water pump sets, and
Maverick Secure Mobile —
a security application that
helps protect data, track
stolen devices, retrieve
phonebook and disable
stolen devices remotely
by working in a hidden
mode.

� Ebay’s income drops by 31 per cent � Microsoft donates code to the Apache open source project � Apple selling used products in China
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Ahmed Shaikh

We hate Microsoft for Windows Vista.
Here was an OS we were truly excited
for — DirectX 10 accelerated, vector

graphics, an all-new communications layer,
tweaks and rewrites at the kernel level, a new
interface — it promised all the right things. And
delivered little more than a badly-imple-
mented security feature (UAC), an Orb
where the Start button used to be,
a ridiculous enhancement to
[Alt] + [Tab] (seriously, who
uses the Flip 3D?), and a
Sidebar / Gadgets feature
copied from sundry, and
free, programs.

If you think we’re
being a little too hard
on Microsoft, then
right you are. After all,
we need to spend
almost an entire
month’s pay to
purchase Windows Vista
Ultimate Edition, and all
we got for it was a half-
decent game (Tinker), a
crash-happy feature
(DreamScene, a desktop back-
ground utility that was promptly
ripped and released for Windows
XP), and a bunch of stuff we don’t care
about (BitLocker, language packs, sound
schemes, poker)… So yeah, it’s personal.

Apparently, we’re not the only ones with
either disdain or apathy for Windows Vista —
market surveys by various organisations show
that Vista’s OS market share hovers around 20
per cent, as of December 2008… It’s a broken OS.

Fixing Vista
So Vista’s a wash. The consumers know it, and
Microsoft knows it (hence the Mojave experi-

ment and the “I am a PC” advertisements).
And so we have Windows 7. Microsoft’s
approach to this ‘new’ OS is clearly communi-
cated through the Windows 7 web site —
“Over the past few years, you’ve asked us to
make some changes to Windows…”, it says,
“We listened closely.” Windows 7, is thus, all
about fixing Vista.

What are these fixes? Most of the
changes can be summed up in one

word — streamlined. Windows 7 Beta
is a more refined and stream-

lined version of Vista. The
annoying UAC is significantly

less irritating now, to the
point of actually being
useful and not constant
mothering by an over-
bearing OS. Windows
itself makes better use
of some of the struc-
tural changes intro-
duced in Vista — Aero is
much more than a shiny
coat, Search is much

improved, network
management is a lot

simpler, bootup is faster,
Windows itself feels a lot

more snappier, copying of data
across media is no longer a chore,

and moreover Windows 7 Beta intro-
duces some welcome, and dare we say,

great changes to the Windows way of
getting things done.

While adding features, Windows 7 also
throws away some applications otherwise
bundled. Whether this is a fallout of their
legal escapades, we don’t know, but
Messenger, Mail, and Gallery are now moved
out of the Windows installation and packaged
separated under the Windows Live banner.
Hopefully, this will allow for greater innova-
tion from the Live team.
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of transluscent windows, each representing
either a new document or a new tab. So let’s
say you have four Word files open — this
feature will show you a preview of the four
and let you navigate to each tab or window
using the mouse. You can also minimise,
maximise and close a window using just this
preview, removing the need to [Alt]+[Tab] to
it.
3. Any program can be pinned to the taskbar.

This is similar to the Quick Launch feature of
past versions — but much more useful since a
pinned program can not only launch a
program, but also manage windows inside
that launched program. Think of pinning as
evolving the taskbar to a more dock-like
behaviour of OS X (or the sundry-free dock
applications available for Windows).

4. The pinning behaviour, when applied to
Windows Explorer, exposes another cool
feature — it lists your libraries. Why this is
welcome will become apparent when we talk
about libraries later.

5. Right-clicking on a pinned program pops up a
list of recently open / created documents
under that program — called a Jump List. This
is a truly great feature as you can now open
frequently used documents right from the
taskbar, instead of hunting for them under
Explorer or looking for them under a
program’s menu bar. Furthermore, each
recent item in Jump List can be pinned, so
you can quickly access important files by
pinning them down, even if it’s been a while
since you have opened them.

6. In some programs such as Windows Media
Player, you also see control overlays. You can
thus play / pause, rewind / forward music
without leaving your current application.

7. Other small changes include a thin vertical
bar on the extreme right of the task bar.
When you hover over this bar, Windows lets
you peek at your Desktop. Moving away
from the bar brings you back to your
current application. This is a quick method
of looking at gadgets that are now shown on
the desktop. The thicker taskbar also allows
for both date and time to be shown, about
time too…

Personally, the ability to pin a program
along with the History pop-up has completely
changed the way we use the Start Menu — in as
much as we rarely hit the Start button anymore.

Windows management
Some minor, but welcome changes to working
with open programs: (1) You can drag open
windows to the upper screen edge to maximise
it. Dragging it back to the centre of the screen
will restore the window (2) You can also drag a
window to the left of your screen to make it fill
the left half of your desktop. Ditto for the right

The Taskbar
Ever since Windows 95 introduced the taskbar
and the Start button, this central aspect to the
Windows interface hasn’t seen any substantial
changes. Windows Vista, of course, replaced
the rectangular “Start” area with just a spheri-
cal logo, and did little else. Windows 7 Beta
takes the taskbar to an all-new level, and it
does so by intelligently extending the current
functionality, not by introducing drastic
changes. The taskbar is now thicker, almost
twice the height of the older one. It also does
away with the labels for programs launched
(although this behavior can be changed).
Finally, it introduces several key changes to
how programs on the taskbar now work:

1. When a program is launched,
its icon appears on the taskbar.
The default behavior is without
labels. When you hover over an
icon, Windows 7 pops-up a
small snapshot of the app
(called a preview), moving the
mouse over this snapshot will
show a preview of that applica-
tion Window. Move the mouse
away, and the OS brings you
back to your currently active
application. This is a great way
to quickly peek into other
windows, without leaving the
current application.

2. Multiple windows of a
launched program (even tabs
for some supported apps) are
now grouped together under
the same icon in (1) above.
This is similar to the grouping
done by XP and Vista, but is a
much more elegant solution
based on how the group’s
elements are exposed on mouse-hover over
a launched program’s icon. It shows a row

Managing open Windows
using the taskbar

Windows Explorer recent
items and libraries
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pane and WMP will play a preview of that file —
only for music tracks.

Faster
Windows 7 Beta starts up faster — it also shuts
down and restarts faster than our Vista
Ultimate copy. Putting the Beta to sleep and
waking it up is also a much faster and stable
experience. This mantra of faster, extends to
the entire OS as well. Aero no longer feels slug-
gish to use. We’ve had mixed results copying
files across media — another common
complaint with Vista. At times, this is much
faster (took us an entire 120 seconds less to copy
8GB of files under Windows 7, as compared to
Vista). Similarly, it feels just as slow (note that
the latter is not a scientific conclusion, just a
feeling). On the whole, if you were keeping
away from Vista because of its speed, Windows
7 Beta promises to fix that issue.

Networking
Right off the taskbar you can manage your
network connections. One click on a “network”

icon next to the volume
control icon opens a
pop-up. From here you
can open the Network
and Sharing Center, get
an overview of the
networks you are
connected to, and
connect and disconnect
yourself over dial-up,
VPN, or Wi-Fi. The
Network and Sharing
Center is also stream-

lined — letting you manage, setup, trou-
bleshoot your networks.

New to Windows 7 Beta is the HomeGroup,
which is exactly what it sounds like — you can
use it to connect your home PCs together,
letting you share photos, music, videos and so
on. When you setup a HomeGroup, you can
select the libraries and devices that you want
to share. This group can be password-
protected, and you can set access permissions
as well. Computers must be running Windows
7 to participate in a HomeGroup.

Action Center
This is where all those irritating pop-up
balloons have gone to die. Good riddance too.
Notifications are much more subdued under
this Beta. No longer does it feel like the OS is
screaming for attention every time a file
stubs its toe. The Action Center is a tiny flag
icon sitting next to the volume and network
icons on the taskbar. From here, you can
review system messages and take steps to
resolve pending issues. The Center breaks info
down into two categories: Security, wherein
falls Firewall, Update, virus, spyware and
similar settings; and Maintenance, where you
can backup and restore data, and check for
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Playlists are auto populated by WMP

WMP taskbar preview

Above: Network and Sharing
Center
Left: Managing network
connections

edge. This can be used to compare and copy
data across different locations by dragging
them to opposite sides of your screen.

Libraries
The promise of WinFS to bring intelligence, rele-
vance, and relation to your data was so badly
needed that we were extremely disappointed
when the feature was unceremoniously
dropped from Vista — likely to be never heard
from again. Libraries, while nowhere near a rela-
tional database, somewhat takes the sting away
from losing WinFS. The concept is simple — you
have similar data spread across drives, folders,
partitions, etc. — so why not logically store them
under a single virtual folder? Windows 7 Beta
does just that and we’re thankful for it. You can
thus have libraries collating pictures, videos,
music, documents, and create and define your
own libraries to boot. It’s a great way to store
and access information.

When you pin Windows Explorer to the
taskbar, a right-click on its icon shows you your
current libraries. These can be permanently
pinned as well. Thus giving you access to your
entire content straight from the taskbar itself.

Another welcome addition is that the library
is automatically shared across supported appli-

cations. No longer will you need to create inde-
pendent libraries of your music / videos / photo-
graphs under different programs — Winamp,
Picasa, Media Player, Media Jukebox, and so on.
If a program supports Libraries, it will immedi-
ately and automatically gain access to all your
content. A drawback here is that there is
currently no apparent way to exclude content
from being listed in a library, so sensitive data
also shows up with everything else.

Search
Search under this Beta is fixed in three ways: (1)
it’s fast, so we actually use it; (2) it takes up the

entire Start menu width, so it doesn’t look messy;
(3) search results now expose pre-set filters that
go a long way to refining a search query. Search
in general is now much more usable.

Windows Media Player
This is a much snappier avatar of WMP. It also
supports a wider range of codecs right off the
bat, although not enough to throw away your
favourite codec pack. While playing music or
video files, WMP starts a minimal interface
showing just the media and playback controls
— a no-nonsense approach that is appreciated.
From the ‘Now Playing’ view you can switch to
the more traditional Library view which breaks
down WMP into three panes. Left is where you
navigate through your libraries. Centre is where
you find a library’s content, and on the right
you have a task pane. The right pane offers
frequent tasks — Play, Burn and Sync. It’s a
much cleaner interface that takes a while to get
used to because old habits die hard... Notably,
you can hover over a track’s name in the middle

Maximised Window

Libraries are shared
across applications

Faster search relevant results

Take part in the
Readers’
Survey

on Page 78, and
win tonnes of

exciting prizes
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solutions to system and/or program crashes.
The Action Center is also where the System
Restore feature resides. Finally, we have the
Troubleshooting option, which is a surpris-
ingly useful (in that it actually solves issues,
no really, it does!) list of tasks and wizards to
handle everything from running a program
made for previous versions of Windows to
power management. It helped us run quite a
few irate programs...

Miscellany
1. Themes: Right-click on your desktop, select

Personalize and you will be able to change
sundry items that give your setup its identity
— colour, sounds, and the screensaver.
Moreover, you can select multiple images to
be used as your desktop wallpaper and tell
Windows to cycle through them after a
specific interval. Watching your desktop
change wallpapers (especially if they are cool
abstracts) every 30 seconds is very cool
indeed. You can also save your settings as a
theme. Very nice.

2. Gadgets: We would love to tell you more
about these, but no matter how hard we
tried, we could not get them to work. The
change in this Beta is that you now drop

gadgets to your desktop. The irritating sidebar
is gone. But every time we dropped one, it
would simply disappear.
3. On-Screen keyboard. This is finally using

vector images and is thus scalable.
Moreover, it now offers text prediction and
text completion — making it a great feature
for those with weak eyes or for those too
lazy to walk to their physical keyboard.

Closing thoughts
Windows 7 Beta does all the right things. It
fixes what was broken, introduces some great
and useful features, runs faster, feels snap-
pier, and is reportedly less demanding on
hardware. It’s everything that Windows Vista
should have been. We would go as far as
saying that this Beta should have been a serv-
ice pack to Windows Vista (and maybe some
features will indeed make it to SP2). While

this Beta generally cleans up after Vista, we
would personally like to see more innovations
as we head towards the retail release.

Through Windows 7, Microsoft has
thought it wiser to clean the slate and release
anew, rather than try and salvage Vista’s
tarnished reputation. That doesn’t change the
fact that Windows Vista users might feel
cheated. But isn’t that the nature of technol-
ogy? Early adopters beware. If nothing else,
Windows 7 seems on track to fulfilling prom-
ises made during the Longhorn era.

For that alone, we are excited to see more
of Windows 7. What can we say? Some
people never learn... �

ahmed.shaikh@thinkdigit.com

Get yer shortcut keys here
New shortcuts to navigating Windows 7
Win+Home Minimize all but the active window
Win+Space See through to the desktop
Win+Up arrow Maximize the active window
Win+Down arrow Minimize/restore the active window
Win+Left/Right arrows Dock the window to each side of the monitor
Win+Shift+Left+Right arrow Move the window to the adjacent monitor

(for dual-monitor setups).
Win+T Focus and scroll through items on the taskbar
Win+P Adjust presentation settings for your display
Win+(+/-) Zoom in/out
Shift+Click a taskbar item Open a new instance of that application

Action Center

Create and save a
theme

On Screen
Keyboard
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We tested a Nehalem processor, the i7 965
Extreme, a few months back and compared it to the
(then) fastest desktop processor in the world — the
Intel Core 2 Extreme QX 9770 (3.2 GHz). Needless to
say, the Core i7’s performance was at least 15 per
cent faster, 90 per cent of the time, in both real-
world tests and synthetic benchmarks. Not only
was the i7 significantly faster than any AMD
Phenom processor, it was also noticeably faster
than the fastest quad-core Intel Yorkfield processor
around. When you consider that the Core 2 archi-
tecture isn’t very old and Intel has been continu-
ously churning faster Core 2 processors, Nehalem
becomes something rather special.

One of the firsts for Intel in the desktop space is
that Nehalem is a native quad-core. Earlier, only AMD
offered native quad-cores with its Phenom X4 range.
Intel’s quad-core processors before the i7 were basi-
cally two dual-core CPUs slapped together on a single
die; a fact that has been of great interest to AMD, as
it has thumbed its nose rather regularly at what it
has called a Jurassic design. The market is, however,
more concerned with real-world performance rather
than on-paper specifications and the Core architec-
ture is much faster than anything AMD has been
able to conjure up. And now the newcomer is out
with promises of even more processing grunt. Of
course, AMD isn’t whittling sticks either — its
Phenom 2 processors have just made an entry — but
they have a very tough opponent to beat.

Scalability
Intel claims to have designed the Core i7 with scal-
ability in mind and looking at its released block
diagrams we have to agree with them. In fact

everything about the i7 design is modu-
lar, and while the current Nehalem
CPUs are native quad-cores we could just
as easily see eight-core CPUs or even
dual-cores with integrated graphics, in
the future. The fact is that Nehalem is
designed from the ground up to be flex-
ible and Intel can easily add or remove
cores and other components as per
market needs and demands. Nehalem

also resurrects an old trick — hyperthreading (HT) —
which was dropped since the Pentium 4. Hyper-
threading is Intel’s name for simultaneous multi-
threading (SMT), a process in which operations
from more than one instruction thread can be
processed by a single processor core.

A quad-core Nehalem CPU can, therefore,
process eight threads, while an eight core
Nehalem will actually process a previously
unheard of 16 threads. This gives the i7 much
better multi-threaded performance while keeping
thermal envelopes and silicon requirements
much lower than they would be, if additional
cores were added instead.

Doing more with less, seems to be Intel’s
design motto for the i7. HT also means fewer

ReturnReturn
of the
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Michael Browne

Ever since its Conroe architecture took the
world by storm, Intel, the largest CPU
manufacturer in the world has been on an

undeniable roll. AMD has been unable to hit
back with anything concrete and competition
has been lean. Intel has even gone as far as prom-
ising us something new in terms of processor
architecture every two years or so. In fact, many
people have made much of Intel’s “tick-tock”
development model: each tick represents a die-
shrink and each tock denotes a major architec-
tural change. Late last year, Intel delivered the
latest tock in the form of the processor code-
named Nehalem; finally given the marketable
moniker of Core i7, with its processor family
dubbed “Bloomfield”.
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searching. Although this secondary predictor
unit is slower than the primary unit, its ability
to correct incorrect predictions made at the
first-level and thus prevent any core overtime
should more than compensate for its reduced
speed of operation. Then there is a buffer called
the “Renamed Returned Stack Buffer” which
ensures that correct data is pulled from the
processor’s stack, even in the event of an incor-
rect prediction. Therefore Nehalem beefs up the
chances of a hit, and minimises overhead and
latency in case of a miss — a huge plus, to be
sure. HT together with this two-stage branch
prediction should bring immense benefits
when working with multiple threads. The
branch prediction could also do wonders for
single-threaded applications: Since each core’s
resources are shared according to the workload,
if two threads are pushed at a core then each of
them gets one-half of the resources. If a single
thread is to be executed, it gets the full atten-
tion on the core it is pushed to, giving it greater
performance. While on the topic of parallelism,
Nehalem can execute more in-flight micro-ops
than Penryn — the count is up from 96 to 128.
Micro-ops, short for micro operations, are
detailed low-level instructions issued to imple-
ment complex machine instructions. So the i7
has an increase in parallelism at the instruc-
tion level as well; a serious benefit when you
consider each core supports HT.

The IMC
Now a little bit on that shiny new IMC. Intel’s IMC
supports three channels instead of two. So be
prepared to see i7 based motherboards with six
memory slots. This IMC supports only DDR3 and
up to 24 GB of RAM. This is good for server config-
urations or workstations needing more than 8 GB
of RAM. Although the IMC doesn’t support the
fastest DDR3 memory, it doesn’t need to. Firstly,
the theoretical bandwidth that tri-channel
memory configurations offer, even at memory
speeds of 1,333 MHz, is higher than a dual-chan-
nel configuration running memory clocked at
1,800 MHz. Besides greater bandwidth than all
previous Intel systems, the IMC on each i7 CPU
ensures that latencies will be minimal. In fact,
slower memory also means tighter timings —
which we’ve seen as more conducive to perform-
ance than higher memory clock speeds. All this
will sound very familiar to most people following
processor technology over the past five years —
this is exactly what AMD told us about its
memory controller — theoretical bandwidth
doesn’t matter as much when using an IMC
because most of the increased bandwidth gets
wasted with FSB latencies. It seems Intel was
listening to AMD as well. Thanks to the IMC,
multi-CPU systems based on Nehalem processors
will consist of a dedicated RAM pool per CPU. If

one CPU needs access to some data which is in
another’s data pool the QPI link between both
the CPUs will come into play. This may result in
some latency, but it should not be a lot. Obviously
this won’t affect desktop users with a single CPU.

One of the main talking points of the
Nehalem architecture is the QPI link itself. The
QPI is a point-to-point interface, so there’s no
conflict of interests for bandwidth. The QPI is
the means for cores to talk to each other. It also
connects the CPU to the motherboard chipset
and allows the CPU to talk with PCI Express,
USB, and SATA components. So far all the
Nehalem desktop CPUs that Intel has released
have a single QPI link. Server CPUs will have two
links, with the second link allowing crosstalk
between CPUs in multi-socket systems. The high-
est-end Nehalem, the i965 Extreme Edition, has
a link that allows 6.4 GT per second, (GT is an
acronym for giga-transfer, yet another new
term!). The lower Nehalems have a QPI link that
allows 4.8 GT per second. The total bandwidth
offered by each QPI is 25.6 gigabits per second
and each consists of two 20-bit, bi-directional
links. Note that the total bandwidth of 25.6 giga-
bits per second is double the bandwidth avail-

able on the 1,600 MHz FSB of Intel’s X48 chipset.
In a truly modular fashion, Intel can add more
QPI’s to a Nehalem CPU if the need arises.

The clock speed of all Nehalem CPUs is a
derivative of the base QPI clock which is 133
MHz. This is much lower than the FSB speeds
of previous CPUs from Intel; where the base
FSB clock was 333 MHz, or even 400 MHz.
Therefore all Nehalem CPUs have much
higher multipliers. The L3 cache and the IMC
operate on a difference clock called the un-
core clock. This figure is 20X the base QPI
clock i.e. 2.66 GHz. This is similar to AMD’s
Phenom design where multiple clocks are
used for different parts. In terms of power-
management Nehalem differs as well: While
Phenom allows each core to request different
clock speeds, incidentally the reason why one
needs to install the AMD Cool’n’Quiet driver;
the Nehalem attempts to run all cores at the
same clock speed at all times. The only excep-
tion being when Turbo Mode (see below) is
enabled. In other words, if a particular core

Nehalem CPUs
Model Numbers -> i965 Extreme Edition i940 i920
Fabrication Process 45 nm 45 nm 45 nm
Core Speed 3.2 GHz 2.93 GHz 2.66 GHz
Socket LGA 1366 LGA 1366 LGA 1366
L2 Cache Size 256 KB x 4 256 KB x 4 256 KB x 4
L3 Cache Size 8 MB 8 MB 8 MB
QPI Speed (giga-transfers per sec) 6.4 4.8 4.8
Effective Multiplier 24 22 20
TDP 130 watts 130 watts 130 watts
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wasted clock cycles as each core has a much
better chance of being kept busy due to the fact
that each core can be fed with two threads at a
time, instead of a single thread. Nehalem’s
cores are much faster than those in a Pentium
4, partly due to their being derived from the
much faster Core architecture and also due to
the much shorter execution pipeline; this
means that HT on an i7 should be much more
efficient than HT was on the Pentium 4 CPUs.

Intel’s Penryn CPUs added support for SSE 4
and Nehalem brings with it support for SSE 4.2.
The main additions with the new SSE instruc-
tions are improved XML processing support,
voice-recognition, error-detection code calcula-
tion, and DNA sequencing. What we’re seeing
here is greater emphasis on achieving more
performance per watt. While Nehalem CPUs have
a higher TDP (Thermal Dissipation Point) than
Penryn at 130 watts versus 95 watts, Intel claims
that the performance hike is more than propor-
tionate to the increased power requirement, or at
worst, equal to it. In fact the Nehalem is designed
on the Atom processor ethos: that is to maintain
a 2:1 ratio for increments in performance and
power consumption figures at all times.

Nehalem is a native quad-core with four cores
sitting on a single die. Unlike previous quad-cores,
wherein two cores shared an L2 cache, i7 offers
each core discrete L1 and L2 caches, with an L3
cache in common. The Core i7 is made from a
budget of 731 million transistors. In comparison,
Yorkfield needed 820 million transistors. The die
size of Nehalem is larger though; increasing from
214 mm^2 to 263 mm^2. That’s fewer transistors
and reduced density, which should bring thermal
benefits. Nehalem has the same L1 cache as previ-
ous Yorkfield CPUs: a 32 KB instruction cache and
32 KB data cache per core, but the L2 cache is
significantly smaller. Each core in a quad-core
Nehalem CPU gets only 256 kB (1 MB in total),
while Yorkfield CPUs had as much as 3 MB of L2
cache per core. There is a single 8 MB of L3 cache
to which all cores have access.

Copycat?
Now why did Intel make a high-end CPU with a
fraction of the L2 cache? And why introduce an L3
cache which we know is slower than any L2 cache?
The answer is one of the most radical architec-
tural differences between Core i7 and Core 2 — the
inclusion of an on-die memory controller or inte-
grated memory controller (IMC). Gone is the

memory controller on the Northbridge. This is
where AMD fans will scream “copycat”. That’s not
all. Gone is the ancient, bi-directional Front-Side
Bus (FSB) in favour of what Intel calls “QuickPath
Interconnect”, which is equivalent to AMDs Hyper
Transport with a few differences. Intel had pretty
much reached the upper limits of what it could
do with its FSB and with FSB frequencies
approaching 1,600 MHz, even faster memory
could not alleviate the problem of keeping the
CPU fed with data from memory. In fact, it is the
IMC that resulted in the changed cache sizes on
Nehalem, and not the other way around. Industry
experts have rightly criticised Intel for hiding the
huge memory latencies associated with having an
FSB-based interconnect between CPU and RAM by
adopting the brute force approach — increasing
the processor cache to sometimes crazy levels.
Obviously this is an inefficient, not to mention
costly approach. Now, thanks to the IMC, Intel can
make Nehalem shine with a relatively small L2
cache. Another trick is the inclusion of a new
secondary Translation Look-Aside Buffer (TLB);
earlier CPUs made do with a single TLB. The TLB is
a CPU cache that is used by memory management
hardware (like the IMC) to improve the speed of
virtual address translation. Intel also copies
AMD’s way of designating the specific processor
regions and the Nehalem is divided into two parts
termed as “core” and the rather awkward “un-
core”. The core includes the physical CPU cores
and L1 and L2 caches while the un-core consists of
everything else on the chip, including the L3
cache and IMC.

The branch prediction mechanism of the
Core i7 has also seen a significant change. A
second-level branch predictor with a much
larger data set and a deeper history has been
added to the prediction unit in all Core 2
processor cores. The deeper history in conjunc-
tion with the larger data set allows for broader

Nehalem vs. Penryn: cache and memory
Nehalem Penryn (Yorkfield)

L1 Size / L1 Latency 64 KB / 4 cycles 64 KB / 3 cycles
L2 Size / L2 Latency 256 KB / 11 cycles 12 MB / 15 cycles
L3 Size / L3 Latency 8 MB / 39 cycles NA
Main Memory Latency * 107 cycles (33.4 nano sec) 160 cycles / 50.3 nano sec

* Using DDR3 1600 MHz (CAS Latency 7)
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isn’t being used it’s simply power gated and
effectively turned off.

Turbo mode
Talking about multipliers brings around the
inevitable topic of overclocking. A decade back,
just the mention of overclocking was enough to
get people at Intel all riled up. But with
Nehalem, Intel is in one sense, encouraging it.
The i7 supports a feature called “Turbo Mode”
(TM). A processor will be rated to operate within
certain constraints — a maximum temperature,
current and power consumption. If Turbo
Boost is enabled, and if the processor’s on-die
Power Control Unit, which monitors the ther-
mal condition and power usage of the cores,
indicates that it is running within these
constraints, one or more cores will start to oper-
ate at higher clock speeds, enabling higher
performance for the threads they are executing.

When cores are clocked-up in this way, steps of
133.33 MHz are used — the base frequency
mentioned earlier. When this increase in clock
speed occurs will depend on the conditions inside
the machine, most particularly the cooling
system. The more efficient the cooling, the more
likely that clock speeds will increase. The most
likely situation for Turbo Boost to be effective will
be when a single- or dual-threaded compute inten-
sive application is running, with little demand on
the other cores. In that case, the core running the
main thread is very likely to be clocked up, with
the other cores not running, thereby reducing
power consumption and heat dissipation.

This feature addresses the one criticism of
multi-core processors: that not all compute
intensive applications have the inherent paral-
lelism that can benefit from multiple cores,
and that such processors give no performance
improvement for single-threaded applications.
With Turbo Boost enabled, such an application
can gain extra performance through the
increased clock speed of the core on which it is
running. This is perhaps the most important
feature expressing the scalability that Intel
claims to have built into this new architecture.

Cheap thrills
At the outset, it’s evident that Intel adopted a
very cost-centric approach to designing the i7. It
clearly draws on the best points of their previous
architectures and with a borrowed trick or two,
manages to raise the performance bar consider-
ably. Partly inspired by the Atom design, the i7
has a very low die-area cost. We found Nehalem to
be around 20 per cent faster than its predecessor
and all this on a new platform that is bound to
see optimisations and further performance incre-
ments. The LGA 1366 should be a good system to
invest in for those looking at a powerful desktop
processor; yet the costs related to purchasing a

new motherboard coupled with the high prices
of DDR3 means Nehalem may find few takers in
price sensitive markets (such as India). As of now,
the X58 platform is the only one available,
although NVIDIA has obtained the necessary
license from Intel and we could see NVIDIA
boards supporting i7 soon. Intel also claims that
future eight-core Nehalems will also be designed
for socket 1366; this is serious longevity for the
platform although whether it keep its promise
remains to be seen. The mess of platforms for
different processors in the Pentium 4 / Pentium D
era is all too fresh in our minds — we hope the
1366-pin socket stays awhile; else early adopters
will surely have sufficient grounds for complain.

Parallelism
It seems Intel deliberately chose features that
would ensure it excels in the server domain —
which has, by far, been its Achilles’ Heel over the
past two years. In fact, a number of tricks under
Nehalem’s 45nm hood won’t even be noticed
unless the i7 is used in multi-socket servers. Most
of these tricks involve parallelism and of course
more effective caches and prediction systems.
Developers for desktops need to get cracking on
getting their applications more and more multi-
threaded because this is where the i7 will shine
and future processors will follow suit. Regardless
of intent, the i7 offers a nice performance boost
across applications in the desktop space as well.
Gaming, 3D rendering, and video encoding are
the three biggest beneficiaries. In fact it even
delivers improved performance on a core-to-core
basis — so Intel has another architectural winner.

Just when we thought it couldn’t get much
better Intel throws us a few more delightful
surprises. Eight-core Nehalems could reach
markets by the end of 2009. We’ve also heard
that Intel plans to introduce a new Bloomfield-
derivative family named “Lynnfield”. Identical
to i7; these CPUs sacrifice the QPI for a more
traditional DMI and also forego tri-channel
DDR3 for a dual-channel setup. These CPUs will
utilise a 1156-pin socket and here’s the killer —
there’s an on-package PCI Express controller
that supports 16 PCI Express lanes. Yes, the
PCIe lanes are on the CPU itself! These 16 lanes
can be used as a single x16 connect or two x8
connects. Intel has also discussed “Havendale”
which is a dual-core variant with 4 MB of L3
cache. These CPUs will be the first Intel CPUs to
have a graphics core integrated as part of the
CPU package. It also has the 16 lane PCI Express
controller from Lynnfield, but it cannot be run
as two X8 connects. Of course, Lynnfield is still
a good four months or so from market; while
Havendale won’t debut till 2010. The only thing
better than living in interesting times is the
knowledge that the best is yet to come! �

michael.browne@thinkdigit.com
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The good stuff    Stuff to lust after   Stuff for the well-moneyed

Maal
Drool

Sennheiser HD 800
The German company has introduced a new set 

of headphones that is fast becoming the new 
reference standard. With a frequency range 
of 6 to 51,000 Hz, and oxygen free cabling, 

the headphones are made to please you with 
outstanding acoustic sensations. The materials 

used are exquisite, like Japanese Alcantara 
for the ear pads. The headphones sport 

some innovative new patented engineering, 
including a new type of transducer and a ring 
shape to eliminate unwanted vibrations. The 

headphones cost $1400 (Rs. 68,668). 

Cloud Black
Square-Enix is going to release a numbered, 
limited edition version of the Sony PS3. The 
Final Fantasy VII themed PS3 is called the 
“Cloud Black” by the makers and will be 
accompanied with the Final Fantasy VII: Advent 
Children Blu-ray disc. The set is so exclusive 
that you will have to figure out a way to get it 
from Japan, the only place where it is releasing 
(considering the horde of religious Final 
Fantasy fans there). The set will retail for US 
$550 (Rs. 27,042).

PS3 WarBeast
So you really like games like Guitar Hero 

or Frets on Fire. You also don’t want to 
be seen dead with those lame plastic 
excuses for guitars that PS3 and PS2 

players normally use. What you need is 
the big mean real size WarBeast Guitar by 
DreamGear. You might get a good deal on 

Amazon.com where we saw a couple of 
used WarBeasts disappear before our eyes. 

If you don’t get your hands on one of those, 
a brand new one will set you back by a 

mere US $100 (Rs. 4,916). 

Polaroid PoGo
The Polaroid is back, with a whole new digital 
avatar of its famous instant-print cameras. The 
Polaroid PoGo churns out borderless 2x3 inch 
300 dpi photos in under a minute. There is 
something mysterious about this little gadget, 
as it claims to print these photos without ink, 
using some zero-ink technology called zink. 
Anyone would have been happy to call this a 
done deal at $100 (Rs. 4,916), but wait, there 
is more magic in this little thing. It can also 
interface to your digital cameras through a 
USB 2.0 interface AND print from your phone 
as long as your phone has good Bluetooth.

TokyoFlash Tenmetsu
The innovative people at TokyoFlash never seem to stop 
in their ruthless campaign to design outrageous watches. 
We are not complaining. The Kisai Tenmetsu tells you 
both the time and the date, by showing LED lights in three 
different colours on a 2x4 array. How it manages to do 
this is anybody’s guess, but if you really want your watch 
to ooze of individuality, this is something just for you. The 
Tenmetsu costs $ 255 (Rs. 12,469).
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Digit: What were the kind of mission-specific require-
ments that were factored in designing the Terrain
Mapping Camera? What is the image resolution of
on-board cameras like the TMC?
IRSO: The aim of the Terrain Mapping Camera is
to completely map the topography of the moon.
The camera works in the visible region of the
electromagnetic spectrum and captures black-
and-white stereo images. It scans a strip of lunar
surface which is 20 km wide with a resolution of
5 m. Such high-resolution imaging helps in
better understanding of the lunar evolution
process, as well as in the detailed study of the
regions of scientific interest. When used in
conjunction with data from Lunar Laser Ranging
Instruments (LLRI), it can help in better under-
standing of the lunar gravitational fields as well.

Digit: How was the mission accomplished on such a
low budget?
ISRO: The total budget for Chandrayaan-1 proj-
ect was Rs 386 crores, out of which about Rs 100
crores was spent on the Deep Space Network,
which has 32-m and 18-m antennas which can
be used for Chandrayaan-I as well as future
missions. The Chandrayaan-I mission was
accomplished within the budget by optimal
utilisation of human resources, infrastructure
and good planning.

Digit: What exactly is the Indian Deep Space Network
(IDSN)? How does it counter any time delays?
ISRO: The Indian Deep Space Network performs
the important task of receiving radio signals
transmitted by Chandrayaan-I spacecraft that
become incredibly feeble by the time they reach
the Earth. Besides, it can send commands to the
spacecraft at a power level of up to 20 KW. The
IDSN consists of two large parabolic antennas,
one with an 18-m, and the other 32-m diameter
at Byalalu, situated about 35 km from
Bangalore. Of these, the 32-m antenna with its
‘seven mirror beam waveguide system’ was
indigenously designed, developed, built,
installed, tested and qualified. The 18-m
antenna can support the Chandrayaan-I lunar
mission, while the 32-m antenna can support
any spacecraft mission deeper into space.

Digit: How would the Indian space programme
compare to NASA in terms of technology?
ISRO: India is on par with the best in the world
in the area of satellite technology. India has the
largest constellation of remote sensing and
communication satellites in the Asia-Pacific
region in civilian sector. ISRO is considered a
leader in the application of space technology
for the benefit of mankind and national devel-
opment. The social applications such as tele-
medicine and tele-education conceived by ISRO
and the setting up of village resource centres,

remote sensing services and communication
satellites has drawn the attention the world.

Digit: What kind of future surface missions can we
expect post Chandrayaan-I? Is Chandrayaan the first
step in setting up a future moon base? Is a mission to
Mars on the cards?
ISRO: Following Chandrayaan-I, ISRO has plans
to launch Chandrayaan-II around 2011-12,
carrying a lander and rover to collect samples
on the lunar surface and analyse the chemical
composition of the lunar soil. Studies have
been initiated for undertaking an unmanned
mission to Mars.

Digit: What is the significance of India being one of
four countries to have its flag on the moon?
ISRO: When the Moon Impact Probe (MIP) with
Indian tricolor painted on its surface impacted
the lunar soil, India became the fourth country
to land a man-made object on the lunar surface.
This is a significant achievement as the mission
involved travelling a distance of 400,000 kilo-
metres performing crucial manoeuvres to place
the satellite in lunar orbit and impacting lunar
soil at predetermined place with great accuracy.

Concluding thoughts
Although we were quite eager to know some
details regarding the computer technology
used in the mission, such as processor, comput-
ing power, AI (if any), unfortunately, IRSO was
pretty tight-lipped.

We’re assuming that this may be sensitive
information, or just national trade secrets, which
we obviously do not want to share with the
world. Stay tuned to this space, and we will try
and get continued updates about Chandrayaan,
and future missions, as our nations flag is
carried proudly into outer space. �

siddharth.parwatay@thinkdigit.com
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in the visible, near-infrared, microwave and
X-ray regions of the electromagnetic spec-
trum. With this, preparation of a 3D atlas
and chemical mapping of entire lunar
surface is being carried out. Some really
fancy equipment like the Terrain Mapping
Camera (TMC), Lunar Laser Ranging
Instrument (LLRI), and some other spectral
and X-ray imaging instruments were loaded
on to the Chandrayaan.

The mission has certainly achieved some
remarkable feats. The first one that comes to
mind is more economic than scientific. The
entire mission was pulled off in a compara-
tively humble budget of Rs 386 crores. Great!
But some questions remain unanswered —
why would you want to go to the moon in the
first place? Didn’t the space race die out with
the Cold War? Agreed, the innate human
desire for exploration is undeniable, but
there have to be some real tangible benefits.
Well we decided to find out through a one-on-
one round with the scientists at ISRO. And
while we were at it, we bombarded them with
a host of other questions regarding the tech-
nology used, breakthroughs achieved, and
future plans.

Digit: What were the motives behind the mission?
Why would we need a detailed topographic mapping
of the moon, and why analyse the lunar surface for
mineral deposits?
ISRO: The primary objectives of Chandrayaan-
I are: i) upgrade India’s technological capabil-
ities, ii) expand scientific knowledge about
the moon, iii) provide challenging opportuni-
ties for planetary research to the younger
generation of Indian scientists. Outer space
will be the next frontier of exploration for
mankind. The Moon will form an intermedi-
ate base for undertaking exploration of outer
space. There is a need to identify the presence
of water to support astronauts undertaking
deep space flights, and for using water by
breaking up into hydrogen and oxygen as a
possible source of propellant for future
missions. There is also a need to exploit
minerals and chemicals available on the lunar
surface. Preparation of a detailed topographic
map is essential to understand different
terrains of the Moon. Chandrayaan-I also aims
to look at the presence of Helium 3 on the
lunar surface, which can be used as a fuel in
nuclear reactors that can be useful in solving
the power requirements on Earth.

Siddharth Parwatay

Chandrayaan-I, India’s first mission to
the moon was launched on October
22nd, 2008. At the time of going to

press, the mission has seen no major glitches
and has been near flawless, and we hope it
stays that way. It has already beamed back to
earth around 40,000 postcard-size high-defini-
tion images of the moon. Soon, some 70 scien-
tists from across the globe are expected to
pour over these images to unravel the myster-
ies of the moon.

Overall, the mission had three objectives.
The primary objectives of the mission are to
expand the scientific knowledge about the
origin and evolution of moon, upgrade
India’s technological capabilities, and
provide challenging opportunities to young
scientists working in the planetary sciences.
These objectives are to be achieved through
high resolution remote sensing of the moon

Chandrayaan

India is only the
fourth country
to have its flag
on the lunar
surface!

The Chandrayaan-1 Spacecraft

SWIM
(Solar-Wind Monitor)

CENA
(Chandrayaan
Energetic Neutral
Analyzer)

MIP
(Moon Impact Probe)

RADOM
(Radiation Dose Monitor)

SIR-2
(Infrared Spectrometer)

LLRI
(Lunar Laser Ranging
Instrument)

TMC
(Terrain Mapping
Camera)

CIXS
(Chandrayaan-1 X-
ray Spectrometer)

M3
(Moon Mineralogy
Mapper)

Mini-SAR
(Miniature Synthetic
Aperture Radar)

HySI
(Hyper Spectral
Imager)

HEX
(High-Energy X-ray
Spectrometer)

You can’t take a trip
to the moon just yet,

but you can
see a few stars
on your way to our

Mumbai office.
Details on
Page 78



37www. thinkdigit.com DIGIT FEBRUARY 2009

Digital Passion l Main Story

1-G technology involves the use of analogue
radio signals for communication. Voice data is
modulated to a high frequency (usually beyond
150 MHz) for transmission. Information trans-
fer between telephone towers takes place in the
form of digital signals.

2-G differs from 1-G in the use of digital
voice signals for communication. The analogue
voice data is encoded into digital signals for
transmission.

How does 3G compare with the available
technology?
3G is a substantial enhancement over the
current 2G technology, and is capable of facil-
itating high-speed internet access and data
transfer. Adoption of 3G in India would
involve substantial improvement in the exist-
ing cell phones to be able to support 3G serv-
ices. The idea of launching 2.5G services was
also considered due to the difficulty of
moving over from 2G to 3G. But the delay in
launching advanced telecom services and
launch of phones with 3G capabilities made
the choice easier.

High speed digital packet switching
networks are the source of the high speed
offered by 3G. Compared to the traditional
circuit switching technology, packet switching
offers better transmission bandwidth utilisa-
tion, and hence higher data transfer rates.
Additionally, advance multiplexing techniques
add to network speed.

What changes can be expected due to 3G?
The emergence of 3G is likely to act as catalyst
for enhanced product and services. Creative
solutions evolving around user benefits are
expected to emerge.

� Quality of text, audio and video communica-
tion would improve through:
�Technology supporting more real-time, and

next to real quality communication
�Enhanced mobility and roaming
�High quality e-mail and internet access

� 3G would enable heavy video broadcast
(video conferencing, video lectures and
virtual classrooms, video sharing, etc.) and
data-intensive services (such as online moni-
toring/surveillance, e-commerce, online
education, telemedicine, music/software/data
download, online gaming, etc.)

� High-end, light, feature intensive, and easy-to-
use terminals would come into the market
with creative interfaces designed to suit
customer preferences.

Additionally, the strong business opportuni-
ties around 3G are expected to attract a large
number of players offering choice, affordability
and quality to the consumer.

Differences between the three technologies
1G
1G technology was the
starting block in mobile
telephony offering quality
voice service

Analogue voice service

Better sound quality than
2G over long distance
calls

No data service

2G
2G technology brought in
energy efficient digital
communication systems
facilitating smaller
handsets and price
reduction

Digital encryption of
conversation

Better data security

Optimal spectrum
utilization

Start of data services like
SMS

Limited e-mail access

Slow speed internet
access

14.4-43.2 kilobits/sec data
transfer

3G
"Launched in 2001, the 3G
services have brought in
high quality service and
substantial user
convenience, but involve
considerable investment
in technology for service
providers"

High speed internet on
phones

Video communication

Heavy data transfer
services

Quality and interactivity
of services

Enhanced roaming

Strong network security

144 Kbits/sec (high speed
mobile) & 2 Mbits/sec
(stationary mobile) 7

Packet switching vs. circuit switching
Circuit switching involves dedicated link creation
between two phones during a call leading to redundan-
cies & high waiting time

In packet switching data is transmitted in the form of
encrypted digital data packets through the least
congested route / nodes reducing redundancy in the
process

Generation Switching Data type Period of Standards
technology launch

1G Circuit switching Analog 1980 AMPS
2G Circuit switching Digital Early 90s “TDMA, CDMA, GSM”
2.5G Circuit switched for High speed Early 21st “GPRS, EDGE, 1xRTT”

access network & packet digital century
switched for core network

3G Packet switched Digital 2003 “WCDMA,
broadband CDMA-2000”

The Generation Gap: 3G versus its siblings
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Nishant Raman

India has seen rapid technological growth in
recent times, especially in the areas of infor-
mation technology and communication.

Telecommunication has led the charge in the
area of consumer technology with rapid pene-
tration of mobile telephony amongst the
masses. India is already one of the largest
consumers of mobile phones, with an average
nine million users being added every month.
The telecom tariff rates offered in India are
among the lowest in the world.

3G and WiMAX are the latest inclusions to
the mobile and internet communication fold,
promising to take user-experience to a higher
level through interactivity, greater convenience,
improved access, and quality of services offered.
This article aims to capture the essence of these
two technologies, analyze their impact on
communication, and to conduct a comparative
assessment of relevance, and hence acceptabil-
ity, of the two to the masses.

3G
Launch of 3G in India
Doors are opening for the launch of the much
awaited 3G service in India. The introduction

of advanced telecommunication services was
proposed in the tenth five year plan, paving
the way for funding and resource allocation
for 3G services in the annual budget of the
Department of Telecommunication (DoT). The
electronic auctioning of the 3G spectrum is
planned to take place in two phases on 16th
January and 19th February, according to a
DoT directive. This fresh initiative should
pave the way for a wide range of products and
mobile services being made available to the
Indian consumer. 3G will facilitate high-speed
internet access through mobile phones and
provide mobility to a large number of services
such as video conferencing, gaming, and large
downloads.

Currently, the 2.1 GHz band is to be
auctioned for launching 3G services in India.
License winners are expected to roll out 3G
services in 90 per cent of metro areas and 50
per cent in other areas given to them (with a
minimum 15 per cent rural coverage). This
coverage is expected by the end of the fifth
year, after spectrum allocation.

The 450 MHz band is currently being
utilized for radio communication, while the
800 and 1,900 MHz bands are used for military
communication purposes. They will be
auctioned when they become free.

What is 3G?
“Third Generation wireless telecommunication
technology”, or 3G, is an advanced radio commu-
nication technology which provides a marriage
of high-speed internet access and high-quality
mobile telephony. The technology enables simul-
taneous voice and non-voice data transfer.

3G

Frequency band Availability Freq block size Uplink Downlink
frequency frequency

2.1 GHz 3 Available 2 x 5 MHz 1920-1980 MHz 2110-2170 MHz
450 MHz 4 Proposed 2 x 1.25 MHz Undecided Undecided
800 MHz Proposed 2 x 1.25 MHz Undecided Undecided
1900 MHz Proposed 2 x 1.25 MHz 1900-1910 MHz 1980-1990 MHz

Table 1

WiMAX
and

High speed
mobile

connectivity is
coming to

India
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the third of its kind across the globe after
USA and Taiwan.

According to the WiMAX forum, the
market for WiMAX in India, which includes
device and service sales, will reach $13 billion
by the year 2012. The forum pegs the number
of WiMAX users by 2012 at 27.5 million, an
approximate 20 per cent share of the world’s
total WiMAX user base at that time. According
to independent research by Maravedis, a
market research firm, the subscriber base for
WiMAX in India is expected to reach 21
million by the year 2014.

Leading global WiMAX companies, such as
Alcatel-Lucent, Motorola and Samsung, are
starting their operations in India. Nokia has
announced the launch of its first ever WiMAX-
enabled phone which is scheduled to be
launched in India.

What is WiMAX?
WiMAX, or “Worldwide Interoperability for
Microwave Access”, is a broadband wireless
point-to-multipoint specification from the
IEEE 802.16 working group, enabling wireless
broadband networks with high speed. Leaps
and bounds ahead of WiFi, WiMAX is
designed to operate as a wireless metropoli-
tan-area network.

WiMAX promises faster and superior
performance, adaptability to various applica-
tions, advanced IP-based architecture (enabling
integration of various applications with the
internet) and reduced rates to consumers.

WiMAX supports a range of modulation
algorithms to facilitate the realization of opti-
mal bandwidth in all conditions. The theoret-
ical maximum data bandwidth of 75Mbps can
be achieved with WiMAX using 64QAM 3/4
modulation (only under optimal transmission
conditions).

Fixed WiMAX is limited to providing wire-
less network access to fixed devices, a limita-
tion eradicated by mobile WiMAX. WiMAX does
not have the need for a direct line of sight
between the source and endpoint of communi-
cation/data transfer, unlike most other wireless
technologies. Mobile WiMAX supports SOFDMA

(Scalable Orthogonal Frequency Division
Multiple Access), an enhancement over
OFDMA256 which facilitates non-line-of-sight
communication. SOFDMA also brings in better
throughput and minimized sound fading in
multiple path scenarios.

What are the key highlights of WiMAX?
WiMAX has some important features that have
attracted the attention of the whole informa-
tion and communication community ranging
from internet operators and mobile telecom
operators to fixed line telecom service
providers, and so on. The attraction of possible
gains in the future has brought many technol-
ogy firms into the WiMAX fold:

� IP-based network: WiMAX specifications are
developed over IP and support IP-based appli-
cations. The need to unify various communi-
cation networks and to cut costs has inspired

Parameter Value
Range: Line-of-sight (LOS) ~50 Km
Range: Non-line-of-sight (NLOS) ~10 Km
Maximum data speed ~70 Mbps
Licensed frequency band 2-11 GHz
Un-licensed frequency band 10-66 GHz
Switching Packet
Multiplexing SOFDMA
Modulation "BPSK, QPSK, 16QAM,

64QAM"
Source: http://grouper.ieee.org/groups/802/16/

WiMAX specifications

Specification Description
802.16-2001 LOS access in 10-66 GHz spectrum
802.16c-2002 Improved QoS; support for HIPERMAN
802.16a-2003 Added 2-10 GHz to existing standards
802.16d-2004 Fixed WiMAX; supported OFDMA 256
802.16e-2005 Mobile WiMAX; enhanced OFCDMA

multiplexing
802.16f-2006 Information base management
802.16g-2007 Mobility management
HIPERMAN Equivalent of 802.16 in Europe
WiBro Equivalent of 802.16 in Korea

Evolution of WiMAX

How has been the acceptability in other
countries?
Japan was the first country to test and imple-
ment 3G. The acceptability has been good for 3G
there, with internet access, gaming and music
download being some of the prominent applica-
tions. The objective of launching 3G in Japan
and Korea was to develop an internal communi-
cation network and hence the access charges for
service providers were kept low, resulting in low
3G charges on consumers, and hence greater
popularity and acceptance. 3G has done well in
most countries due to its good features. It has
been successfully launched and is being oper-
ated in more than 50 countries currently.

On the other hand, the financial perform-
ance of 3G operators has been poor in some
regions due to high debts on service providers or
high-access charges; especially in Europe. The
actual performance of 3G in most places has been
lower than the specified speed standards and has
caused dissatisfaction among consumers, lead-
ing to lower acceptance rates for the service.

What are the major concerns involving 3G?
3G rollout in many countries has resulted in
factors hindering acceptance of service among
consumers and profitability of service
providers; India would do well to learn from
them. Additionally, we foresee certain issues
the operators are likely to face in India:

� High revenue expectations from 3G services
resulted in high input fee/access charges
levied on service providers for 3G service
licenses.

� The price of 3G mobile services (including
internet access) was kept excessively high in
some countries, especially Europe, reducing
the attractiveness of the 3G offering.

� Heavy upfront capital investment is required
for developing local infrastructure capable of
supporting 3G services in any country.

� 3G phones are more expensive compared to
2G and other lower-end phones, making the
switch to 3G financially unfavourable for
common consumers, especially in India.

� In India a substantial proportion of the popu-
lation does not require 3G voice and data serv-
ices in hand-held devices; this would limit the
spread of 3G in the short term.

� Health impact of electromagnetic waves
would always remain a cause for concern.

� There is a general lack of awareness about 3G
services even among the educated population
in India. It would take time for 3G services to
pick up, as has been the case globally.

What’s ahead for 3G?
Organizations worldwide are involved in a race
to develop the next level of wireless communi-

cation, and hence to grab and maintain a
substantial market share. Some of the possible
new areas of communication standard evolu-
tion can be:
� Universal networking: development of archi-

tectures and middleware that support univer-
sal networking between all communication
devices leading to smooth communication
and data/application transfer from one device
to another.

� Customized services: the user would have the
power over which function can be served by
which device (one device acting as the central
controller for all other devices the user owns,
music being played on one device while video
on another, etc.)

� Higher network speeds: with better band-
width utilization and multiplexing technolo-
gies, network speeds are expected to go up,
enabling on-the-fly data transfer from one
device to another.

� Other auxiliary services: other features and
services, such as heightened network security
through Bluetooth device-based protection,
identification services, information services
customized to user preferences, centralized
billing, etc would come up with the evolution
of communication technology.

� 4G: An upgrade over the current 3G system
involving some advanced features, such as
better spectrum utilization, greater network
speed, more simultaneous users per cell
phone, better inter-operability across hetero-
geneous networks, etc.

WiMAX
Launch of WiMAX in India
The stage is set for the launch of WiMAX in
India with the finalisation of dates for the
auction of the 2.5 / 3 GHz spectrum by the
Department of Telecommunciation (DoT). The
3G and WiMAX spectrums are scheduled to be
auctioned during January and February 2009.

In a recent announcement, the India
chapter of the WiMAX Forum has made
public its plans to set up an applications lab
at the Indian Institute of Technology (IIT),
Delhi. In view of the high business potential
of the Indian market, the WiMAX community
places high importance on India; this is
evident from the plan to set up this lab, only

Date Action
Dec 11 & 13 2008 Bidders meet
Dec 19 2008 Pre-bid conference
Dec 31 2008 Last date of submitting applications
Jan 05 2009 Pre-qualification of bidders
Jan 16 2009 First phase of auctioning
Feb 09 2009 Second phase of auctioning

The timetable
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� High speed data and telecom services:
WiMAX specifications can be used by telecom
operators to design high speed communica-
tion and data services for consumers.

� Providing Nomadic connectivity: Mobile
WiMAX would make it possible to provide
good connectivity to communication devices
in motion.

� Connectivity systems for disaster situations:
during disasters and calamities physical infra-
structure can become damaged, limiting
connectivity in critical situations. WiMAX
connectivity can be vital in such conditions.

� Physical infrastructure substitution: high
speed data backhaul through WiMAX can
lead to the transformation of many data
intensive services by the substitution of the
physical hardware by wireless connectivity.
For example, Internet Protocol Television
(IPTV) can substitute traditional cable-based
TV, backhaul for Wi-Fi hotspots can shift
from DSL, evolution of mobile data TV, emer-
gency response services, wireless backhaul as
substitute for fibre-optic cable, etc.

What are the major concerns about
WiMAX?
Despite the mentioned advantages and the busi-
ness potential, there are several potential issues
and roadblocks for a WiMAX rollout in India:

� Spectrum Allocations Issues: globally, the roll-
out of WiMAX in many nations has been
delayed due to the required frequency bands
being occupied for other applications. The situ-
ation was similar in India with a substantial
portion of the required frequency being used
by the military. With the recently planned
auctions for WiMAX the roadblocks seem to be
lifting.

� Market downturn: due to the recent
economic downturn, firms may find it diffi-
cult to pull in financial resources to make the
necessary investments for WiMAX rollout.

� Other technologies: availability of existing
technologies and required investments may
deter many firms from making the shift to
WiMAX. Additionally, the long delayed 3G
would also compete for market share in India,
possibly leading to restricted growth for
WiMAX.

� Performance Issues: In addition, some of the
frequencies utilized by WiMAX are subject to
interference from rainfade. The unlicensed
WiMAX frequencies are subject to RF interfer-
ence from competing technologies and
competing WiMAX networks.

What’s ahead for WiMAX?
Keeping in mind the technical superiority of
WiMAX over other wireless networking tech-

nologies, the possibilities are rife that WiMAX
would be used to develop higher generation
data and communication technologies like 4G.
For instance, the US based telecom firm
Qualcomm has been pushing a standard for 4G
known as 802.20, based on OFDMA, a multi-
plexing standard developed for WiMAX.

Further new technologies like 802.20
Mobile-Fi are expected to emerge challenging
existing standards and providing better
performance in terms of bandwidth, speed,
reduced latency, encryption (noise reduction &
security), et al.

3G vs. WiMAX
Comparison of existing wireless
communication technologies
The communications space has seen an array of
wireless technologies, each bringing in a new
set of characteristics and raising performance
standards. 3G, WiMAX, Wi-Fi and Bluetooth, are
the prominent ones.

In terms of data transmission capabilities,
WiMAX leaves all the currently available wire-
less technologies far behind. LTE, a technology
being backed by Ericsson, is similar to WiMAX
and is expected to surpass WiMAX in terms of
performance in future.

Comparison of 3G and WiMAX
Both 3G and WiMAX have been touted as the
next big hopes for the communications sector
and particularly telecommunications technol-
ogy. Globally, 3G has been present in the
market for a period of time and has acquired a
market share, while WiMAX is still a very recent
phenomenon which has had limited deploy-
ments across the globe. A comparative analysis
of both follows:

� Existing infrastructure: in many nations
large telecom players have invested heavily in
3G technology in the last few years, creating
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Data Capacities of wireless technologies

Uplink Downlink

firms globally to shift telephony to VoIP,
enhancing the importance of WiMAX. The
shift to IP-based network enables much easier
and cheaper network monitoring and manage-
ment with standard tools for telecom opera-
tors.
� Flatter and simpler topology: a data

network by design, WiMAX has a more
simple topology compared to cellular
networks which have undergone layer addi-
tions to accommodate data transmission
capabilities. WiMAX also requires less time
and fewer hardware, investment and human
resource to set up than traditional cellu-
lar/Wi-Fi infrastructures, resulting in lower
service costs for end users. WiMAX also
provides the capability to scale up and down
according to the application requirements.

� Adaptability to a wide range of applications:
with its IP-based architecture, WiMAX
supports a wide range of communication and
data transfer applications. WiMAX also
provides the possibility of transforming the
way a large number of services such as inter-
net, telephony, cable TV, etc. are currently
provided to consumers.

� Inexpensive interface: the costs involved in
migrating existing hardware to WiMAX are
low, owing to the low prices of the required
chipsets and interfacing devices.

How does WiMAX compare with WiFi?
Even though a large number of comparisons are
made between WiMAX and WiFi, the similari-
ties are limited when compared to the perform-
ance differences between these two technolo-
gies. WiMAX provides a wide range of advan-
tages over Wi-Fi:

� Wider reach: Wi-Fi is short range (30-100
metres) compared to WiMAX, which provides
a coverage radius of about 50 kms. This leads

to Wi-Fi being limited to providing access only
within a shop or a floor of a building, while
WiMAX in comparison can cover much wider
spaces.
� Optimal bandwidth utilization: advanced

multiplexing provides better bandwidth
utilization in WiMAX compared to WiFi.

� Higher speeds: Wi-Fi hotspots are typically
backhauled over ADSL. Due to this, Wi-Fi
access has poor upload speeds between the
router and the internet compared to WiMAX.
Additionally, no traffic prioritization leads to
farther systems being made to wait longer
than the ones close by in a Wi-Fi network.
Proper scheduling in WiMAX standards takes
care of this issue.

� Limited hardware and manpower require-
ment: to service an area covered by WiMAX
using Wi-Fi networks would need a large
number of hotspots to be created through
routers. This necessitates a much higher
manpower and hardware requirement for Wi-
Fi compared to WiMAX which only requires a
tower to be installed.

� Noise reduction: with stronger encryp-
tion/modulation, WiMAX performs better in
noisy conditions.

� Security: with enhanced encryption,
WiMAX offers better security than Wi-Fi
networks which have been notorious for
security breaches.

What are the potential applications
of WiMAX?
The bandwidth, reach and IP-based topology of
WiMAX make it suitable for a large number of
potential applications. Some of the possible
applications of WiMAX which stand to trans-
form the way the whole information and
communication business operates globally are:

� Shifting telephony to VoIP: globally, fixed-
line telecom players are losing market share
to mobile operators. WiMAX provides an
opportunity for these players to transform
their cable-based systems to IP-based VoIP
system and provide additional high-speed
data services.

� Last mile broadband connectivity: WiMAX is
the ideal technology for providing a wireless
alternative to cable and DSL for last mile
broadband access to direct consumers.

� Connecting remote locations: remote loca-
tions with limited telecom infrastructure and
sparse populations can be financially infeasi-
ble when connected through physical wire-
based infrastructure. WiMAX provides a viable
option to provide connectivity in these areas

� Connecting Wi-FI hotspots: WiMAX can be
used to connect various Wi-Fi hotspots with
each other and to other parts of the internet.



exit barriers for themselves. These players
would find it economically unviable to shift to
another technology such as WiMAX without
having first gathered the fruits of their invest-
ments. But in India, with the delay in imple-
mentation of 3G, both WiMAX and 3G could
start the race for market penetration on equal
footing.
� Need: in a country like India where the pene-

tration of broadband and dial-up has been
limited due to the weak physical infrastruc-
ture, the need for newer technologies that
could reduce costs and dependence on physi-
cal infrastructure, is even greater. While 3G is
a strong technology, improving mobile
communication standards substantially, it
still trails behind advantages such as lower
cost of last mile connectivity, limited depend-
ence on physical infrastructure, faster
networks, higher data hauling capabilities,
limited data fade, and enhanced mobility,
offered by WiMAX.

� Availability of supporting applications: In
India most consumers still use phones,
computers, laptops and other devices which
do not support 3G or WiMAX. Due to talk of
3G being launched in India having been
going on for some years, there are a number
of 3G supporting phones now available in
here, while the devices supporting WiMAX
are yet to be launched in India. With big
players such Nokia and IMB, supporting
WiMAX in a big way and their plans for
launching chips and gadgets supporting
WiMAX in the near future, this issue will
surely be taken care of.

� Cost of migration for consumers: As
discussed, WiMAX is a relatively inexpensive
technology being targeted for the masses by
the big players. In the case of WiMAX, inter-
facing equipment is available helping old
cosumers shift to the new technology with
their old hardware, and the cost for the tran-

sition is expected to be very low due to the low
cost of related technology. Also, the cost of new
hardware supporting WiMAX would be similar
to that of their non-WiMAX versions. The same
does nor apply to 3G where most mobile
phones supporting it are substantially expen-
sive and require complete discard of old hand-
sets.
� Telecom player’s perspective:

�Fixed line: 3G is a threat for fixed line oper-
ators as it provides enhanced capabilities to
the mobile operators, providing an opportu-
nity for them to attract more consumers
and take more market share away from
fixed line. WiMAX provides an opportunity
for fixed line players to improve their
competitiveness through reduction of costs
around the physical infrastructure, and
improved performance capabilities by shift-
ing to VoIP.

�Mobile: Mobile operators worldwide have
recognized the importance of 3G, yet
WiMAX would remain attractive, owing to
its enhanced data transmission capabilities,
providing an opportunity to offer enhanced
data and communication services.

� Applications: as discussed earlier, both 3G
and WiMAX would support the evolution of
enhanced communication products and
services, but the impact of WiMAX is
expected to be bigger and goes beyond cellu-
lar communication — affecting a wide range
of services including cable TV, fixed line
telecommunication, network data back-
haul, etc.

Close scrutiny suggests that both 3G and

WiMAX have a lot to offer to the Indian
market, with WiMAX being a bit more suited
to the India condition especially with the
delayed deployment of 3G and weak fixed wire
& broadband infrastructure. Opportunities
are vast for 3G and WiMAX in India with the
possibility of them co-existing as complimen-
tary technologies in the wake of strong
communication and coverage needs here. It is
likely that both technologies would continue
to operate in India with the market being frag-
mented between these two new technologies
and other legacy systems.

readersletters@thinkdigit.com

Standard Family Application Multiplexing Notes
802.16e WiMAX MobileInternet SOFDMA Quoted speeds

achievable at short
range; practically
10Mbps at 10Km

HIPERMAN HIPERMAN MobileInternet OFDM
WiBro WiBro MobileInternet OFDM Short range (<5km)
UMTS W-CDMA UMTS/3GSM Mobile phone CDMA/FDD Roadmap shows
HSDPA+HSUPA HSDPA up to

28.8Mbps from the
base station. Users
can get D/L of
400-600 Kbps and
~100Kbps uplink

UMTS-TDD UMTS/3GSM Mobile Internet CDMA/TDD Reported speeds
according to
IPWireless

Competing wireless communications technologies

Parameter 3G WiMAX
Communication for Download 2 Mbps; Download 10 Mbps;
stationary devices Upload 0.15 Mbps Upload 2-3 Mbps
Communication for Low speed 0.14 Mbps High speed 2 Mbps
mobile devices High latency (>100 ms) Low latency (<100 ms)
Bandwidth Theoretical maximum Theoretical maximum

2.4 Mbps 70 Mbps
Security High High
QoS High High; latency as low as <10ms

Specifications for 3G and WiMAX
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In his column in the January issue of
Digit, Edward Henning promised that we
would start covering the issue of
customer service, and invited readers to
write in to us at servicewatch@
thinkdigit.com, with any serious and
properly documented examples of bad
service they had received. We have
received some examples from readers,
although at the time of writing most of
these are still under investigation. Of
course, consumer rights are protected by
law, and therefore, in this article, we
start by looking at the relevant legisla-
tion as well as an example problem from
one of our readers.

If you have a genuine problem
with a vendor, often, one of the
quickest ways of getting them to

take action is to make it clear that
you understand the law that
protects you, and you are fully
prepared to make use of it.

Several years ago in the UK, I
learnt that when confronted by a
shop or other vendor that refused
to, say, exchange a printer that
didn’t work properly, to say some-
thing like this: “Are you not familiar
with the law, under the Sale of
Goods (Implied Terms) Act, 1972?

“I am, and so is my lawyer. Your
refusal to exchange my printer
contravenes that law. Are we going
to do this the expensive way?” That
usually does the trick nicely. So,
what is the equivalent here in India?
In order to find out, I went along to
the Department of Consumer
Affairs, and met its Director, Mr. G.
N. Sreekumaran. He told me that the
state of customer care in India is not
up to the standards that I might
have seen back in the UK, and that
many companies either do not give
prompt and proper response, or they
do not even have customer care
departments. Of course he is refer-
ring to the whole range of compa-

Customer
satisfaction
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cases, the resolution of complaints runs at about
14 per cent, but with those companies in the
Convergence Process, it is around 50 per cent.
The main reason for the 50 per cent figure is
that many complaints turn out not to be valid.
With the 14 per cent figure, however, there are
also many companies that simply do not comply.
It is then that a consumer will need to turn to
the courts.

The court structure that has been set up
under the provisions of the Consumer Protection
Act is a three-tier system, with District Forums at
a local level, State Commissions at the state level,
and the National Commission for the country as
a whole (with the exception of Jammu and
Kashmir). These courts attempt to resolve all
disputes within a 90-day period. However, in prac-
tice, this usually does not work out. The company
against which the complaint is made has to be
given time to investigate the complaint and
arrange any defence — this usually takes the
process over the 90-day period.

These courts are under the umbrella of the
National Consumer Disputes Redressal
Commission (see: ncdrc.nic.in). Action through
these courts is clearly a last resort, and the
government intends to set up a system of
conciliation and mediation that consumers
could use instead of going to the courts. This
will be along the lines of the UK’s Consumer
Direct Service, a government funded service for
information and advice on consumer issues.
That organisation’s web site states that it “will
recommend a clear course of action to follow”,
but, “cannot intervene directly in consumer
matters, such as taking action against a trader.”
I get the sense that the Indian equivalent will
perhaps have a few more teeth than the UK
original. Let’s hope so.

A free market is supposed to work by the
law of supply and demand — notice that second
word. The market can only supply what
consumers demand, and if we are undemand-
ing — not just of the products we need, but also
of the quality that we expect and the service
that we deserve — then we should not be
surprised to receive poor treatment. So, if you
are treated badly by a company, make sure your
complaint is genuine, acquaint yourself prop-
erly with the law and your rights, and press
your complaint vigorously; if necessary, with
the help of the National Consumer Helpline.

Everybody benefits. Not just you if you end
up getting your printer or ‘phone fixed, but the
industry as a whole, because complaints tend
to push companies to providing better prod-
ucts and services which in turn means that
their customers are more likely to return to
them and purchase more. And the offer still
stands to let Digit know of serious problems
and we will contact the company concerned on
your behalf: servicewatch@thinkdigit.com.
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nies and goods and service.
The relevant legislation is the Consumer

Protection Act, 1986, together with several
amendments (see: http://ncdrc.nic.in/1_1.html).
The language used in a legislation like this
makes for pretty heavy reading, and so I shall
not quote from it extensively. However, one of
the key points is that the consumer is
protected from goods having any “fault, imper-
fection or shortcoming in the quality, quantity,
potency, purity or standard which is required
to be maintained by or under any law for the
time being in force under any contract, express
or implied or as is claimed by the trader in any
manner whatsoever in relation to any goods”.
Services are also covered.

There is also mention in the Act of protec-
tion regarding unfair trade practices, pricing
and other issues, but the key point is that you
are guaranteed redress, if something you
purchase doesn’t meet proper expectations —
even if there is no warranty or the warranty
has expired. For example, in an extreme case, if

you purchase a printer, and only try to use one
particular function that is described in the
documentation a few days after the warranty
expires, and find that it fails, you have a very
good case for replacement if it can be shown
that this has not come about by normal wear
and tear. This function may not have been
mentioned when you purchased the printer,
but it is common in printers and is clearly
documented — it is therefore a quality which
was implied when you made the purchase, to
use the language as given in the quote above.

If you are faced with a situation like this,
and the vendor refuses promptly either to repair
or replace the goods, or give you your money
back, the first thing to do is to make it clear that
you are fully aware of your rights under the law,
and you are quite willing to use the law to seek
redress. You should, of course, make sure in the
first place that you have a genuine case, by read-
ing carefully the warranty and any terms and
conditions that might apply.

If this does not work, and the vendor is not
addressing your complaint properly, what
should you do next? I put this question to the
Department of Consumer Affairs’ Mr.
Sreekumaran. He suggested that the first step
should be to call the National Consumer
Helpline, on 1800-11-4000.

There are basically two levels of help that
you might receive. The first one concerns
companies that have joined the curiously
named Convergence Process with the
Helpline. Currently there are about 150 such
companies, and they include some names
that will be familiar to Digit readers, such as
Airtel, Reliance, Acer, BPL Sanyo, Hitachi,
Lenovo, LG, Motorola, Nokia, Philips,
Samsung, Sansui, Sharp, Sony and Sony
Ericsson. The list from which these names
have been taken is at least two months old
and more have recently joined.

If a complaint comes in to the Helpline
regarding one of these companies, the details
are immediately sent electronically to the
concerned department in the respective
company. These companies have all stated that
they will act promptly on the complaints they
receive, and give feedback to both the aggrieved
consumer and to the Helpline. If this scheme
works as described, then the more companies
sign up, the better. If any of you do happen to
use the Helpline, do let us know results you
obtain, either to the email address given above,
or through the forums on thinkdigit.com.

If the company with which you have a
complaint has not joined the Convergence
Process, the level of help you get will vary. The
helpline will do its best to help, advising you
who to contact in the company and how to
approach the problem.

According to Mr. Sreekumaran, with these

The case of a faulty monitor

One reader contacted us after her business monitor from ViewSonic
failed while still under warranty. She told us that the company

took six days to visit, but were unable to fix the monitor immediately.
No replacement was offered, and time dragged on. After three weeks
without a working monitor, and several calls to ViewSonic, she wrote
to Digit. We, in turn, contacted ViewSonic. The company acted very
quickly, and within a couple of days our reader had a new monitor.

So, what had gone wrong, if anything? We spoke to Mr. Neeraj
Verma, Customer Service Manager for ViewSonic India. He told us that
one problem with this case had been the fact that the particular
model of monitor concerned was “End-of-Life.” This means that the
company no longer sells it, or are just selling off the last ones, and so
they are running down the stock of spare parts, etc., making it diffi-
cult to repair. This is clearly true, as the replacement monitor that has
been delivered to our reader is a more recent model.

The other main problem was that two components were faulty in
this particular device, and this was not realised when the monitor was
first inspected.

Mr. Verma told us that the company usually manages to fix
customer problems within five days, sometimes in just one or two
days. So, judging by ViewSonic’s own standards, this particular reader
was not treated well, having been without a working monitor for over
three weeks.

One point Mr. Verma made that echoed comments from the
Department of Consumer Affairs was to ask that customers check
their facts fully before making a complaint. Check your warranty and
terms and conditions — the ViewSonic web site has some information
on this — and make sure you have a valid complaint first. He said that
there are a significant number of false complaints that are made, and
that these slow down the process of fixing genuine ones.

In summary, this was perhaps a more difficult case than normal
for ViewSonic, and the company did act quickly after we contacted
them, but it seems wrong to leave a customer without a working
system for so long.
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Many would agree that 
notebooks or laptops 
were considered tools 

for the elite businessmen under a 
decade ago. That is no longer the 
case. Today, students carry them 
to school and colleges. Some even 
use it as their only computer 
because they make for a simpler 
purchase than a desktop PC, and 
a convenient one.

Price played a part in this 
shift of perception. Notebooks 
were expensive once, well beyond 
the reach of all but the elite 
businessmen that carried them; 
they have dropped in prices over 
the years. Today, you can easily 
purchase an entry-level laptop 
for less than Rs. 25,000. Still, 
there are a few problems with 
notebooks even though they are 
this cheap. Although they have 
become smaller and more power-
ful, power consumption also has 
gone up and down went their 
battery life. Thus most laptops 
that you can buy for around  

Rs. 25,000 will have a battery life 
of about two hours. The other 
problem with laptops this cheap 
is they are heavy and painful to 
lug around; not exactly portable 
at that. While there is a solution 
— to opt for ultra-portable note-
books, these typically start at 
around Rs. 75,000 and they are 
often out of the reach of most of 
us looking for portability.

The year 2008 changed the 
status quo though. It saw a wave 
of notebooks hit our shores with 
the launch of the highly antici-
pated, low-power processors 
from Intel called the Atom. The 
Atom processor was (relatively) 
cheap, small and power efficient. 
With the first Atom processors 
sprouted brands that used these 
in their low-power notebooks. 
These were quickly called net-
books and they were targeted 
at users who wanted affordable 
laptops. Netbooks are so-called 
as they happen to be best suited 
for tasks of surfing the internet, 
along with mild office usage.

The first question to ask here 
is why anyone would want to 
buy a netbook. To start with, it’s 
probably not the best thing to 
own as your primary computer: 
if you have no other PC or laptop, 
a netbook won’t serve you best. 
At least not today, who knows 
what future processors bring to 
this segment... With that caveat, 
there are many scenarios that 
fit netbooks perfectly. They have 
long battery lives so you can get 
the same battery performance 
you would get on an expensive, 
power-efficient laptop. Netbook 
make great second computers to 
own. You can carry them wherev-
er you want. You can use them to 
browse the internet while sitting 
in the living room on the couch, 
watching a game of cricket on 
TV. Unlike most “laptops” these 
will actually fit in your laps and 
not run as hot as to burn you. For 
those who would like to buy a 
cheap PC, a netbook could be an 
option to consider — just remem-
ber that you will have to do with-
out an optical drive, as well as 
with a very cramped keyboard.

Prêt-à-Portable 
Looking 
for a light 
notebook 
that won’t 
break the 
bank? 
Then a 
netbook is 
what you 
need
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Today, almost every brand 
has a netbook to offer. This is 
then the right time for us to do 
a small comparison of the net-
books available in the market. 
We received seven netbooks from 
six brands. One of the newest 
netbooks to come to India was 
the BenQ Joybook Lite U101. We 
weren’t given a price for this yet.

Acer Aspire One

The Acer Aspire One was one of 
the first netbooks to arrive 

in India, along with 
the ASUS Eee PC and 
the MSI Wind. This is a 
smaller laptop in com-
parison to the others. 
The Aspire One comes 
with a 9-inch screen 
much like the ASUS 
904HA. The big differ-
ence is that the size of the 
Aspire is a lot smaller than 
the ASUS Eee PC 904HA. 

When it was released, many 
considered the Aspire One to 
the best looking netbooks and its 
blue-coloured avatar was proudly 

exhibited in almost every mall 
across the country. It was this 
netbook that we received. This 
One has a glossy finish on the 
top and on the insides surround-
ing the screen. The hinge of the 
Aspire One houses its status LEDs 
and the ends of the hinge have 
an orange tip compliments the 
look and finish of the netbook.

Build quality of the Acer One 
is average; the outer shell feels 

right but the keyboards have 
a light feel. Pressing them 
doesn’t require a lot of effort 
and the keys feel slightly 
wobbly.

Speaking of the key-
board, we come to per-
haps the biggest negative 

of netbooks —being 
such small laptops, 

they keyboards 
a c c o r d i n g l y 
shrink in size. 
For the Aspire 
One, the keys 

are smaller all 
throughout the key-

board. The touchpad too is 
small with the mouse buttons 
positioned vertically instead of 
horizontally. Although get-
ting used to the limited sur-
face area of the touchpad is a 
problem for everyone, the but-
tons were easier to get used to 
over time. The touchpad is so 
small that you have to swipe 
your finger many times verti-
cally to move the pointer from 
the top to the bottom of the 
screen. Even changing the mouse 
sensitivity didn’t help a lot.

The audio quality is fine and 
fairly detailed; just not loud 
enough. If you think you might 
watch movies or TV shows on 
this netbook, you might need 
either laptop speakers or a good 
set of headphones. The screen 
isn’t so great for movie watching 
either: viewing angles aren’t for-
giving and the backlight bleed-
ing is clearly visible.

If anyone gets the impression 
that this isn’t a good netbook, 
then they are mistaken. Netbooks 
were expected to be under Rs 
20,000 before they were to be 
released. Manufacturing costs 
drove the prices over that mark 

but today. Acer has informed us 
that the price for the Aspire One 
is Rs 20,000 and it differs from 
model to model. The pricing for 
it on online shopping sites when 
we last checked for the Aspire 
One with Linux was around 
some Rs. 14,500 and the one with 
Windows XP is Rs. 17,500. The 
Acer Aspire One in that case is 
good value for money.

ASUS Eee PC 904HA 
and 1000H 

The ASUS EeePC 10000H and 
the 904HA are almost identi-

cal to each other in shape and 
design. With their lids shut, the 
only real way to tell them apart 
is to look for the 1000H’s pro-
truding battery. The 904HA we 
received came with a 6600mAh 
battery.

The 904HA, as its name sug-
gests, has a 9-inch screen and the 
1000H, a 10-inch one. The 904HA 
has two thick panels on the either 
side of its screen which look like 
speakers at first but the speakers 
are in fact at the bottom, for both 
these netbooks. 

One of the complaints laid 
out at the Eee PC’s feet has to 
be about its small and narrow 
vents that run down the side of 
the netbook. This makes the Eee 
PC heat up a little more than the 
others as there isn’t a lot of air 
ventilation within the chassis. 
The Eee PC netbooks also look 
plain and don’t stand out much. 
The keys feel a little flimsy and 
the mouse buttons for the touch-
pad are a bit tacky as well. One 
of the unique features of the Eee 

Netbooks aren’t meant for high-end gaming or 
even for power-users. Having read up and fol-

lowed developments on netbooks for a while, it was 
expected that almost all the brands would be very 
close in performance, ruling out performance as the 
deciding factor while purchasing one. We modified 
our laptop comparison test sheets to better suit the 
netbooks. PCMark 2005 was used as the primary test 
for desktop application performance. We even ran 
an older 3DMark - 2005 on the netbooks to measure 
graphic subsystem performance. We also used SiSoft 
Sandra as a synthetic benchmark to gauge other 
subsystems including the memory subsystem and the 
hard drive. 

One of the most important points we focused 
on was the battery life test. A video was run with 
the brightness of the screen and volume turned up. 
Some of the netbooks had built-in overclocking and 
battery saving features, which were all turned off for 
the test.

We decided to run Far Cry just to see what kind of 
gaming performance we could get from the netbooks. 
We also did a DivX video compression test and a 
WinRAR benchmark to measure processing power.

Scores and ratings were also given to the other 
features of the netbooks. We looked at screen quality, 
audio quality, build quality, touchpad and many other 
aspects of the netbooks. 

  How We Tested
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PC is its multi-touch track pad 
which allows you to use gestures 
by sliding multiple fingers simul-
taneously, like you would do on 
the new Apple devices.

The keypad is one of the most 
usable, of all the netbooks we 
tested. There are dedicated but-
tons for changing screen resolu-
tion, Skype, performance modes 
and also to turn off the screen. 
There is no button or shortcut 
to disable the touchpad though.  
There are some small differences 
between these siblings though 
– the webcam is a 1.3-MP on 
the 1000H and a 0.3-MP on the 
904HA, the latter also misses out 
on Bluetooth.

The biggest differences 
between the two are their screen 
size and battery. We recommend 
the Rs. 23,990 1000H as are you 
aren’t saving any baggage space 
by picking the 9-inch 904HA. 
On the other hand, if you value 
battery life above all, then the 
904HA is the one to buy. That’s 
available for Rs. 20,490.

BenQ Joybook Lite 
U101 

BenQ is best known for the LCD 
screens and optical drives but 

not so much for laptops in India. 
At first glimpse, things look very 
good for their new netbook. 
The first thing you notice about 
the BenQ Joybook U101 is its 
beautiful surface; complete with 
accented patterns under its blue 
glossy finish. It gives the netbook 
a unique look and makes it feel 
more personal.

With the lid opened, the 
inside of the laptop resembles the 
LG XNote and the Lenovo IdeaPad 
S10. It doesn’t look a lot different 
from the LG and the Lenovo here. 
A metallic power button, two 
sets of LEDs, rounded edges and 
a rounded combined mouse but-
ton are some of things that stand 
out when you look at it.

The screen of the Joybook is 
16:9 and runs at a resolution 
of 1024 x 576. This is a little 
less vertical workspace than 
the other 1024 x 600 displays. 

This might be great for movie 
buffs but not so great when you 
need the most workspace avail-
able for other applications. While 
rest of the hardware remains the 
same as the other netbooks, the 
Joybook Lite U101 is one of the 

only ones to give you more than a 
gigabyte of memory to start with. 
The U101 comes with 1.5 GB of 
RAM which can be upgraded to 2 
GB. This doesn’t show any drastic 
improvements over other note-
books in performance.

Although the performance in 
all tests match the other net-
books, the battery life test shows 
that the 3-cell Joybook Lite lasts 
for just over two hours. That’s a 
bit better than 10-inch Lenovo 
S10 and a lot more than the LG 
X110.

The BenQ has nothing more 
to offer in terms of performance 
or features. A set of necessary 
feature and looks is what it has 
going for it mostly. Being a very 
new product, BenQ hasn’t provid-
ed us a price for the Joybook Lite 

U101. Still, the BenQ Joybook Lite 
in our opinion is a good option 
should the price be around the 
Rs. 20,000 mark.

LG X110 

LG isn’t very aggressive in the 
laptop market but their new 

netbook is an interesting one. 
The LG X110 is one of the best 
looking netbooks around and 
one which is very comparable to 
the Lenovo IdeaPad and the BenQ 
Joybook. One notable aspect of 
this netbook is a neat array of 
LEDs lining its bottom, and a 
glowing blue power button.

The entire look of the LG 
X110 makes it almost a Mac-like 
laptop when opened. The white 
is bound to get dirty over time, 
though. The touchpad is good 
and has a single piece button 
with two mouse buttons. The 
design and feel of the touchpad 
is great and is effortless to use. 
A hotkey can be used to disable 
the touchpad if you choose to 
use an external mouse instead; a 
welcome touch.

Its speakers are one of the 
weaker points of the LG X110. 
They are very loud but they have 
a very shrill treble output and 
don’t make for good music lis-
tening. Another kink in the LG 
is that the netbook has a front 
end where you normally rest you 
palm that sticks up from the 
surface you place it on. Typing 
becomes a little uncomfortable 
this way. Some other manufac-
turers have chosen to bevel that 
edge so you can rest your palm. 

A feature not seen on compet-
ing netbooks is the 3G modem 

built in as an 
option. A sim card 
can be inserted 
into the netbook 
which allows you 
to access the 
Internet. This 

could be a 
very use-

f u l 
fe a -
ture 

when 3G services finally arrive 
in India.

The keyboard feels well built 
with nice, firm keys. The netbook 
has plenty of wide open vents 
at its bottom such that there is 
almost no heat given out off the 
top of the netbook. Having said 
that, the area underneath does 
get a little hot. All in all, exclud-
ing the audio quality and low 
battery life, the X110 is a pretty 
decent netbook that rivals the 
BenQ Joybook for looks. 

Lenovo IdeaPad S10 

The Lenovo IdeaPad S10 grabs 
you attention with its deep-

blue top and chrome-finished 
Lenovo badge. The beauty runs 
to the inside as well though, with 
good attention to detail in places 
such as the camera, for example, 
which has a nice chrome ring 
around it. 

Looks aren’t everything and it 
doesn’t take too long to notice a 
few functionality issues with the 
S10. The buttons on the touchpad 
are hard and the Function key is 
placed on the extreme left of the 
keyboard instead of the Control 
key—if you are used to desktop 
keyboards, your hand will invari-
ably hit Function when you want-
ed to reach for the Control but-
ton. This is a problem also seen 
on the MSI Wind.

The F12 key, although not 
used often, is missing from the 
keyboard. It is only available 
as a hotkey. The Tab key is also 
much smaller. All these reduc-
tions seem to have benefited 
the rest of the keyboard layout 
— it’s spacious. The keyboard 
also feels sturdy with little trav-
el to the keys. 

Performance figures for this 
netbook were also identical to 
most of its competitors. A detail 
to note here: 3D Mark 2005 
refused to run due to the as the 
netbook lacked the minimum of 
128 MB video memory required 
for the benchmark. We couldn’t 
set the video memory beyond 
64 MB.

There aren’t any hotspots 
around the notebook. The only 
bit of heat can be felt on the sides 

of the unit; nothing around the 
touchpad, which is a good thing. 
There is a compact and light-
weight battery on the Lenovo S10 
which kept the S10 running for 1 
hr 48 minutes in our tests; which 
is a decent time.

There are many netbooks 
with better battery life and 
these are available for a lot 
less than the S10. At Rs. 26,000, 
it’s definitely expensive and is 
worth only looks matter the 
most to you. 

MSI Wind U100 

The MSI Wind is a 10-inch 
netbook and was one 

of the first netbooks avail-
able in India. Back when 
it launched, it was one of 
the favourites for its design.  
The Wind has a rounded 
and bevelled motif which 
many users seem to prefer 
to the more compact and 
bright glossy finishes found 
in competing netbooks. 

The build quality of 
the Wind is average. One 
of the problems is that the 
hinge for the LCD screen is 
pretty weak and wobbles 
at the slightest opportunity. 
The keyboard isn’t so good 
either. Still, the keyboard 
feels a little better than the 
ASUS Eee PC. Much like the 
Lenovo S10, this netbook 
has the Function on the left 
as well, which takes getting 
used to. The directional 
keys are smaller and nar-
rower and might not be so 
good for any simple games 

that you might want to play on.
The screen is decent but can 

be a little too bright, to be of com-
fort. There are LEDs for almost 
every kind of indication that you 
may need to see. The audio too 
doesn’t sound great and it tends 
to emphasise the highs a bit. 

In terms of performance, the 
only place where the MSI Wind 
lacked power was in the drive 
related tests. For example, SiSoft 
Sandra showed a 39 MB/s drive 
index score whereas the others 
were around 50 MB/s.

ASUS Eee PC 1000H

BenQ Joybook 
Lite U101

LG X110

Lenovo IdeaPad 
S10

MSI Wind U100
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The MSI Wind although a 
decent netbook, was expensive 
and difficult to get in 2008. The 
price is still a bit on the higher 
side, for what it offers.

What should you get?
There was no clear winner, no net-
book that stood out. All the net-
books had minor differences in the 
components used which reflected 
in the synthetic and real world 
benchmarks that we ran; but these 
performance differences were not 
big enough to come to notice. 

Battery life was the only important 
performance figure that emerged 
from this shootout. Battery life 
takes on more importance, since 
one would typically use a netbook 
away from a power socket; more 
often than not.

As far as battery performance 
goes, there is nothing to beat the 
ASUS Eee PC 904HA. It is undoubt-
edly the best of the lot. Four and a 
half hours is a really long time for 
a notebook to be running on batter-
ies. It also is good value for money 
and wins the Best Buy Awayd. The 

 Contact Sheet                   Netbooks
Contact Phone E-mail Web site

Acer Acer India 080-40708747 ganaraj.kamath@acer.co.in www.acer.co.in
ASUS ASUS Technology 022-67668800 / 18002090365 media_india@asus.com www.asus.in
BenQ BenQ India 0124-4501400 varun.singh@benq.com www.benq.co.in
Lenovo Lenovo India 080-22108490 / 18004252666 buy@in.lenovo.com www.lenovo.com/in
LG LG Electronics India 0120-2560900 salvi@lgindia.com www.lgindia.com
MSI MSI 18002000004 marketing@msi-in.com www.msi-in.com

  
Netbooks

Brand
Model

Acer
Aspire One

ASUS
Eee PC 904HA

ASUS
Eee PC 1000H

BenQ
Joybook Lite U101

Lenovo 
IdeaPad S10

LG
X110

MSI
Wind U100

Price (Rupees) 20,000 20,490 23,990 NA 24,490 26,000 25,000
Grand Total (Out of 100) 69.00 76.12 77.01 78.93 74.85 75.14 70.16
Features (Out of 70) 45.98 49.70 51.81 54.60 52.24 51.76 44.85
Performance (Out of 30) 23.02 26.42 25.20 24.33 22.61 23.38 25.31
Features and Specifications
Processor Model No Intel Atom N270 Intel Atom N270 Intel Atom N270 Intel Atom N270 Intel Atom N270 Intel Atom N270 Intel Atom N270
Processor Speed (MHz) 1600 1600 1600 1600 1600 1600 1600
Memory (MB) / RAM Type / Memory 
Speed

1 GB / DDR2 / 667 1 GB / DDR2 / 667 1 GB / DDR2 / 667 1.5 GB / DDR2 
/ 667

1 GB / DDR2 / 667 1 GB / DDR2 / 667 1 GB / DDR2 / 667

Chipset Intel i945 GSE Intel i945 GSE Intel i945 GSE Intel i945 GSE Intel i945 GSE Intel i945 GSE Intel i945 GSE
Graphics Solution Intel GMA 950 Intel GMA 950 Intel GMA 950 Intel GMA 950 Intel GMA 950 Intel GMA 950 Intel GMA 950
Audio Solution Realtek ALC268 Realtek ALC662 Realtek ALC662 Realtek ALC Realtek ALC Realtek ALC888 Realtek ALC888
HDD Size (GB) 120 160 160 160 160 160 80
Bundled OS XP Home XP Home XP Home XP Home XP Home XP Home XP Home
Characteristics
Screen Size (Inches) 8.9 8.9 10.2 10.1 10.2 10 10
Weight (kg) 1.23 1.4 1.45 1.05 1.2 1.19 1.17
No of Ports (USB) 3 3 3 3 2 3 3
Connectivity (LAN/Bluetooth/WiFi) 4 / 6 / 4 4 / 6 / 4 4 / 4 / 4 4 / 4 / 4 4 / 4 / 4 4 / 4 / 4 4 / 4 / 4
Type of Memory Cards Supported SD / MMC / MS / 

MSPro
SD / MMC SD / MMC SD / MMC / MS / 

MSPro
SD / MMC SD / MMC SD / MMC / MS / 

MSPro
Build Quality (Out of 10) 6.5 7 7 8 7 7 6
Ergonomics (Out of 10) 5 8 8 7 8 7 7
Performance
Synthetic Scores
PC Mark 2005
CPU Score 1466 1500 1497 1497 1480 1499 1501
Memory Score 2329 2442 2430 2369 2379 2402 2397
Graphics Score NA NA NA NA 524 525 NA
HDD 4271 4360 4382 4415 4425 4772 3953
Overall NA NA NA NA 1540 1535 NA
SiSoft Sandra 2008 Lite
CPU Arithmetic (Dhrystone / 
Whetstone)

4029 / 3347 4027 / 3351 4032 / 3343 4039 / 3340 4048 / 3338 4048 / 3352 4043 / 3314

CPU Multi-Media (Integer / Floating) 29469 / 19932 29437 / 19939 29342 / 19876 29449 / 19931 29503 / 19928 29562 / 20025 29277 / 20007
HDD Index / Random Access Time 51 / 9 51 / 9 54 / 9 50 / 11 53 / 9 53 / 9 39 / 14
Memory bandwidth (Integer / 
Floating)

2734 / 2404 3005 / 2603 2874 / 2506 2894 / 2522 2941 / 2550 2987 / 2587 2878 / 2484

3D Mark 2005
CPU Score 252 247 241 241 NA 242 244
Overall Score 1632 1622 1589 1571 NA 1632 1635
Real World Tests
Audio Test Speakers (Out of 10) 5 6.5 6.5 7 6.5 5 6
WinRAR 3.8 Benchmark (kB/s) 348 356 369 353 370 366 368
Farcry (fps) (640x480, low detail) 6.71 6.68 6.49 6.98 6.92 7.03 6.78
100 MB File Conversion (min:sec) 4:27 4:09 4:25 4:27 4:23 4:23 4:22
Battery Life (hrs:mins) 1:54 4:29 3:19 2:01 1:48 1:28 3:32

MSI Wind U100 with its 6-cell bat-
tery is also worth considering if you 
want a 10-inch laptop. The ASUS 
Eee PC 1000H should be the next 
on the list.

 If you just want a usable net-
book at the cheapest price, then 
the Acer Aspire One is the king. We 
have learnt from the that you can 
buy the Windows XP version for 
around Rs. 17,500.

Of all the netbooks, the BenQ 
Joybook Lite U101 looked the best. 
So if you want something attention-
grabbing, then this BenQ should 
be it. Its colourful back with its 
highlighted patterns will serve you 
nicely. It is also our Best Overall 
Performer with its great feature set, 
great speakers and build quality. n

rossi.fernandes@thinkdigit.com &  
kumar.j@thinkdigit.com
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Michael Browne	

When we think of cell-
phones we usually 
visualise a good cam-

era, WLAN connectivity for web 
browsing and a touch screen 
for fun interfacing. The average 
metropolitan has seen so many 
high-end cellphones that some 
of us forget that there is a whole 
new world that exists apart from 
PDAs and smartphones — a world 
for those of us that need just a 
phone. This may seem contrary 
to the aspirations of a college 
student or even those of a rick-
shaw driver who might yearn to 
own a Nokia N96 or an Apple 
iPhone. But the fact remains that 
while these phones are indeed 
worthy of pursuit, not every-

body can afford to purchase one. 
Moreover, not everyone may even 
want to purchase one. There are 
even those people who already 
have a high-end uber cellphone 
and they need another cheaper, 
no-frills device mainly for mak-
ing calls.

Through the following pages 
we address the bottom rung of 
the handset market. This mar-
ket is dominated by CDMA (Code 
Division Multiple Access) hand-
sets and a few cheaper GSM 
(General Subscriber Module) 
handsets. There are many people 

Thinking 
Small Cellphones aren’t all about touch screens, five 

megapixel cameras, and a burning hole in your 
pocket. We showcase 16 affordable marvels
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Nokia’s 2626 was the only Nokia 
phone in this entire test. Nokia 
did send us a couple of other 
phones but these were priced 
well above our cut off point of Rs 
8,000. The Nokia 2626 is a solid 
little phone that feels extremely 
well built owing to its compact 
dimensions and the choice of 
materials used on its outer body. 
There’s no camera and no memo-
ry expansion, and with an inter-
nal memory of 2 MB it’s clear 
that the 2626 isn’t much more 
than a basic phone. At its price 
point we’d be surprised really, if 
it were to be anything more. You 
can get it in a plethora of colours 
though; the one we got was a 
bright postman red (eek!) that 
very few of us liked.

Performance
Amongst the GSM phones, 
Samsung’s E1410 had the overall 
best performance. In fact we were 
impressed by the signal quality 
of this cellphone, as it has been 
our experience that ultra-afford-
able phones typically use ultra-
cheap antennas. This wasn’t the 
case here. We were disappointed 
with the Nokia 2626 in terms of 
in-call quality. The CDMA phones 
perform more or less similarly 
during the call and signal quality 
tests; the LG RD 3600 did have a 
very good quality headset pro-
vided and call quality with the 
hands-free plugged in was quite 
commendable. Only the LG RD 
6100 had a camera but it wasn’t 
too good; needless the inclusion 
of one is a feature that deserves 
mention in this particular price 
category.

And The Winner Is
LG’s RD 3600 has the best value 
for money for amongst all the 
sub-Rs 4,000 cellphones and is 
our Digit Best Buy Winner in this 
category. It’s suitable for some-
one looking at a CDMA phone 
that has terrific value for money 
– it’s cheaper than its sibling the 
RD 3610 but manages to outdo it 
on both feature and performance 
tests – it’s got a better keypad 
too. The best non-CDMA handset 
would be the Nokia 2626 – a little 

brick that will last a long time 
and is quite a good phone in the 
bargain. If you absolutely must 
have a camera, you have only 
one option in this category, LG’s 
RD 6100.

Cellphones above 
Rs 4000
The bridge between affordable 
and pricey

For those looking for a phone 
with a few more features than 
the shoestring options list-
ed below we have these — the 
phones priced between Rs 4,000 
and Rs 8,000. We feel this is 
perhaps the most interesting cat-
egory of them all. The phones in 
this category may not have the 
appeal of costlier devices, nor do 
they move in the volumes that 
the sub-4000 rupee models do. 
But they do represent a good 
compromise between price and 
features. Chances are that any-
one looking for a basic cellphone 
would at least demand some 
rudimentary features: 
a decent music player, 
the ability to take pho-
tos and videos, and of 
course an expandable 
memory capacity. It is 
also likely that such 
a user would also 
want a slightly better 
screen, with a great-
er viewable area and 
richer colours. Such 
phones will also be 
better built, offer (in 
general) better ergo-
nomics and keypads. 
In short this category 
hits the sweet spot 
between functional 
and convergence. 
LG had four phones 
in this category; 
Samsung had three, 
while Sony Ericsson 
had two handsets. 

Features
When it comes to 
looks its hard to 
ignore LG’s KM380T 
– it has a very neat 

looking flap that covers the key-
pad and opens downwards. In 
fact this reminds of us of some of 
the older Siemens and Motorola 
handsets and there’s something 
about the whole flap setup that 
looks very classy. The sides of the 
phone are chrome and the back 
is finished in dark grey matte 
plastic. Overall it’s quite a com-
pact phone and is lightweight; 
this imparts a solid in-hand feel. 
The flap itself however isn’t as 
well built as the rest of the phone 
and a little rough usage may get 
it damaged. The flap has a few 
buttons on its surface that coin-
cide with the buttons that make 
up the joypad, and while the 
joypad works normally when the 
cover is open, close the cover and 
the same buttons work as multi-
media controls. This phone has 
a 3.5-mm jack; you can plug in 
your headphones directly. While 
the joypad and menu buttons 
are quite usable and ergonomic, 
offering decent feedback, the 
number keypad is just too clicky 
and basically horribsle. In fact 

SMS junkies will rue 
the day they purchased 
this phone. Maybe 
people with extreme-
ly small fingers may 
find it decent; we 
certainly didn’t. The 
keypad’s lighting is 
very bright and vis-
ible, although it’s not 
even. Samsung’s L700 
is a very simple look-
ing phone but it’s built 
like a brick. If there 
were ever a phone that 
could be used as a 
weapon this would be 
it – a solid, thick steel 
rear-battery cover and 
a front bezel also of 
solid steel. This makes 
the phone heavier and 
it’s also quite a long 
device. This phone 
doesn’t work with-
out a SIM i.e. offline 
mode which is a shock-
ing omission since 
the cheaper Samsung 
phones work fine.

Sony Ericsson’s 

who just need something basic 
yet functional. For such people  
i.e. those who cannot/will not 
spend more than Rs 8,000 on a 
cellphone, we present this test.

Cellphones up to 
Rs 4,000
The minnows in a sea of sharks

Basic cell phones may be far 
from flagships but they rule 

the volumes game. So while bud-
get cellphones will not have fea-
tures like WLAN, integrated GPS 
and a great camera, for every 
person who finds a high-end 
phone at least 20 more people 
buy an entry level handset. In 
fact, this segment is ultra com-
petitive as peoples tastes change 
very fast. Phones like the iPhone 
are sought for the immeasurable 
sex appeal associated with the 
device; and a thousand reviews of 
the same bloom online. Demand 
for it remains more or less stable 
— people who want an iPhone 

will remain fans. 
But what about 
a Rs 3,000 device 
which is only 
solid in India 
and that too only 
with a Reliance 
CDMA connec-
tion? Details 
are sure to be 
scarce and reli-
able views and 
opinions about 
as rare as rain in 
a desert.

We tested 
a total of seven 
phones priced 
below the Rs 
4,000 mark. 
Obviously most 
of these phones 
are CDMA hand-
sets. CDMA is 
very prevalent 
with the lower-

end of the handset market. This 
is because most people go for 
a CDMA phone simply because 
Reliance and Tata (the two main 
CDMA service providers) provide 
very cheap call rates. Another fac-
tor is that the calls made within 
the same service providers’ circle 
are usually free. Many people 
who already have a smartphone 
with a GSM SIM card therefore 
opt for a cheap CDMA handset 
just to make local calls, or send 
bulk SMSes or any similar usage 
scenario.

Five of the seven handsets 
were LG ones while Nokia and 
Samsung have a model each in 
this category.

Features
LG provided us with four models 
that obviously form a steplad-
der in terms of their placement 
in their product range. The RD 
3500, RD 3510, RD 3600 and RD 
3610 are all in a row of ascending 
features, ditto pricing. The RD 
3610 is the highest and the prici-
est model amongst the quartet. 
Both the RD 3500 and RD 3510 
are SIM-based phones and both 
of these have rather plain colours 
and finishes. The RD 3510, espe-
cially, has a very light-grey rear – 

we feel this looks plain ugly. That 
being said both these phones are 
very compact and feel rather stur-
dy. The RD 3510 has a diaphragm 
type keypad instead of the button 
type keypads we’re used to, and 
quite frankly this keypad is a let 
down in terms of key feedback; 
usability suffers as a result of 
this. Even the menu buttons are 
hard and feedback is not ideal. 
We also feel that this keypad will 
not last long, as our experience 
with diaphragm-based keypads  
over the years has taught us. 
Another ergonomic nightmare 
is the fact that neither of these 
phones — the RD 3510 and the 
RD 3500 — have a middle button 
on the joypad. Pressing the left 
menu button to select an option 
every time you wish to activate 
something within the menu is 
just a royal pain.

Despite the fact that the 
RD 3610 is the costliest of the 
quartet above, it’s also got the 
cheapest build quality of all the 
phones and we didn’t like its 
rough-finished rear. LG’s RD 6100 
is the fifth LG phone in this cate-
gory. It’s compact and well-built, 
with a choice of materials that is 
much better than the other LG 
phones. Once again it’s a CDMA 
handset. The phone has a very 
solid in-hand feel. Although the 
joypad looks like it would be awk-
ward to use at first glance, it sur-
prisingly works beautifully. Once 
again this handset is SIM-based. 
A camera has also been provided; 
something the other LG handsets 
missed, complete with a mirror 
for vanity shots. Samsung’s E1410 
is the next phone in this cat-
egory. It’s a basic looking phone 
that has a solid build and feels 
very dense in-hand. No camera 
and no video playback support 
means that this is pretty Spartan 
for those looking for multime-
dia. That being said, the phone 
supports memory expansion 
via microSD. Samsung probably 
provided this feature for those 
wanting to store and listen to 
music. This was also the only 
phone in this category that fea-
tured Bluetooth, and is also the 
costliest phone in this category. 

We scoured the bottom-half of the market and 
decided to divide our contestants into two cat-

egories. The first category consists of cellphones up to 
the price of Rs 4,000, which we feel is a cut-off point 
for many buyers who want a basic cellphone. The 
other category consisted of cellphones priced above 
Rs 4,000. We decided to cut-off all cellphones priced 
above the Rs 8,000 rupee mark as anything higher 
than this approaches the smartphone territory.

Besides rating a phone’s specifications and fea-
tures we also paid close attention to its ergonomics. 
We gave scores for keypad layout, keypad comfort, 
joystick/joypad feedback and general ease of use. 
Besides this, we also rated the build quality of the 
device, its keypads, and any movable parts, (such as 
sliders, battery covers etc.), and of course, the quality 
of its accessories.

In terms of performance the most important 
criteria for a budget cellphone is its call quality. We 
also rated their cameras and multimedia playback. 
In addition, the speed of the processor of a cellphone 
was also rated. We divided our test zones into two 
parts for the signal integrity and clarity test. Zone 1 
was inside our office and represents a typical urban 
usage scenario where signal strength is good but not 
at its best. Zone 2 is the killer; it’s located inside our 
basement and where most service providers’ signals 
gets murdered.

  How We Tested

LG’s RD 3600
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Samsung L700
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W350 is a nice looking phone 
with a black/orange colour tone 
like so many of the other SE 
walkman phones. It has a well 
spaced keypad and has the same 
chic keypad flap as on the LG. 
The outer flap also has the mul-
timedia buttons integrated. Once 
again, like the KM380T, these 
buttons coincide with the joy-
pad, which we find quite inno-
vative. The phone itself is built 
quite well and is reasonably slim; 
it also has a solid in-hand feel. 
The volume and multimedia 
buttons that characterise Sony 
Walkman series are well done 
and very usable. The keypad on 
the W380 is quite good – the keys 
are well spaced out, reasonably 
bevelled and impart decent feed-
back. SMS junkies will like this 
keypad. Even the backlighting, 
although dim, is very functional. 
Sony Ericsson’s Z555 was the sole 
clamshell phone amongst the 
candy-bar form factor. This phone 
is built very well and feels solid 
but doesn’t have the same style 
that the Sony Ericsson W380, 
which we tested back in August 
last year. The screen is also small-
er than the W380, and not as 
crisp as we’d like for a phone 
in this price category. It has a 
decent keypad but the W350’s 
keypad is much better and has 
better backlighting.

LGs KP 199 and KP 220 are 
the cheapest phones in this cat-
egory and despite the fact that 
the KP 199 is cheaper; we liked 
its fit and finish more than the 
KP 220. It’s cute looking with a 
nice rounded front bezel that is 
done with chrome rims which go 
well with the black colour of the 
phone. The back of the phone is 
finished rather cheaply and is 
the only facet that betrays its 
lower price. LG really scores with 
the KP 199’s keypad – it’s very 
well spaced and feedback is really 
good. This phone seems to have 
been built with the SMS junkie 
in mind, and even the menu but-
tons and joypad are well laid out. 
The KP 220 itself is quite a bit 
larger and for such a big phone 
we found the screen to be dispro-
portionately small. The keypad 

  
Cell Phones

Cell Phone above Rs 4000

Brand
Model

LG
RD 3500

LG
RD 3510

LG
RD 3600

                     LG
               RD 3610

Nokia
2626

LG
RD 6100

Samsung
E1410

LG
KP199

Price 1099 1099 1450 1749 2229 2699 3200 4399
Plus Compact, Solid build Compact, Solid Build Solidly built, good keypad Decent colour combo Well Built solid feel Well built, great keypad Neat looks Compact, well priced
Minus No middle joypad button Diaphragm-type keypad Menu button slightly tacky Build quality No camera Weak camera No camera Small, mediocre sceen
Grand Totals (Out of 100) 24.99 24.44 34.16 32.88 35.05 36.13 44.81 50.33
Features (Out of 75) 17.76 17.10 25.76 24.81 27.04 27.60 35.89 40.44
Performance (Out of 25) 7.23 7.34 8.40 8.08 8.01 8.53 8.92 9.89
Features
Physical Specs
Form Factor Bar Bar Bar Bar Bar Bar Bar Candybar
Network Bands CDMA (Reliance) CDMA (Reliance) CDMA (Reliance) CDMA (Reliance) GSM 900 / 1800 CDMA (Reliance) GSM 900 / 1800 GSM 900 / 1800 / 1900
Screen Resolution (Pixels) / Size (inches) 128 x 128 pixels / 1.5 inches 128 x 128 pixels / 1.5 inches 128 x 128 pixels  / 1.5 inches 128 x 128 pixels / 1.5 inches 128 x 128 pixels / 1.5 inches 128 x 128 pixels / 1.5 inches 128 x 128 pixels / 1.63 inches 128 x 160 pixels / 1.77 

inches
Maximum Number of Colours displayed onscreen 65K 65K 65K 65K 65K 65K 65K 256K
Touchscreen / Dual Screen (Y/N) 6 / 6 6 / 6 6 / 6 6 / 6 6 / 6 6 / 6 6 / 6 6 / 6
Dimensions (LxWxH) 101 x 46 x 13.9 mm 101 x 46 x 13.9 mm 101 x 46 x 14.3 mm  101 x 46 x 14.3 mm 104 x 43 x 18 mm 104 x 46 x 13.9 mm 108 x 46 x 15.3 mm 105.5 x 47.5 x 16.5 mm
Weight 80 grams 80 grams 80 grams 80 grams 91 grams 80 grams 79 grams 95 grams
Internal Memory 32 MB 32 MB 32 MB 32 MB 2 MB 64 MB 4 MB 60 MB
Expandable Memory Type / Hot Swappable (Y/N) NA NA NA NA NA NA microSD microSD
Available Colours (If options) 6 6 6 6 Fiery Red, Spatial Blue, 

Energetic Copper, WhiteNavy
6 6 6

Other Features
Charging via USB (Y/N) 4 4 4 4 6 4 6 4

Address Book Capacity / No of calls in Register 500 / (60 calls total) 500 / (60 calls total) 500 / (60 calls total) 500 / (60 calls total) 300 / 20 dialled, missed, 
received

500 / (60 calls total) 1000 / (30 dialled, missed, 
received)

1000 / 10 (dialled, 
received, missed)

Talk Time / Standby Time * 3 hrs 20 min / 200 hrs 3 hrs 20 min / 200 hrs 3 hrs 30 min / 200 hrs 3.3 hrs / 200 hrs 3 hrs / 300 hrs 3 hrs 30 min / 200 hrs 11.5 hrs / 546 hrs 10 hrs / 880 hrs
No of Profiles # /Customisable 4 / 4 4 /4 4 / 4 4 / 4 7 / 4 4 / 4 4 / 4 4 / 4
Offline Opearability (Y/N) 4 4 4 4 4 4 4 4

Connectivity
Browsing (GPRS/HSCSD/EDGE/3G) 6 / 6 / 6 / 6 6 / 6 / 6 / 6 6 / 6 / 6 / 6 6 / 6 / 6 / 6 4 / 6 / 6 / 6 6 / 6 / 6 / 6 Y / 6 / 6 / 6 4 / 6 / 6 / 6
Connectivity (WiFi/Bluetooth/IR/USB) 6 / 6 / 6 / 4 6 / 6 / 6 / 4 6 / 6 / 6 / 4 6 / 6 / 6 / 4 6 / 6 / 6 / 4 6 / 6 / 6 / 4 6 / 4 / 6 / 4 6 / 4 / 6 / 4
Bluetooth Version/A2DP support 6 / NA 6 / NA 6 / NA 6 / NA 6 / NA NA 2.0 / 6 1.2 / 4
Accessories
Bundled Accessories Charger (data cable and 

headset optional)
Charger (data cable & head-
set optional)

Charger, headset Charger, headset Headset, charger Charger Charger, data cable, headset Charger, data cable, 
headset

Size of memory card provided NA NA NA NA NA NA NA NA
Overall Build Quality (So 10) 6 6 6.25 5 6.75 6.25 6 6.5
Overall Ergonomics (So 10) 5.25 4 6 5.25 4 6.5 4.5 5.75
Camera Specs
Camera Resolution (Megapixels) NA NA NA NA NA .3 NA 0.3
Video Capture Resolution NA NA NA NA NA NA NA NA
Dual Cameras / Auto Focus / Flash (Y/N) NA NA NA NA NA 6 / 6 /6 NA 6 / 6 / 6
Camera Settings (So 10) NA NA NA NA NA 2.5 NA 2.5
Multimedia
Music Formats supported NA NA NA NA NA NA MP3, WMA .MP3, eAAC+, WMA, WAV
Video formats supported NA NA NA NA NA NA NA .MPEG4, 3gp
FM Radio (Y/N) 6 6 4 4 4 4 4 4

Performance
Signal Reception and Voice Clarity (So 10)
Zone 1 / Zone 2 5.25 / 4.25 5.25 / 4.5 5.5 / 4.75 5.5 / 4.5 6 / 4.75 5.5 / 5 6.25 / 5.75 6.5 / 5
Handsfree Clarity 4 4 6 5.5 5 5.5 5.5 5
Captured Photo Quality (So 10)
Captured Photo Colour / Crispness NA NA NA NA NA 1.5 0 1.5
Captured Video Quality NA NA NA NA NA NA 0 0
Audio Quality / Bundled Earphones Quality (So 
10)

NA NA NA NA NA NA 0 3

Video Playback Quality (So 10) NA NA NA NA NA NA 0 0
Processing Speed (So 10) 5.5 5.5 5.5 5.5 5 5.5 5.5 5.5

F E B R u a r y  2 0 0 9
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Cell Phones

Brand
Model

LG
KP220

Samsung
M200

LG
RD 6600

                Samsung
               SCH F309

Sony Ericsson
Z555

Sony Ericsson
W350

LG
KM380T

Samsung
L700

Price 4550 4900 4990 6300 6395 7495 7499 7800
Plus Solidly built Large keys, well built Attractive chrome look Decent build quality Good finish, looks neat Looks funky, nice keypad Funky looks, lightweight Supremely built, spaced keys
Minus Small screen Slightly long Keypad not very good Mediocre screen Small screen None in particular Flap build quality iffy Quite large, heavy
Grand Totals (Out of 100) 52.52 54.64 50.09 44.26 51.83 54.36 55.51 58.17
Features (Out of 75) 40.73 42.17 38.76 32.33 38.93 40.28 43.43 43.31
Performance (Out of 25) 11.79 12.47 11.33 11.94 12.90 14.09 12.09 14.86
Features
Physical Specs
Form Factor Candybar Bar Bar Bar Clamshell Flap Flap Bar
Network Bands GSM 900 / 1800 / 1900 GSM 850 / 900 / 1800 / 

1900
CDMA (Reliance) CDMA GSM 900 / 1800 / 1900 GSM 900 / 1800 / 1900 GSM 900 / 1800 / 1900 GSM 850 / 900 / 1800 / 1900 

/ UMTS 2100
Screen Resolution (Pixels) / Size (inches) 120 x 160 pixels / 1.77 inches 128 x 160 pixels / 1.9 inches 176 x 220 / 2.0 inches 176 x 220 pixels / 1.9 inches 176 x 220 pixels / 1.9 inches 176 x 220 pixels / 1.9 inches 240 x 320 pixels / 2.0 inches 176 x 220 pixels / 2.1 inches
Maximum Number of Colours displayed onscreen 256K 65K 256K 65K 256K 256K 256K 256K
Touchscreen / Dual Screen (Y/N) 6 / 6 6 / 6 6 / 6 6 / 6 6 / 6 6 / 6 6 / 6 6 /6
Dimensions (LxWxH) 103 x 46 x 12 mm 107.6 x 45.6 x 12.9 mm 103 x 45 x 13 mm 113 x 46 x 10.9 mm 95 x 49 x 16.5 mm 104 x 43 x 10.5 mm 108 x 48 x 13 mm 109 x 46 x 12.8 mm
Weight 72 grams 85 grams 76 grams 80 grams 95 grams 80 grams 79 grams 107 grams
Internal Memory 60 MB 20 MB 32 MB 20 MB 12 MB 14 MB 40 MB 40 MB
Expandable Memory Type / Hot Swappable (Y/N) microSD microSD microSD microSD M2 M2 microSD microSD
Available Colours (If options) 6 6 6 6 6 Electric black, Ice blue, 

Hypnotic black, Graphic 
white, Wisteria Purple, 
Turbo Red

6 Titan Silver, Grayish Brown, 
Chargoal Gray, Noir Black, 
Rose Pink, Lilac Violet

Other Features
Charging via USB (Y/N) 4 6 4 6 4 4 4 6

Address Book Capacity / No of calls in Register 1000 / 10 (dialled, received, 
missed)

1000 / (30 dialled, missed, 
received)

1000 / (120 calls total) 1000 / 50 (missed, dialled, received) 1000 / 20 (dialled, received, 
missed)

1000 / 20 (dialled, received, 
missed)

1000 / 40 (dialled, received, 
missed)

1000 / (30 dialled, missed, 
received)

Talk Time / Standby Time * 3 hrs / 300 hrs 3 hrs / 300 hrs 3 hrs / 150 hrs 2.3 hrs / 200 hrs 8 hrs 20 min / 360 hrs 7 hrs / 300 hrs 3 hrs / 250 hrs 3 hrs 30 min / 280 hrs
No of Profiles # /Customisable 4 / 4 4 / 4 4 / 4 4 / 4 7 / 4 7 / 4 4 / 4 4 / 4
Offline Opearability (Y/N) 4 4 4 4 N N Y 6

Connectivity
Browsing (GPRS/HSCSD/EDGE/3G) 4 / 6 / 6 / 6 4 / 4 / 6 / 6 6 / 6 / 6 / 6 6 / 6 / 6 / 6 4 / 6 / 4 / 6 4 / 4 / 4 / 6 Y / N / N / 6 4 / 6 / 4 / 4
Connectivity (WiFi/Bluetooth/IR/USB) 6 / 4 / 6 / 4 6 / 4 / 6 / 4 6 / 4 / 6 / 4 6 / 4 / 6 / 4 6 / 4 / 6 / 4 6 / 4 / 6 / 4 6 /4 / 6 / 4
Bluetooth Version/A2DP support 1.2 / 6 2.0 / 4 2.0 / 6 2.0 / 4 2.0 / 4 2.0 / 4 2.0 / 4 2.0 / 4
Accessories
Bundled Accessories Charger, data cable, headset Charger, data cable, headset Charger, Headset Charger, data cable, headset Charger, data cable, headset Charger, data cable, headset Charger, data cable, headset Charger, data cable, headset
Size of memory card provided NA 6 512 MB 512 MB 512 MB 1 GB 512 MB
Overall Build Quality (So 10) 6.5 7 6 7 6 6.5 7.5
Overall Ergonomics (So 10) 6 5.75 5.75 4 6 6.5 5 7
Camera Specs
Camera Resolution (Megapixels) 1.3 1.3 1.3 1.3 1.3 1.3 1.3 2
Video Capture Resolution 176 x 144 176 x 144 176 x 144 176 x 144 176 x 144 176 x 144 176 x 144 176 x 144
Dual Cameras / Auto Focus / Flash (Y/N) 6 / 6 / 6 6 / 6 / 6 6 / 6 / 6 6 / 6 / 6 6 / 6 / 6 6 / 6 / 6 6 / 6 / 4 6 / 6 / 4
Camera Settings (So 10) 3.5 3 3.25 3.25 5 5.25 6.5 5.25
Multimedia
Music Formats supported .MP3, eAAC+, WMA, WAV MP3, AAC, eACC+, WMA .MP3, eAAC+, WMA, WAV MP3, AAC, eACC+, WMA .MP3, eAAC+, WMA, WAV MP3, AAC, eACC+, WMA .MP3, eAAC+, WMA, WAV MP3, AAC, eACC+, WMA
Video formats supported .MPEG4 MPEG4, 3gp MPEG4, 3gp MPEG4, 3gp .MPEG4, 3gp MPEG4, 3gp .MPEG4, 3gp MPEG4, 3gp
FM Radio (Y/N) 4 4 4 4 4 4 4 4

Performance
Signal Reception and Voice Clarity (So 10)
Zone 1 / Zone 2 6.25 / 5 6.25 / 6 5.75 / 5 5.75 / 4.75 6 / 5 6.5 / 5 6.75 / 5.5 6.75 / 5.75
Handsfree Clarity 5 6 6 5 5 6 5.25 6.5
Captured Photo Quality (So 10)
Captured Photo Colour / Crispness 3 4 2 4.5 4.5 4.5 2.5 5.5
Captured Video Quality 2.5 3 2.5 3 5 5 2.75 4
Audio Quality / Bundled Earphones Quality (So 
10)

4 4 3.5 5 5 5.5 4 5.5

Video Playback Quality (So 10) 4 3.5 2 4.25 3 4.5 3.25 5
Processing Speed (So 10) 5.5 4.5 6 5.5 7 7 5.5 7
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isn’t half bad though, 
ditto the menu but-
tons. It also feels very 
solid in-hand.

Samsung’s SCH 
F309 is a CDMA phone 
and a decently built 
one at that. The body 
feels solid but the key-
pad isn’t the best we’ve 
seen and for its price, 
we did expect more. 
LG’s RD 6600 sports a 
metallic mirror finish, 
and is the costliest of 
the CDMA phones in 
this comparison. It’s 
a nice looking phone 
and has a very decent 
screen. We also liked 
the number keypad 
which although a little 
cramped, works fine. 
The menu buttons are 
good, although we feel 
Sony Ericsson designed 
their menu buttons 
on the W350 better. 
Samsung’s M200 is a large, bulky 
looking phone and its inferior 
build quality aside could be mis-
taken for the L700. But that’s not 
meant in a derogatory sense at 
all, as the L700 is unusually well 
built. The keypad on the M200 is 
nearly the same in terms of lay-
out as compared to the L700 but 
its feedback is not as good.

Performance
In the signal quality tests we had 
a bit of a mixed bag. Firstly, the 
LG KM380T and Samsung L700 
were the clearest phones in Zone 
1. In Zone 2, which is a more 
difficult zone to perform 
well in — being deep inside 
our building and in an area 
that kills most service pro-
vider signals — the Samsung 
M200 did better than its cost-
lier sibling by a small mar-
gin. Hands-free quality on the 
L700 was still the best though; 
with the KM380T losing to 
a few other phones as well. 
The Sony Ericsson also has 
a good hands-free unit, but 
then Walkman phones are 
known for their good head-
sets. Samsung also has the 
most prolific camera amongst 

the lot; it’s got a better specifi-
cation (2 megapixels) and also 
performs the best. It’s surpris-
ing then that this phone doesn’t 
have the best video quality – the 
cheaper Sony Ericsson Z555 gets 
that distinction. Both the Sony 
Ericsson W350 and the Samsung 
L700 have the best music quality 
and these are the phones to look 
at if you want something that 
doubles as a decent MP3 player. 
The same two phones also give 
the best video playback perfor-
mance and it’s safe to call them 
the best overall multimedia 
phones of the bunch. Samsung’s 

L700 is the costliest phone of 
this bunch at Rs. 7,800 and 
is also the best performing 
phone overall, proving that 
money and performance do, 
indeed have a directly propor-
tionate relationship.

And The Winner Is
For our Digit Best Buy we have 
a tie in this category. The joint 
winners are the LG KP220 and 
the Samsung M200. The M200 
is a bit better than the KP 220 
in terms of overall features, 
comfort and performance but 
this margin is small. Moreover 

the M200 is also a lit-
tle costlier. Both these 
phones will do very 
nicely for someone look-
ing at a phone that has 
a camera and memory 
expansion, and for audio 
and video playback. If 
you want something a 
little more upmarket 
then look at either of 
the Samsung L700, LG 
KM380T and the Sony 
Ericsson W350. We pre-
fer the latter two because 
they are more attractive 
and have a fancy flap 
design; although the 
L700 is the better built 
phone. Amongst the 
CDMA phones, LG’s RD 
6600 is the best option 
and it’s much cheaper 
than the Samsung SCH 
F309. LG’s KP220 is also a 
good option for someone 
looking for a reasonably 
feature rich phone that 

is also superb value for money.

To sum it up
We did something a little dif-
ferent this time, and also took a 
look at CDMA handsets. Unlike 
GSM handsets, which one pur-
chases for the device alone, 
CDMA handsets are typically 
part of a service provider’s pack-
age. Therefore, the actual qual-
ity of service offered also plays 
a large part while picking up 
a CDMA device. For example, 
Reliance could offer a particular 
handset with only a select bunch 
of service plans thereby giving 
consumers the binary options of 
taking it, or leaving it. That being 
said it’s good to see some decent 
GSM handsets also available at 
shoestring budgets, although 
GSM handsets are still costlier 
than their CDMA counterparts, 
and will probably always be so. It 
was also refreshing to find some 
true jewels in the rough, as the 
phrase goes. We will be taking a 
more comprehensive look at the 
more drool-worthy handsets of 
2009. But that’s another story, 
for another month. n

michael.browne@thinkdigit.com

Joint Winners: 
LG KP220 and 
Samsung M200

F E B R u a r y  2 0 0 9
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DVD-sets, books,

full-version 
software, 

and even an
all expense

paid trip
 to our office,
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All your computing niggles and nags
are dealt with here!

Your Questions, Our Answers

An overheating power supply
Hi, this is Dhruv and I am a regular reader of
your magazine. My configuration is an Intel

Pentium 4 HT (3 GHz), a ASUS P5VDC MX, a
Samsung 80 GB HDD, a Sony DVD writer, an ATX
cabinet and a gigabyte of memory. My problem is
that whenever I play GTA : San Andreas, my SMPS
heats up and the game stops working. Please
suggest a solution. Is this system configuration
enough to run this game? Please help.

Dhruv Karnick

If the game runs and you can play reason-
ably well on it without any major slow-

downs, then the system should be good
enough to run GTA: San Andreas but we highly
recommend that you upgrade your system. An
overhaul that includes putting an Intel or AMD
dual core processor and a graphics card will do
wonders for you. If you are a major gamer, then
you would enjoy a system like that. If GTA : San
Andreas is the only game that you want to play,
then a graphic card upgrade will be just fine.

The problem of your power supply heating
up is likely to be a spoilt fan at the back of the
power supply. Check to see if its still running or
is clogged with dirt. Do not open the power
supply but get it fixed or replaced if it’s under
warranty.

Laptop shuts down randomly
I have an Acer laptop that’s around six years
old now. It keeps repeatedly shutting down

when I use it. There is always a fan noise when an
application starts some other times; it just shuts
down on its own. What could be the reason? Please
help me.

My laptop configuration is: Acer Travelmate
2501LC which uses an Intel Pentium 4 2.8 GHz, an
ATI Mobility Radeon 9000 IGP, 256 MB DDR333
SDRAM, 40 GB Ultra ATA/100 HDD and a DVD/CD-
RW Combo drive.

Vishwas Kamath
Your laptop is really old and it’s a good
idea to get it serviced sometime. The fan

you are talking about might be failing or it
might be clogged with dust. It needs to be
opened up and cleaned up. Also, get it looked
at by your laptop manufacturer if possible.

Conflicting information BIOS and
system monitoring software
I recently assembled a desktop PC with following
configuration.

Processor : Intel Core 2 Duo E8400 (3.00 GHz)
Mother board : DG33TL
HDD : 250 GB
RAM : 2 GB DDR2 800 MHz
I want your opinion. The BIOS of the system

say that system bus speed is 1333 MHz. The L2
cache is 6144 KB there is no mention of the L1
cache. The system monitoring software (Desktop
utility version 3.0) supplied with the motherboard
shows some other details.

System bus speed : 333 MHz
L1 cache : Data cache 32 KB, Code cache 32 KB

per processor core
L2 cache : Not

Supported
Why is the system moni-

toring software displaying
wrong information about
the system and how can I
solve it? After two to three
seconds of starting up the
computer, the system
switches on momentarily
then goes off again. After
that, it switches back on
normally. Is this normal?

Sanjay Sinha

The delay in startup of the
computer is normal on
some motherboards. Try
installing a different soft-

ware such as CPU-Z to identify details about
your processor. CPU-Z is free for download
from www.cpuid.com. Look for any updates for
the system monitoring utility that came with
your motherboard.

Two odd problems
Hi, I have two queries . Every time I start my
computer I get these errors.

1. Cannot find script file
“C:\WINDOWS\system32\boot.vbs”.

2. Windows cannot find ‘wproxp.exe’. Make sure
you typed the name correctly, and then try

CPU-Z is an easy way to
verify processor informa-
tion

VBS errors on startup are
a common sign of a worm
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This is my system configuration
Processor: Intel Pentium 2.66GHz
512 MB of RAM
Intel 82865G integrated graphics card
80 GB SATA hard drive
I am currently running Windows XP SP3

Rajshekhar Sirimala

Installing Vista over XP will not be a prob-
lem at all. Simply insert the Vista DVD on

system startup after you have set your DVD
drive as the bootable device. All you need is a
different partition. Just be sure to choose
which one carefully and do not format it if you
have any data on it. Once that’s done, Vista will
install and changes will be made to the boot
record so you can choose between the two
operating systems every time you boot.

System has slowed down
I am a regular reader of Digit. It is the one
and only one tech magazine which always

keeps me up to date. I have a problem with my
desktop computer.My PC Configuration is:

Intel P4 processor 2.4 GHz, Gigabyte 845
Motherboard, 256 MB DDR1 RAM and 1 GB DDR1
RAM. I also have a 40GB HDD and a 160GB (IDE)
OS Windows XP SP2

The problem is very critical. I was running my
PC very well with 256 MB RAM and 40 GB and 160
GB HDD. Last week, my system performance
dropped by a lot. Even a simple application takes
a lot of time to load.

1. I tried installing a new OS with different
different CDs - no results.

2. I upgraded my memory with 1 GB DDR1 with
some good results, but my CPU usage
reaches 100% even with small applications,
or while installing some software. Even if I
open a folder, the CPU utilization reaches to
90% for six to seven seconds.

3. I tried changing power supply - no results
4. I tried installing OS in another HDD - no

results
5. Both fans are working well, CPU as well as

the power supply.
6. The CPU temper-

ature is 44C
No vendor of my

city could solve the
problem.What do you
suggest?

Sandeep Goyal

One of the first
things to do is to

update the drivers for
your motherboard. If
you’ve just added the
1 GB of RAM, plug out
the older 256 MB and
look for any improve-
ment. The CPU
temperature is
perfectly fine. If you
have two drives
connected, try discon-

necting the one without the operating system
to look for any improvements. If that works,
then you know one of the drives might be
faulty. Also, enable DMA for the hard drives
from the Windows Device Manager.

Digit! Please help! Booting issue!
Hello Digit,

I bought a new rig after a week of
detailed research on the Internet and your maga-
zine. Here is the config I got.
Intel Core 2 Duo E7300 2.66 GHz
MSI P7NGM DIGITAL Motherboard
Palit Radeon HD 4870 SONIC 1GB Dual Edition
(with Dual BIOS)
Seagate Barracuda 7200.11 HDD 320 GB
Corsair 2 x 2 GB 800MHz RAM
Cooler Master eXtreme Power 600W PSU
Cooler Master CM 690 Cabinet
Dell E1909W 19-inch LCD
Liebert Emerson 600VA UPS

I installed Windows XP SP2 and Vista with SP1.
From the very first day, whenever I switch on my
PC, the motherboard logo flashes on screen and
then a strange three second beep can be heard
from the cabinet. Immediately after that, the
system hangs completely. I reinserted the RAM
but the problem persists. The strange thing is
when I restart my PC,it still gives me that strange
sound but it boots properly and I can login into
both XP and Vista and even can play Crysis at very
high resolution for 10 hours at a stretch without
any problems.

I would like to mention here that my huge
graphics card has physically covered almost all
the six SATA ports on my motherboard and the
HDD SATA port was connected with very much
difficulty. I even had to keep the entire cabinet in
a lying down position as in the upright position my
graphics card was literally throwing its whole
weight on the HDD SATA port below and giving me
display-related problems.

Is my graphics card clashing with my mother-
board somehow? Or otherwise, is my SMPS not
powerful enough? The box for the Graphics card
says it alone needs 500 W Power Supply.

Please help me as I’m going nearly crazy and
lost all my sleep and peace of mind.

Amitava Das
If the graphics card manufacturer states
that 500W is required for just the graphics

card alone, then the power supply is most
likely the problem. Make sure that you have all
the necessary power cables plugged in. If possi-
ble, borrow a powerful PSU from one of your
friends and try starting up your PC. If your
graphics card isn’t properly fitting into the PCI-
E slot, then unplug the SATA cables and see if
you have any beeps or errors during startup.

Buzzing sound
Hello, I get a buzzing noise when I move my
mouse pointer on the screen. The sound is an

odd static which comes from the speakers. I have
an Enter optical mouse. Please tell me what to do
to fix this problem. My rig configuration is an

Enabling DMA mode for
the hard drive channel
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again. To search for a file, click the start button,
and then click search.

What should be done? Please help me.
My PC Configuration is as follows:
Processor: Intel Core 2 Duo 2.00 GHz
RAM: 480 MB of RAM
OS: MS Windows XP Professional SP2

Kailash Subba

The script error you get is because of a
worm. The other error relating to

wproxp.exe is also because of a worm.
Download, install, update and scan your
system with an antivirus including any flash
drives you have for worms.

Problems with DVD Drive
The problem with my DVD drive is that it
cannot play dual layer DVDs. Either the

system cannot detect the disc at all in the drive (it
shows Used space : 0 Bytes, Free space : 0 Bytes
while checking ‘Properties’) or the system hangs
when I right click or double click on the DVD-RAM
Drive icon, unless I eject out the disc. It works fine
with other discs.

Recently after reinstalling windows XP, I found
that I cannot install a few of the software ( like
Tune Up Utilities, Alcohol 120% ) from the hard
drive or DVDs, though I had no problem at all
while installing them earlier.

A few games though get installed successfully,
cannot be played by clicking on the icon. It ends up
in a full black screen even if left for an hour or two,
unless the computer is restarted.

I use Avast Home Edition 4.8 and update it
regularly. Here is my system’s configuration

AMD 4000+ X64 Dual Core Processor
MSI ATI Radeon Graphics Accelerator based

Motherboard
1 GB DDR2 667MHz Ram (Transcend)
160 GB Western Digital SATA2 HDD
LG 18x DVD RW

Does this configuration lead to CPU bottle-
necks and can be improved by expanding the RAM
size? Please suggest me a way to get rid of these
problems.

Chayan

The problem with DVDs not reading could
be due to the drive detecting that make of

media. The fix for that could be flashing the
firmware. Go to the manufacturer’s site and
download the latest BIOS for the exact same
model of DVD drive you own.

The problem of not being able to install
software is bizarre. Make sure your Windows
account is not set up as a limited user. Try
creating a new user. If the installer for the soft-
ware is corrupted somehow, then that could
also be causing the problems.

Try updating drivers for your graphics solu-
tion on the motherboard to fix the problem of
games blanking out the screen when run. 1 GB
of memory is sufficient for Windows XP to run
but upgrading to a minimum of 2 GB is recom-
mended anyway. You will find improvement in
performance. A dedicated graphics card for
games is also recommended.

Using other programs instead of
default programs

I use Windows Vista as my operating system.
I use other programs instead of some of the

default programs that come with it like Notepad,
Paint, Internet Explorer, Calculator, Windows
Explorer, etc. I use Textpad, Paint.net, Firefox,
DreamCalc 3 Pro and Total Commander respec-
tively); I want to get rid of these default programs.

Is there a way?
Vikas Mahindra

You cannot unin-
stall all of the

mentioned software
from your Windows
Vista installation but
you can remove a few
of them. Software like
Windows Explorer
and Internet Explorer
are vital to the operat-
ing system in some
ways or for software
that you might install
in the future.

To uninstall the
few selected software,

click on Start > Control Panel > Programs and
Features. In the left panel, click on Turn
Windows features On or Off. Here you can
remove some of the software that come with
Vista.

I want to dual boot XP and Vista
I want to install Windows Vista over my exist-
ing installation of XP. Can I just install Vista in

another drive? Will it work properly? I have read
many books on it but I didn’t understand properly.
Please help.

Exceptions for uTorrent maybe required to
ensure open access for it

Torrents aren’t
working on the
laptop

Hi,I have this laptop in
which torrent down-

loads have been blocked.
Please guide me through the
procedures to unblock it.
Thanks!

Check your system fire-
wall by clicking on

Start > Settings > Control
Panel > Windows Firewall.
Go to Exceptions and check
your torrent download
client. If you have any other
firewall program, then
allow access through that
software in the same
manner.

Jagdeep Virdi
(TECH QNA Expert)

Question

of the

Month

Turning on and off of
some of Windows Vista’s
components is possible
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ASUS A8V-VM Motherboard, an
NVIDIA GeForce 7300GT 512 MB
dedicated VGA Card, an AMD
3500+ (Socket 939) CPU,
Frontech Super TV internal tuner
card, a LG- GH22N 22X DVD
Writer and Transcend 1 GB x 2
RAM (400 MHz) DDR1. I also
have a 250 GB Hitachi SATA HDD.

Regards,Zubin

The sound you are getting
is most likely being chan-

neled through your sound
card to your speakers. Double-
click on the Windows Volume
Control. Access the volume
controls for both the the line-
in and microphone in the play-
back and recording panels.
Mute all instances of them.

Orkut login on Windows
Hi! This is Bhupesh. Whenever I login to
Orkut, the username and password appears

automatically. I don’t want this to happen as my
computer is on a network. Please help me.

Bhupesh Rawat

If your computer is on a
network and only you

have access to your account
on Windows, then there is
nothing to be worried about.
If there are many other users
using your computer, then
you can clear out your exist-
ing passwords and usernames
by clearing out private infor-
mation in the browser. If you
use Internet Explorer, click on
Tools > Options. Click on the
Content tab and then on
Autocomplete. Click on the
Clear Passwords and Clear
Forms buttons. Similar
features can be found in
Opera and Firefox as well.

System booting problems
I have a SG 1138IL Compaq Presario desktop
with 256 MB of RAM and a 80 GB SATA hard

disk. While formatting, I saved all the Program
Files to drive D by mistake, though it was to be
saved in C Drive. After formatting, when I started
my system, it asked me to select Microsoft
Windows XP to boot up further as there were two
instances of Microsoft Windows XP. On selecting
any one of them, my system worked perfectly.

But after some days my system starts asking
for password though I hadn’t set any password to
my system. I tried the password for Administrator
but it didn’t accept it.

To fix this problem, I formatted my system
completely. After this, my system has now been
working fine but it still asks to select Microsoft
Windows XP during bootup.

Can you help me in fixing this problem.
Thanks & regards

Arun Kumar

Now assuming that you have only one
instance of Windows installed and just

two boot entries on startup, removing the addi-
tional entries is simple. In Windows, click on

Start >
C o n t r o l
Panel >
S y s t e m .
Click on the
A d v a n c e d
tab and
click on the
Settings for
Startup and
R e c o v e r y.
There is a
t i m e o u t
t i m e
d i s p l a ye d
which can
be changed
so that
W i n d o w s
cont inues
to load

within a second of the prompt being displayed.

How to upgrade
Hi, I’m Devesh. By the end of your collectors

edition, I have become the biggest fan of
DIGIT. I need to know few things.

My current PC configuration is
Intel Core 2 Duo E4600 2.4 GHz
Intel DG33 motherboard
2 GB DDR2 RAM
NVIDIA GeForce 8600GT 512 MB
320 GB HDD
I want to upgrade my PC to an Intel Core 2

Quad Q6600 and increase my memory to 4 GB and
hard drive space by 250 GB. The question is, since
the DG33 motherboard supports the quad-core
processor, can I simply just take out Core 2 Duo
and replace it by Quad Core Processor without
making any changes in the BIOS settings or any
other settings for that matter? And secondly,
would it be wise to use two different internal hard
disks at the same time (older 320GB and the new
250GB).

Will any such changes effect my current
programs installed in the PC? I have Vista
Ultimate and Windows XP Professional v2002 SP3.

Devesh

Installing the new Core 2 Quad Q6600
processor will not be a problem. You

won’t have to make any changes in the BIOS. If
you have any problems, reset the settings to
default and save the BIOS settings. Two drives
or even more are not a problem. Upgrading to
just an additional 250 GB of disk space might
not be the best way to go. Look for something
around 500 GB and above as prices are them
are at an all time low.

Recording volume
controls for line-in might
have to be enabled

Clearing of passwords
and form entries is possi-
ble on almost all
browsers today

The timeout for choosing operating
systems can be reduced to a small
amount
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Adobe Photoshop CS4

Adobe Photoshop CS4 presents a
spanking new interface with a
bunch of small, thoughtful

touches. For example, the titlebar has
been removed entirely, allowing more
space for the images to display. The
cursor now changes from black to white
depending on the background, which
ensures that it is visible at all times. The
usually empty space after the menu bar
is filled with tools. Esentially, not a
single inch of screen space has been put
to waste. The immediate effect is that
you have a much larger work area at
your disposal. There are also new
features for the power user, most
noticeably, a panel view for working
with multiple documents at once.
Another welcome addition is that of a
tabbed arrangement when multiple files
are open; where you can undock single
images.

Working with layers
Every time you wish to

make a change to an image,
it makes sense to make those
changes in a new layer. This
measure preserves the orig-
inal image, despite any
adjustments you make. Go to
Layer > Duplicate
Layer to duplicate the image
in a new layer. To make
image adjustments, use the
Layer > New Adjustment

Layer option. The submenu in this
option is the same as the submenu in
Image > Adjustments. Every time
you select an adjustment layer, you will
see the options available for image
adjustments. This means that you can
repeatedly tweak image adjustments in
multiple adjustment layers without
having to go back and forth between
image adjustments on a single layer.
Every image adjustment layer is essen-
tially a mask added to the image.

Using the Vibrancy adjustment
filter

The Image adjustments tools are the
backbone of photo-editing on Photoshop.
A new feature in CS4 is the vibrancy con-
trol. By default, the middle left pane
now has image adjustment tools shown
for easy access. Go to Image >
Adjustments > Vibrance. Vibrance

is noticeably different from saturation
control, but it’s a filter that works with
the saturation of the colours in the
image. What vibrance does is increase
the saturation of all the colours in the
photo, while cutting off the magnitude
of this increase for the colours that are
already saturated. This means that the
areas in the image with a lower satura-
tion get a bigger boost in saturation
than the areas in the image with a
higher saturation.

Using the Photo Filter
CS4 also has a new image adjust-

ment feature known as the Photo Filter.
Many features in Photoshop are named
after similar techniques and equipment
used by Photographers before the onset
of digital photography. Photo Filters is a
long overdue feature. Filters were add-
ons to lenses that enhanced a particular
colour (like green) or suppressed a par-
ticular part of the electromagnetic spec-
trum (like UV light). The Photo Filter
option in CS4 has a bunch of presets
which represent real-world filters avail-
able in the market for photographers.
The logic of using a filter is thus:
imagine a landscape with a lot of trees,
you can then use a green filter to better
reproduce the foliage, by enhancing the
green in the image. The Photo Filter
option in Photoshop lets you choose
your own colour. You can use the colour
picker to pick a colour from the image
and apply the filter. Go to Image >
Adjustments > Photo Filter.

Matching colours across
different images

Often, a set of images taken at a partic-
ular location or an event, look like they
have been taken at different times, as
they look different. This can occur due
to many reasons, like a large span of
time between pictures or using multiple

cameras at a time. To make
the colours consistant
across images, CS4 has a
match colour option. First,
open up all the images you
want to match the colour
in, you will need a min-
imum of two images. Next,
select a reference image,
which will be the image
you will use to source the
colours from. Every time
you match a colour in a
particular picture, you will

use the colours in your ref-
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you are currently working on. To start
working on a new snapshot, select the
snapshot in the History panel. You can
save as many snapshots as you want, but
they are not saved with the file so when
you close a file, the snapshots are lost.

Allocate more RAM to
Photoshop

If Photoshop is running sluggishly, or is
running short of resources, you can allo-
cate more memory to the program. By
default, Photoshop CS4 uses around 50-
60% of your available memory. Go to
Edit > Preferences >
Performance > Memory Usage and
move the slider to let Photoshop use
more resources from your computer.
Note that this step is not the same as
giving Photoshop a higher priority in
the task manager.

Using Layer Comps
Layer Comps, or layer compositions

can be used to show different permuta-
tions and combinations from a single
PSD file. This can be useful when you
have to show a someone a different ver-
sion of what is essentially the same
project. Elements such as logos, names
and a few layers may be the same,
whereas others like the background or
text effects may be different. A layer
comp is a configuration of visible layers
that can be saved with the file itself. Go
to Window > Layer Comp. First select
the layers you want to display by
clicking on the visibility icon next to the
layer. Once a number of layers are
selected, go to the Layer Comp panel
menu, and select New Layer Comp. To
make another Layer Comp, select a dif-
ferent set of visible layers, and select
New Layer Comp. You can select and edit
a Layer Comp. Layer Comps are stored
with the file and can be mailed to
clients.

The new blend modes in CS4
CS4 introduces some new blend

modes. You need at least two layers in an
image to use the blend modes. Go to
Layer > Duplicate layer to create
a new layer, or use another image to
create a layer. Then go to Layer >
Layer Style > Blending Options
> Blend Mode and select an option
from the drop down menu. The Darker
Color mode blends the two layers by dis-
playing the darker of two possible
colours. This layer will make no differ-

options to change parameters. The avail-
able options are Position, Opacity and
Effects. Position is the only parameter
that used in this particular animation,
although you can use others. For
example, you can change the opacity, so
that the ball becomes invisible when it
bounces, and so on. For now, input the
number of frames to add as five. Now
repeat the procedure for the consecutive
original frames. Select all the frames,
and click on Play to preview the anima-
tion.

Export individual layers as
files

Photoshop lets you export individual
layers of the file you are currently
working on, into separate files. The files
generated are saved in the same folder,
and automatically named. You can
choose naming, compression and file
type options. File > Scripts >
Export Layers to Files. Tweak the
options here as per your preference.
Check Visible layers if you want to
export just the visible layers. Then click
on Run.

Working with snapshots
Snapshots save the current state of

your image. They are very useful for
reverting to a previous state, and are
more reliable than the undo tool. You
can save multiple snapshots for com-
paring two different approaches to a
photo-editing problem. To create a snap-
shot, first display the History panel. Go
to Window > History. In the History
panel menu, select New Snapshot. Enter
a name for the snapshot. You can now
choose to store the entire image (which
is the norm), a version of the image with
all the layers flattened, or just the layer

erence picture. Remember the file name.
Go to Image > Adjustments >
Match Color. Under Image Statistics,
under “source” select the file name of
your reference image. Your image should
immediately change the colour set. The
image options that you see at this point
of time, are absolutes and have nothing
to do with the reference image. Before
you do this make sure that the files you
are working on are set to the same
colour space. This means that the check-
marks in Image > Mode should be
consistent (this is also shown next to the
filename in the tab for the file).

Protecting the tone of the
image while dodging and

burning.
Until the release of CS3, dodging and
burning an image always looked unnat-
ural because of the way the image
grayed or darkened upon application.

The new burning and
dodging tools have an
option known as
“Protect Tones” which
better preserve the
colour information of
the image. The picture
on the left shows
dodging without the
Protect Tones feature,
while the one on the
right shows dodging
with the Protect Tones
feature turned on. The
difference is notice-
able, but there is no
standard approach for
using this feature as
the usage is dependent
on the kind of image
and the desired
output.

Increase or re-
allocate the

scratch-disk space
Photoshop uses its own virtual memory
when it runs short of the system’s vitual
memory and the RAM. Usually, the
scratch-disk space is used from the same
drive that Photoshop is installed on. As
this is usually the C: drive, where the
Windows virtual memory is also housed,
this location is not ideal. Go to Edit >
Preferences > Scratch Disks to
change this location. The window just
lists the drives available, and the
amount of free space on each. Just make
sure you check the drives that have a lot
of free space on them.

Enable Open GL
Photoshop CS4 can now use Open

GL for smoother operations and some
file effects. This has been included
specifically for their support for 3D files,
but it also helps in the overall user inter-
face experience. To enable Open GL, go

to Edit > Preferences >
Performance and check Enable Open
GL.

Further tweaks to optimise the
memory usage

The undo history of CS4 takes up a lot of
space. Go to Edit > Preferences >
Performance, and reduce the steps of
undo operations to keep in memory. The
cache levels can be increased upto 8, or
decreased as per individual preferences.
After a series of complicated operations
are finished, you can clear the memory
used by Photoshop by going to Edit >
Purge and selecting an option. The
options available are Undo, Clipboard,
Histories and All.

Create a Panorama
If you have a set of pictures you

would like to be merged into a
Panorama, doing so is an easy process on
CS4. The merging is visibly better than
CS3. Wires, foliage and seascapes are
handled better. Go to File >
Automate > Photomerge, choose the
auto perspective, add the images from
your system in order. To do this, click on
the Browse button, and select the files
that you want to be merged into a
panorama. If you have already opened
the files in photoshop (for editing), then
simply click on Add Open Files. Click on
OK and sit back and watch Photoshop do
its magic. This will take some time, and
you will see windows open and close
repeatedly, but do not worry.

Simple animation using
Photoshop

You can use Photoshop to animate
objects and layers in a picture, and then
export it as a GIF. This was possible in
previous versions of Photoshop as well,
but CS4 provides users with tweening
options and further controls. To create a
simple animation, of say, a ball
bouncing, create a white background
with a circle shape to represent a ball.
Then, go to Window > Animation >
Frame View. Select the first frame, and
click on the Duplicate Frame button
(right before the trash can). Duplicate
the frame five times, for different key
positions of the ball. Select individual
frames, and drag the shape to the rele-
vant position to do this.

Now select two consecutive frames,
go to the animation window and select
tween. You will see a window with
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Animation using Photoshop

Performance options in Photoshop

Matching colours to another image

The old dodge tool (left) and the new dodge tool (right), that preserves tones
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Amarok MP3 Player
Amarok is the MP3 player of choice for
most Linux users. It is simple to install
and to configure, and is packed with fea-
tures. Amarok is available for download
from http://amarok.kde.org. The MP3
player will work on GNOME or any other
desktop environment as long as the rele-
vant libraries are installed. Just use the
package manager to install Amarok, and
you should be good to go. Note that
some of the features of Amarok are par-
ticularly buggy on a few distributions
such as Linux Mint and Ubuntu.

Getting started with Amarok
Amarok cannot start playing MP3

files the moment it is installed. The
main reason for this is that the codec is
propriety, and cannot be distributed for
free. Before installing the codec, you will
have to install an engine. Go to the
package manager, and choose both the
yauap and the xine engines for Amarok.
Once these are installed, install the mp3
codec from www.fluendo.com. This is an
online shop that “sells” MP3 codecs for
no money. Finally, build your MP3 collec-
tion by pressing the Build button that
appears when you start up Amarok.
Choose the folder with your MP3 files, or
choose multiple folders and click OK.
Your music has now been imported into
Amarok, and you are good to go.

Play music from last.fm
For this procedure to work, you

will need an account with last.fm, so
make sure you have one. To play music
from last.fm, go to Engage > Play
last.fm Stream > Custom sta-
tion. Here, you will have to enter the
name of the artist, a genre of music or a
particular band of your preference.
Last.fm will choose similar songs based
on what you input in this box. You will
then be prompted for your username
and password. Next, you will be
prompted to accept cookies. This is just
the way last.fm works, and the songs you
listen to will be metered and counted by
last.fm. This keeps tracks of your statis-
tics, as well as improves recommenda-
tions that last.fm throws your way. Right
click on the track you are streaming
from last.fm to love or ban the track,
directly on the server.

Turn on crossfading
To turn on crossfading, go to

Settings > Configure Amarok >

Playback > Transition and select
crossfading. Set a crossfade duration as
per your preference. You can also choose
to implement the crossfade on only auto-
matic track changes or on only manual
track changes.

Add album art to collection
You can automatically add album

art to your entire collection. If your
folders have an album art, they will be
detected and shown. If there are missing
album covers, Amarok can retrieve them
from the Internet. This step requires a
working Internet connection. Go to
Tools > Cover Manager. This
should show you all the artists in your
collection with the relevant covers.
Blank cases are shown for artists without
covers. Click on Fetch missing
covers to update the covers for these
artists and albums. This will take a long
time depending on how many covers
need to be updated and the speed of
your connection.

Find out the name of your song
If you have an album full of songs

without IDv3 information, or just a few
odd songs that have neither tagged
information nor file name, you can still
find out what the song is in Amarok.
Right-click on one such track, and select
Edit Track Infromation. Under the

Tags tab, select Fill-In Tags Using
MusicBrainz. The program automati-
cally searches for similar songs, and gen-
erates the content for the tags. Note that
this is not hundred per cent foolproof.

Look up the lyrics and artist
information

While playing a song, look to the con-
text menu, and then go to the Lyrics tab.
This should throw up a choice of two
scripts for getting lyrics: Astraweb and
Lyrc. Choose one of the two scripts
which should fetch you the lyrics of the
song you are listening. This will be dis-
played in the window. The Artist tab in
the context menu brings up artist infor-
mation from Wikipedia.

Play Shoutcast radio on
Amarok

Go to Playlist > Radio Streams
> Shoutcast streams, to find a long
list of Internet radio stations. Choose a
genre, then select a particular station,
after which you can choose a sub-station.
Double-click, and the music should start
streaming.

Work with playlist
To load an artist or an album as a

playlist, right-click on the name of the
album/artist and click on Load. You can
also select a few songs and click on Load.
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ence to the image if both the layers are
the same unaltered image. The Lighter
Color blending mode does the exact
opposite, by displaying the lighter of two
possible colours. This mode will show no
difference if both the layers are the
same. The Hard Mix option is an inter-
esting new feature. The blending adds
the color components on the channels,
giving a display colour of 255 if the
colours add up to more than 255, and 0
if they don’t.

Content Aware Scaling
One of the best features of CS4 is

content aware scaling. This is great for
converting regular wallpapers to
widescreen wallpapers. This feature pre-
serves the important aspects of images
while resizing them. This means that
while stretching images, important ele-
ments like buildings or people don’t get
distorted. In this example, a picture with
a width of 1850 pixels was stretched to a
3000 pixel width. The picture on the left
was scaled in CS3, whereas the picture
on the right was scaled in CS4 using con-

tent aware scaling. Go to Edit >
Content Aware Scaling to choose
this option. Normally, Photoshop does a
good job of preserving the content when
you rescale an image. First, select the
area of the image you want preserved
using the select tool.
Then go to Channels
(the tab next to layers)
and click on save
Selection as channel
(the white circle in the
grey square). Now go to
Edit > Content
Aware Scaling, and
use the Protect drop
down box to select the
channel you just cre-
ated. This is usually
Alpha 1, but if you cre-
ated more channels,
these will be named
Alpha 2, Alpha 3...

Export all Layer Comps to files
Instead of manually saving layer

compositions to files, you can use a

preset script to export all existing layer
compositions to files. For this procedure
to work, you need to have at least one
Layer Comp saved in the file. Go to File
> Scripts > Layer Comp to
Files. Select the output and compres-
sion settings. Then click Run. While you
cannot work on more than one Layer
Comp at once, you can select multiple
Layer Comps to be exported. This can be
done by selecting the Layer Comps
instead of displaying them. When
exporting, check the “selected Layer
Comps Only” option.

Working with 3D Objects
Photoshop can now work with 3D

objects, but just make sure that you have
plenty of RAM and plenty of Scratch
Disk space before attempting to do so. To
open a file, simply go to File > Open
and choose a 3D object. You can rotate
and resize such objects using the but-
tons just below the traditional toolbox.
You can paint directly on the 3D objects,
and the filters you apply will be applied
to the surface or “texture” of the 3D
objects.

Install missing features in CS4
Veteran users will come across a

few effects and plugins that are missing
in Photoshop CS4. These are extras that
were included in the goodies folder of
previous versions, but no included in the
latest version. The missing features
include commonly used features like
web photo gallery maker, the texture fill
and the PDF presentation maker. To fix
these missing features (and more), go to
http://tinyurl.com/cs4missing and select
the platform. You will need a farily pow-
erful internet connection though, as this
is a 40 MB download. The files have to be
placed in the plugins folder.

The new Hard Mix blending option

Looking for album art

Working with 3d objects on Photoshop

Stretching without content-aware scaling (left) and with content-aware scaling (right)
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To further add artists/albums to an
existing playlist, right-click on the
album/artist and click on Append to
Playlist. Go to Playlist >
Playlist. Right-click on Playlist, and
click on Create new Playlist to
create a new playlist. The next time you
right click on artists/albums or songs,
you should get an option to add those
tracks to this playlist, or subsequent
ones you might want to create.

Searching in a large database
If you have a large collection of

music, it can become daunting to search
through it for a particular song. For this
reason, the search bar in Amarok works
with smart tags. Searching for title:
summer will show any songs from artists
or albums with summer in the title.
Searching for “Summer Wine” will
work as a phrase search. You can search
by any field in the standard IDv3 format.

Use the tray icon to its fullest
capability

The tray icon for Amarok can be very
useful. You can do a number of things
with it. The icon itself indicates the
progress of track that’s playing. Hover
over the icon to get the song’s album art,
title, artist, location and length.
Hovering over the tray icon and using
the mouse scroll changes the volume.
Scroll up to increase volume, scroll down
to decrease volume. Holding [Shift]
and hovering over the tray icon and
using the scroll wheel goes back and
forth through the track; doing this with
[Ctrl], goes back and forth through a
playlist. You can drag and drop files into
the tray icon to play or to queue them.

Burn CDs with Amarok
Once a playlist is loaded, all you

have to do is go to Playlist > Burn
CD. For this feature to work, you will
need k3b installed, which comes by
default if you are using KDE. If not, use
the package manager to install k3b. The
window that pops up allows you to re-
order songs, as well as add and remove
tracks.

Install additional scripts
Since Amarok is open-source, there

are a lot of independent developers out
there who have written small plugins for
it. These are called scripts, and can be
installed from the Script Manager. Go to
Tools > Script Manager and click

on Get More Scripts. Note that you
need an Internet connection for this fea-
ture to work. Wait for a few seconds as
Amarok updates its script database. Now
every time you select a script, a small
description appears alongside. Read
carefuly and pick and choose scripts to
your liking; beware as some might be
buggy, or not work properly on all dis-
tros. Also check the versions of the
scripts: installing a stable version is
better than installing an alpha release.

For the keyboard warrior
Use [Windows] + [X] to play,

[Windows] + [C] to Play/Pause,
[Windows] + [V] to stop.
[Windows] +[-] reduces the volume,
while [Windows] + [=] increases the
volume. [Windows] + [Z] plays the
previous track, and [Windows] + [B]
plays the next track. [Windows] +
[Shift] + [=] seeks forward into a
track and [Windows] + [Shift] +
[-] seeks backwards. Use [Windows]
+ [M] to mute, and [Windows] + [A]
to add tracks to the player. You can go to
Settings>Configure Shortcuts to
customise these shortcuts and more.

Personalise the interface
You can make Amarok look the

way you want to, by removing tabs and
features you don't use, or by adding
those not available by default. Go to
Settings > Configure Toolbars.
By default only the Play, Pause, Forward,

Backward and Stop commands are acti-
vated. Use a seperator to organise the
toolbar. You can, for example, remove
the Forward and Backward icons, and
add the last.fm icon. At any point of
time, click on Restore Default to return
Amarok to its original state.

Change how Amarok looks
Go to Settings > Configure

Amarok > Appearance. Then change
the fonts that Amarok uses, change the
foreground and background colours,
and the colour for a new playlist item.
There are two browser styles available by
default. Click on Download Styles,
select one of the highest rated or hottest
styles, and save them to your system
folder. Then click on install style
to add the style. The style will now show
up in the Select a style drop down
menu. Pick it, and if you don't like it,
repeat the process until you find some-
thing that suits your taste.

Transfer files to your PMP
Go to Settings > Configure

Amarok > Media Devices. Click on
Autodetect Devices. Now plug in
your PMP, and Amarok should normally
detect it. You can transfer songs back
and forth. If Amarok does not detect
your device, click on Add Device and
manually add the device. This procedure
will not work for the iPod, but there are
slightly more complicated workarounds
for this player as well.

stalling scripts
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NVIDIA has just stepped
up its game by releasing

the GTX285. This is the
pumped up version to the
great GTX280 that was
released last year. Zotac now
brings to us an even more
pumped up GTX285 AMP! edi-
tion. The card looks the same
as the GTX280 one of the dif-
ferences we noticed is the
power connectors.
This one

requires only two 6-pin PCIe
connectors as compared to its
predecessor (one 8 pin and
one 6 pin). The cover on the
back was also removed. The
AMP! edition comes with
clocks of 702 / 1512 / 2592
MHz (core / shader / memory)
as compared to the standard

edition of 648 /
1476 / 2484

MHz. The
GTX280

in com-
pari-
son

comes
at clocks of

602 / 1296 / 2214 MHz
(core / shader / memory).

The GTX285 still comes with
240 stream processors, but
the major difference is the
move from 65nm to 55nm.

We benchmarked this card
in DX10 using a QX9650
with 4 GB DDR3 RAM. 3D
Mark Vantage gave a score of
15,206 with a GPU score of
12,533. At a resolution of
1920x1200 in Company of
Heroes with AA enabled, we
got 202.9 fps. With Doom 3
we got 246.9 fps with 4x AA
at 1600x1200. Crysis gave us
interesting scores — in DX9,
the result we got were 46 at
1600x1200 and 40 at
1920x1200 while in DX10 we
got fps of 25 and 22 respec-
tively. Unreal Tournament 3 at
4x AA and 4x AF gave us a
score of 141 fps at
1920x1200. The last bench-
mark we ran was the slight-
ly older F.E.A.R. with 4x AA
and 4x AF. The card aver-
aged 167 fps at 1600x1200
and 127 fps at 1920x1200.

The GTX285 has definite-
ly some good results with
benchmarks, but it’s not all
that far from the GTX280.

This is a high-end card and
definitely is one of the
world’s fastest single GPU
cards so the price is also
quite exorbitant, but at the
same time knowing its capa-
bilities you can’t say it’s
unaffordable either.

Specifications:
NVIDIA GeForce GTX 285 @
702 MHz engine clock, 240
Processor Cores @ 1512 MHz,
1 GBB GDDR3, 2592 MHz
memory clock

Contact: ZOTAC International
(MCO) Ltd.
Phone: 011-46665666
Email: sales@zotac.com
Web site: www.zotac.com
Price: Rs. 28,999

We test the latest hardware
and software products
available in the marketBazaarBazaar

Zotac GeForce GTX285 AMP! edition
The mammoth has arrived

BenQ’s E900HD is an all
new ultrawide LCD

screen that sports a 16:9
aspect ratio and operates at
a resolution of 1366x768.
This kind of resolution is
perfect for watching movies

and that’s what most LCD
and Plasma TVs use.

This BenQ product defi-
nitely grabs everyone’s
attention. It has a mix of a
glossy black and grey finish
to it. It’s got the right design

for an everyday-use
desktop PC screen.
All the buttons have
the right feel to
them. The stand
also shares the
same glossy finish
as the bezel, and
keeps the screen
leveled and stable.

Like some other
brands, the controls
are moved to the
side, and using the
interface is extreme-
ly simple — you can

get used to the interface in
minutes.

Setting up the screen is
simple, and the screen does
well to display details. The
only big difference while
using the screen for desktop
applications is the reduced
workspace in terms of
height. Other than that, the
screen does well — the
colours are good, but the
presets supplied with the
screen are too gaudy and
over-emphasised.

The screen also features
inbuilt speakers, but they are
pretty weak — even after con-
cessions for being inbuilt.
The speakers are clear, but
just not powerful enough for
everyday use, and definitely
not so for movies or games.

Although 22-inch and
above screens would be con-
sidered by many as ideal for

movie watching on the
desktop, this 19-inch still
does a fair job at it. At
Rs 7,900, it’s a pretty good
deal, especially for its sleek
design — which you’d
expect to pay more for.

Specifications
19-inch screen, Resolution:
1366x768 pixels, Response time:
5ms, Dimensions:
18.03x14.17x7.03 inches

Contact: Benq India
Phone: 0124-4501400
E-mail: sales.enquiryin@benq.com
Web site: www.benq.co.in
Price: Rs. 7,900

BenQ E900HD
Best suited for movie buffs

Features
Performance
Build quality
Value for Money
Overall

RATINGS

Features
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Build quality
Value for Money
Overall

RATINGS
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The MSI PR201 notebook
falls in the Professional

series of the MSI group. The
PR201 is black, like other
business notebooks, but has
nice silver insides. This gives a
really neat and simplistic feel
to it, and you won’t even find
stickers of any kind on it.

There is a Kensington
security slot, VGA port,
USB, LAN port, and an opti-
cal drive on the left side.
The right side of the laptop
has two USB ports, a
modem port, an HDMI port,
a PC card slot and a flash
card reader.

A few problems we had
with this laptop was that
firstly the touchpad has no
side scrolls or multi-touch
functions. Even though
this laptop may be going
for a plain and neat look,
things like that may be

beneficial at times. This
MSI also lacks a FireWrie
port. We ran a series of
benchmarks to see the per-
formance of this laptop.

PC Mark 05: CPU Score -
5800, Memory Score
- 4885, Graphics
Score - 2453, HDD -
4461, Overall - 4795.
3D Mark 05: CPU
Score - 7951,
Overall - 1383.
Maxxon
CineBench R10
(CPU Score) -
4694. FarCry
(fps)
(640x480,
low
detail)

- 51.41. The screen quality is
just about decent and if it
were a rating on 10 we

would give it a 6.5, whereas
the audio would score a 7.

There are two things
that stand out in this lap-
top. One is the battery life:
It lasted a whole 3 hours 27

mins on high performance
with full brightness. The
second being it’s weight:
1.8 kg. The laptop is defi-
nitely business oriented
and has great processing
power. But then it also
lacks some features like a
better touchpad and a bet-
ter optical drive also.

Specifications
Intel Core 2 Duo P8400 @ 2.26
GHz, Display: 12-inch WXGA
(1280x800), SD, MMC, MS, MS
PRO Card reader

Contact: MSI
Phone: 011-41758808
E-mail: marketing@msi-in.com
Web site: www.msi-in.com
Price: Rs. 62,000

MSI PR201
The Plain Jane laptop

With brands lowering
prices and a lot of

choice available,
Samsung’s T220 moves
away from the norm of
plain thin bezel screens.

The T220 is identical to
its 19-inch sibling – the

T190 which came to us a
few months back. In terms
of design, things aren’t any
different. The Bordeaux
treatment is still there.
There bezel around the
screen is semi-transparent
with a hint of color thrown

in. The power button is
using a touch-sensitive but-
ton. The menu controls are
on the side.

The build quality of the
screen itself is great but
the stand isn’t so. The
stand only allows you to
move the screen back and
forth quite a bit.

The display quality is
somewhat similar to what
the T190 has. Calibrating the
screen using Displaymate
was a little tricky with the
brightness and contrast set-
tings not playing along well.
The blacks aren’t very deep
and the colors are pretty
decent overall. Being a TN
panel, banding is present,
but not visible as much in all
colours. Movies and games
look fine but there is noth-
ing extraordinary.

The T220 is destined for
users who want their desktop
setups to look good. The T220
is on target in that aspect,
but the performance of the

screen is not as good as we’d
like it to be. It’s still an above
average performer. The price
is clearly more than most 22-
inch screens. This is some-
thing that you should only
spend on if you really want
design and elegance.

Specifications
22-inch screen, Resolution:
1680x1050, Response time:
2ms, Dimensions: 20.47 x 17.4
x 8.46 inches

Contact: Samsung India
Electronics Pvt. Ltd.
Phone: 011-41511234
E-mail: rengith.nair
@samsung.com
Web site: www.samsung.com
Price: Rs 15,000

Samsung T220
Different, but at a cost

Features
Performance
Build quality
Value for Money
Overall

RATINGS
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The HD 4870 initially
launched with only a

512MB GDDR5 version,
which was just odd, because
such a high-power card
deserved to have more mem-
ory. Months after the first
4870s came, we see compa-
nies coming out with 1-GB
versions, one of them being
the Palit with its Sonic edi-
tion 4870 1 GB card.

Palit has not stuck with
the standard cooling edition,
but has gone in for the same
dual-fan cooling like some of
the other Sonic series cards.
The card has two 6-pin PCIe
power connectors towards
the back. Now, when you
look at the I/O side of this
card, it gets a bit more inter-
esting. Palit has moved on
from that boring Dual Link
DVI setup seen on most
graphic cards these days.

Instead, we see four different
ports – DVI, VGA, HDMI and
a new standard display port.
There is a small overclocking
switch to go from Normal to
Turbo mode. Under Normal,
the core clocks at 750MHz
and memory at 3800MHz
QDR. When you hit the
Turbo switch, the card auto-
matically adjusts its core to
775 MHz and Memory to
4000 MHz QDR. It’s not a
very large overclock, but it’s
good to have.

The card gave us a 3D
Mark 06 score of 15087. We
benchmarked Crysis in DX9
at 1280x1024 and 1920x1200
both at 4x AA and 4x AF and
got fps ratings of 46 and 30,
respectively. Unreal
Tournament 3 gave us an fps
of 115 at 1280x1024 and 69
at 1920x1200 both at 4x AA
and 4x AF. With Doom 3 (4x
AA) at 1600x 1200, we got
200.5 fps. In Prey, we got
125.5 fps at 1920x1200 and
4x AA, 4x AF. We tested in
turbo mode and it did not
give us great gains.

The only drawback we
noticed with this card is

that the it’s slightly louder
than most cards, especially
louder in turbo mode
where the fans throttle up
to the overclock. At
Rs 18,500, the card is great
buy for a high-end card.

Specifications
Memory Support: 1024 MB
DDR5, Memory Interface: 256
bit, Sonic Memory / Core
Clock: 3800 MHz (950 x 4) /
750 MHz, Turbo Memory /
Core Clock: 3800MHz (950 x 4)
/ 775 MHz

Contact: Tirupati Enterprises
Phone: 09339207519
E-mail: mail@tirupati.net
Web site: www.tirupati.net
Price: Rs. 18,500

Palit HD 4870 Sonic 1GB
From 512 MB to 1 GB

Portable hard drives are
getting smaller and

smaller and everybody
wants storage. Western
Digital has added a 500 GB
drive to the My Passport
Elite series. This drive design
is great as always and has a
soft finish to it.

The WD My Passport
Elite is a 2.5-inch drive with
a nice metallic finish to it
with the edge in a black
gloss finish. On one side, you
find the USB 2.0 connector
with four white LEDs next to
it. We noticed a flaw here,
the lights are on the con-
necting side of the drive,
that means the user can’t
really see the lights. The
lights should have been on
the other side so that users
can actually see them. There
is also a sliding cover over
the USB port which is quite
innovative and keeps the
port safe and clean.

The My Passport Elite was
quiet, and in HDTach, it
scored an average read speed

of 34.9 MBps, and an average
write speed of 29.1 MBps. In
SiSoft Sandra, the drive
Index score was 31 MBps. We
ran the drive through some
file transfer test where we
did a 1 GB sequential as well
as a 1 GB assorted file trans-
fer test and got the following
times — 1 GB sequential
write time: 36.5 sec, 1 GB
sequential read time: 16.4
sec, 1 GB sequential internal
copy: 44.7 sec. For the 1 GB
assorted files we got a write
time of 42.7 sec, a read time
of 16.1 sec, and 1 GB assorted
internal copy: 38.1 sec.

This portable drive also
comes with software that
includes Google Desktop,
Picasa, Adobe Reader 8.1, WD
Diagnostics Setup, Backup
Utility, Drive Manager,
MioNet and a Sync Tool. With

466 GB of actual storage
space, this drive is great for
its design and build quality.
It has a 5-year warranty, but
unfortunately, the price tag
of Rs. 12,150, it’s certainly not
good value for money.

Specifications
Dimensions: 15 x 126.15 x 79.5
mm, 2.5 inch SATA 5400 RPM

Contact: Western Digital
Phone: 09321029204
Email: amarjeet.singh@wdc.com
Web site: www.wdc.com
Price: Rs. 12,150

WD My Passport Elite 500GB
Slim, portable and spacious

Features
Performance
Build quality
Value for Money
Overall

RATINGS
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The XFX 750a SLi
motherboard is a

fairly new chipset
with integrated
graphics for the AMD
lover. The board is
fully loaded with all
the NVIDIA goodies like
2 way SLI support,
Hybrid SLI, GeForce Boost.

The design of the board
is well laid out with the typ-
ical XFX black and green
colour scheme. It looks
good, don’t get us wrong,
especially with the steel
heat pipes XFX has used.
There are two PCI X1 slots
below the fist PCIe slot. The
board also comes with three
PCI slots. There is also a nice
big PCI jumper between the
two PCIe slots. An interest-
ing button along with the
Power switch and Restart
button is a Bios Button
which can be flashed by the

push of it.
Some other features we

found is Justw00t, the over-
clocking features in the XFX
bios. You can also reset all
your overclocking settings
by flashing the settings on
the motherboard itself.

We tested the perform-
ance of this motherboard
and got some really good
results. The GeForce 8200

works as a really good
integrated graphics

solution and gave us
fps results of 57.5

on Doom 3
(640x480 Ultra

Details, No
AA, No AF)
and also
32.2 fps
(1024x768

Ultra Details, No
AA, No AF). Company of
Heroes gave us fps results
of 20.5 and 12 from the set-
tings of 800x600 and
1280x1024 respectively. 3D
Mark 05 gave a score of
2433/8129 (3D Marks/CPU
score). The scores for PC
Mark 05 are as follows: CPU
- 7635, Memory - 4544,
Graphics - 2208, HDD -
7042, Overall - 5762. The
Chipset on this board is the
750a MCP, but in perform-
ance it matches up to even

the NVIDIA 8300 chipset.
This motherboard is a

great motherboard for AMD
enthusiast especially with
power saving due to Hybrid
SLI. This is really a great
buy for a motherboard with
integrated graphics.

Specifications
Socket: AM2+/AM2, Chipset:
750a SLI MCP, Memory Type:
DDR2, Max Supported
Memory: 8GB, USB Ports: 4,
Onboard Graphics: GeForce
8200, VGA Port, DVI Port, 2
Way SLI Bridge.

Contact: Rashi Peripherals
Phone: 022-67090909
E-mail: response@rptechindia.com
Web site: www.rptechindia.com
Price: Rs. 8,750

XFX 750a SLi
SLI: Check, Onboard Graphics: Check, Great Buy: Check

Features
Performance
Build quality
Value for Money
Overall

RATINGS

The Internet abounds with
web sites and knowledge

about almost anything and
everything. But what if you
want to cast your voice and
opinions on the Net too but
don’t know web designing or
programming to do so. Well
that’s where Online Web site
Builders come into the pic-
ture. One such web site
builder is Mr Site which
claims to be easier than easy
when it comes to creating a
web site.

The Mr Site Website Kit is
a box which contains a
Manual, a CD and an activa-
tion code. The activation
process is straight forward
and once you decide a
domain name you’re one
step closer to creating your
web site. On logging in you
see six options infront of
you: Choose a Design, How

many Pages?, Change
Content, Publish your Site,
Extras and Log Off. On the
upper right side you also see
a Quick Jump Menu which
gives you quick and easy
access to all the options and
their respective sub-menus.
Above that are the options:
Buy, Stats, Help and Email.
Next to these options there is
a storage meter which shows
you the space you have
already utilized and will

keep you aware of when your
web site will get filled up.

There is a wide variety of
designs you can choose from
and entering your text into
them is not hard. You can
also select Creative Mode
which gives you more
options to add YouTube
videos and even Flash anima-
tions. One thing we did not
like is that the text of the
title that you select for the
page, which is displayed on
the header, will be the same
as the text on the button for
that page. Extras include
options like Widgets,
Personalising, and Admin
options. You can personalise
quite a bit with Mr Site like
uploading custom headers,
logos and even buttons. A
nice feature that comes with
this is a website image editor
which is very easy to use and
has an equally simplistic
interface. Webmail and FTP
support is also provided.

This website builder is
very user friendly with an
easy interface, but it is still
just at a basic level. Even
though this kit costs Rs.
2,999, which is costly, the
annual renewal is a mere
£2.99 (approx. Rs. 225).

Specifications
150 MB Website Storage space,
valid for 1 year, Anytime
Webmail Access, User guide
included.

Contact: Mr Site Takeaway Website
Pvt. Ltd.
Phone: 09780531682
Email: sales@mrsite.co.in
Web site: www.mrsite.co.in
Price: Rs. 2,999

Mr Site Takeaway Website
An easy way to create a website

Features
Performance
Build quality
Value for Money
Overall

RATINGS

Have you ever found your-
self in the situation that

you really needed a photo
print at that very second in
time and that there was no
way but to go to a photo stu-
dio. Well that problem will
now be solved thanks to
Canon’s Selphy CP 760 com-
pact photprinter.

It’s a simple design,
white in colour with round-
ed edges. There is a 2.5-inch

colour LCD display under
which are present the con-
trol buttons. The screen is
slightly angled so as to make
viewing as comfortable as
possible. The front side of
this printer has three memo-
ry card slots, which takes
SD, MMC, MS, MS Duo. On
the left side, the PC connec-
tion port and a USB port for
PictBridge connection from
digital cameras are present.

The Selphy has its own
features like basic colour

corrections and even
red eye reduction
which can be config-
ured on the printer
before printing. This

can be done even
when a digital

camera is
plugged in

and doesn’t
necessarily

have to be done with the PC.
The time taken to print

a single 4x6 postcard image
took us 78 sec. This was
quite amazing considering
the image accuracy. We dou-
ble checked this by printing
another image and this
time it took us 74 sec with
the same colour accuracy.
There are no modes like
colour saving and economy
that are present, but since
this printer is meant only
for photo printing, it’s just
great. Also it is great fun to
watch the process of print-
ing as it prints in layers,
first a layer of yellow, then
red, then blue and finally
white with an instant dry-
ing feature. So for each
colour layer the paper gets
sucked back in and out.

This printer is light, com-
pact, easy to use, many ways

for many devices to print,
great quality outcome. Only
question here is why is it
only a 4 x 6 photo printer.
Considering the price of
only Rs. 5,495, it is a really
great buy and we definitely
recommend this to you all.

Specifications
Max Resolution: 300x300 dpi,
2.5-inch colour LCD display,
Dimensions (inches): 7.09 (W) x
4.99 (D) x 2.88 (H),

Contact: Canon India Private
Limited
Phone: 1800-180-33-66
E-mail: info@canon.co.in
Web site: www.canon.co.in
Price: Rs. 5,495

Canon Selphy CP 760
4x6 affordable prints now available at home

Features
Performance
Build quality
Value for Money
Overall

RATINGS

Divoom is one of the
newest brands to hit

the Indian market. We have
with us a speaker set called
the Xforce 1. It’s a catchy
name for sure but we have
to see if they really are any
good in performance.

The speakers are a 2.1
format speakers that con-
nect using RCA cables. The
woofer looks really attrac-
tive but the satellites with
the dust filter covers on

aren’t as attractive. With
them removed however,
they are a lot better and
sound a tiny bit better too.
A wired remote with a mic
and auxillary input accom-
panies the speakers. The
bass and treble controls are
on the woofer itself.

The woofer is sturdy and
the sallites by themself are
built pretty well. The woofer
has a very attractive front
with a fine mesh on it

which gives it a very good
look. The stand rotates so
they automatically become
wall mounts. This is some-
thing you don’t see every-
day. Because of this, the
stands feel a little loose.

Once you tweak the tre-
ble and bass a bit, the
speakers sound pretty good.
The bass is almost excessive
but it’s not really powerful
just loose and flabby. The
satellites are much better.
They are clear and bright in
nature but lack high detail.
They are pretty loud but
they don’t really have a
punchy sound to it. The
speakers work great for
music and are still pretty
average for movies and
games. People who like
crisp highs in their music
will love these. The bass
also is pretty but good but
the mids are lacking.

The XFORCE-1 is priced
at Rs 1,900 which is cheap

for a set that sound pretty
decent. This makes it good
value for money. Anyone
who wants a decent 2.1
speaker set for the desktop
and can’t spend more than
Rs 2,000 shouldn’t look any
further.

Specifications
Power 40 W, Frequency Range:
20Hz to 20kHz,
Dimensions: Satellites 100 x
105 x 180 mm, Subwoofer: 230
x 255 x 210 mm

Contact: H T Impex
Phone: 022-66102080
E-mail: sales@zenthemaster.com
Web site: www.divoom.com
Price: Rs 1,900

Divoom XFORCE-1
No Kaboom!

Features
Performance
Build quality
Value for Money
Overall

RATINGS
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NVIDIA’s 9 series graphic
cards are nothing more

than a refurbished GeForce
8 series card. The main dif-
ference is that the 9800GT
uses 65nm GPU unlike its
8800GT counterpart. The
XFX version of this card
looks really great. Firstly it
does not take up two PCI
slots as the others that
share the same numerical
part of the name; 9800GTX,
9800GX2, 9800GTX+. XFX
has used its own cooling
solution which is a plus
point. Other than looks,
this card has 112 SPs and
comes at stock clocks of 600
MHz for the core and 512
MB of GDDR3 memory
clocked at 1800 MHz.

There is no game bun-
dled with this card, nor is
there any overclocking soft-
ware. But XFX never provides
overclocking software any-
ways. When it comes to per-

formance you cannot expect
this to be as good as a GTX
280, but it did very well for a
mid-range card. We ran it
through a series of bench-
marks at different settings
for various games are the
results are as such. In Crysis
at 1280x1024 with 4xAA and
4xAF we got 33 fps and at
1920x1200 with 4xAA and
4xAF we got 16 fps. In
Stalker: Shadow of
Chernobyl, 125.53 fps was
seen at 1280x1024 with 4x
AA and 4x AF whereas, 78
fps was seen at 1920x1200
with 4x AA and 4x AF. With
settings of 1280x1024 and
1920x1200 with 4x AA and
8x AF for Unreal Tournament

3, we got the results of 146
fps and 77 fps respectively.

On the other side, we
also tested games that were
not as demanding (graphic
wise) but are all time
favourites too like Doom 3,
Prey and Far Cry. In Doom 3
with the settings of 4x AA
at 1600x1200 we got 93.5
fps. With prey at 1280x1024
(4x AA, 4x AF) we got 112.2
fps and at 1920x1200 (4x
AA, 4x AF) it was 70.6 fps.
FarCry results were also
very good, 1280x1024 (4x
AA, 8x AF) - 147.15 fps and
at 1920x1200 (4x AA, 8x AF)
- 102.33 fps.

The XFX 9800GT gave a
3D Mark 06 score of 13351,

which is good for this card.
The XFX 9800GT is good

card to use for games at a
low resolution. It will give
you good results up to a res-
olution of 1280x1024 with
high detail. If you are plan-
ning to go above that with a
shiny 22-inch LCD or some-
thing then expect the per-
formance to fall.

Specifications
Core Clock - 600 MHz, Memory
Clock – 1800 MHz, Memory –
512MB GDDR3 Stream
Processors - 112, 512 MB GDDR3,
Memory Interface - 256 bit

Contact: Hewlett Packard
Phone: 124 - 2566 111
Email: seema.dawar@hp.com
Web site: www.hp.com/in
Price: Rs. 8,800

Intex’s IT-5400 FM are a 5.1
speaker set that can be

used with both the PC and
also in your living room
with your TV. The satellites
of this set are of the same
large size. Build quality of
the woofer is good but the
satellites have a thin mesh
behind a cloth which isn’t
very strong. The design of
the speakers themself lack
style and seem kind-of bor-
ing. The design of the
remote also looks outdated.
Batteries don’t fit well into
the remote.

The speakers come with
a FM tuner which works
fairly alright and picked up
reception instantaneously
when we first put it on
without connecting it to
our PC. The woofer has a

small display on it that dis-
plays information of the vol-
ume. Performing tasks like
changing volume requires
you to keep pressing the vol-
ume up and down buttons
constantly. The buttons on
the woofer are also of poor
quality.

The quality of the speak-
ers is average. One of the
major complaints like with
most of the other Intex
speakerswe’ve received is
the colouring of the sound.
The sound is
more empha-
sised towards

the higher mids. The sound
is pretty warm but it lacks
detail. There is crystal clear
crisp highs that come out
from the speakers. The flap-
py smooth harmonic bass
isn’t present either but the
the beats are pretty distinct.

If there’s one strong
point, it’s that the 5400FM’s
do not distort at high vol-
umes in music and movies.
The frequency sweep test
did cause a tiny bit of dis-
tortion. In general, listening
to these speakers isn’t so
much fun. Watching movies
is fine but music isn’t as
much fun with these speak-

ers.
Connections to the

speaker are made through

RCA connectors so you need
3.5mm jack to RCA connec-
tors to connect to these
speakers.

These speakers are clear-
ly best used with a DVD
player or an HTPC and con-
nected to a TV. At Rs 3,950,
they are a decent pair of
speakers and one of the
cheapest 5.1 speakers you’ll
come across.

Contact: Intex Technologies
Phone: 09811037376
E-mail: info@
intextechnologies.com
Web site: www.
intextechnologies.com
Price: Rs 3,950

Intex IT-5400FM
Average performer at a cheap price

Features
Performance
Build quality
Value for Money
Overall
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XFX 9800GT
The affordable performer

Epson has been one of
the world’s leading

manufacturers of inkjet
printers, scanners, laser
printers and even dot
matrix printers. The Epson
Stylus TX101 is an all-in-one
Printer-Scanner-Copier
inkjet and is aimed for
home users.

The TX101 is a two flap
printer, which means, the
paper has to be loaded
from the top and comes
out from the front. The
back flap is almost at a
90º angle which is fine
when you are loading a
whole lot of paper but is
not very useful for loading
single sheets.

The buttons are located
on the left of this printer
with buttons for On/Off,
Stop and Copy functionali-
ty. Sadly, even though this
all-in-one also comes with

a scanner, there is no but-
ton for Scan. You need to
scan through the PC using
the Epson Scan software
which comes with the
installation CD.

We tested the print
quality by printing three
test documents. We saw
that in economy mode it
takes about 10secs to print
a document which is light
gray in colour and of a bad
quality with lines between
each word. The same was
seen while printing the
image & text file which
took 40.7secs even in econ-
omy mode with the colours
not even being clearly visi-
ble. In the standard mode,
which is normal, the print
quality did improve, but
the edges were still rough
and the time taken for the
text documents was at an
average of about 27secs.

The image quality was an
improvement, but that
page took 127.1secs with
the same jagged edges
around text.

We also tested photo
printing by printing a full
page colour test document
on some photo paper. The
quality was slightly dull
with some pixilation in
comparison to the actual
image. The time taken to
print this at the best quali-
ty was 9 mins and 28 secs
which is just too long for
one print.

This Epson is a basic all-
in-one printer that does not

have anything out of the
ordinary going for it.

Even though it is
priced at only Rs.
3,699, we would
not recommend
you to buy this as
quality wise it is
not ideal.

Specifications
Maximum resolution:
5760x1440 dpi , Optical reso-
lution: 600 X 1200 DPI, 48 bits
input, 24 bits output

Contact: Epson India
Phone: 080 30515000
E-mail: think@eid.epson.co.in
Web site: www.epson.co.in
Price: Rs. 3,699

Epson Stylus TX101
Where it’s all about being affordable

The Cookie is a clean look-
ing phone at first glance.

Its got a really uncluttered
front facia with just three,
small and well beveled but-
tons. The phone itself is fin-
ished in matte black and has
a steel-grey ring running
right around the sides that
adds a classy look. The cam-
era and phone screen lock
buttons are on one side and
very easy to use despite their
small size owing to great
feedback, the volume
up/down buttons aren’t as
good. LG has added the abili-
ty to finger swipe through
albums and this is called
“Free Touch”, an obvious rip-
off from Apple’s Multi Touch;
but it doesn’t work anywhere
at all as well which is why
there’s a stylus provided. Its
light years away from the

flawless fluidity of Apple’s
touch interface. Add to that a
very slow processor which
becomes amply evident as
you use the touch feature
when browsing albums and
such. We were a bit disap-
pointed with the touch sensi-
tivity. On a more positive
note touch accuracy is a bit
better and acceptable for a
phone in this bracket.

The screen itself is quite
large and clear although
we’ve seen better screens in

the Xperia and the IPhone.
The Cookie does make a
strong point for itself by hav-
ing a well laid out menu sys-
tem with pretty good icons –
not like some of the cartoon-
ish icons we’ve seen from LG
in the past. LG provides a
neat bunch of games and
quite frankly we had a bit of
fun playing these.

This is no camera phone
and we’ve seen much better
3-megapixel units and
there’s no flash. MP3 play-
back quality is strictly so-so
and another pain is LGs con-
tinued use of a proprietary
connect for the same rather
than a 3.5mm jack. Call qual-
ity and signal reception
strength on the Cookie isn’t
all that great and nowhere
close to Nokia phones.

Priced at Rs 13,500 its a
mixed bundle. Although not
many phones can offer such
a large touchscreen for the
price there are other prob-

lems that prevent us from
recommending you swallow
this Cookie (pardon the pun!).
For one, it’s a mediocre
phone, MP3 playback quality
and the camer could be bet-
ter. There are other alterna-
tives for this price range that
do far more as a phone and
as multimedia devices.

Specifications
Specifications: Screen – 3.0”,
240 x 400 pixels, 3 MP camera,
microSD expansion, 89 grams

Contact: LG Electronics India
Pvt. Ltd
Phone: 91-120-2560900
E-mail: VivekSingh@lgindia.com
Web site: www.lgindia.com
Price: Rs. 13,500

LG KP500 Cookie
No cookie for me

Features
Performance
Ease of Use
Value for Money
Overall
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There have been many
mobile phones and PMPs

that allow users to watch
videos and movies on them.
But seriously, watching the
videos on that small a
screen is really painful. So
here is a solution for those
commuters who like to
catch up on their video and
movie watching needs with
a bigger screen. The Mitashi
TFD-7608 is portable DVD
player with a load of fea-
tures to offer, it’s silver on
the outside and has a black
finish on the inside.

This portable device has
a 3.5mm headphone jack,
AV-in, AV-out, and the vol-
ume control on the right.
On the left you can plug
your TV wire into. When
you open the player, the
first thing you notice is that
the screen can be rotated
and turned all the way
around and made to rest

like a tablet PC. The buttons
on the device were not very
good and felt toyish.

The remote provided is
also not that great in quali-
ty, but has additional
options like zoom, and at
least the buttons here have
a better feel to them than
those on teh player.
Although one must wonder
why a portable player needs
a remote in
th first
place?
Especially
since you
can’t view it
from more
than an arms
length.

The player also has
MMC, SD and MS card input
support from the back as
well as a USB port so that
you can plug in a flash
drive. When we tried to play
something from a flash
drive, however, we found
that it takes 5 clicks to start
a movie. This player sup-
ports a wide range of for-
mats including DIVX

Another problem we
spotted was while turning
the screen the TFT flickers

at the base. We
looked into it
more and saw
that any time
the screen is
disturbed
there is a

slight

intereference. Even so, this
player is great company on
long journeys and will pro-
vide on-the-go entertain-
ment whenever and wher-
ever you are. Also you can
use this as a DVD player in
your car.

Specifications
7-inch widescreen TFT Color
Display with In-built TV Tuner,
DVD/CD/MP3/DIVX/JPEG, built-
in SD/MMC/ MS Card Reader &
DivX function

Contact: Mitashi Edutainment
Pvt. Ltd.
Phone: 022 -25006661
E-mail: sujay@mitashi.com,
archie@mitashi.com
Web site: www.mitashi.com
Price: Rs. 7,490

Mitashi TFD-7608
DVDs on the go...

With security being such
a big concern these

days, there have been many
new developers coming up
with antivirus software and
then evolving into complete
security suites. Some of the
older well-known security
suites have been overshad-
owed by them.

The installation is simple
and you are first prompted
to uninstall and disable any
previous security suites or
components that you have
installed. The interface is tra-
ditional as compared to
Norton’s recent security
suites. To keep the abundant
features from confusing
users, the suite lets you tog-
gle between a Basic and
Advanced menu. Each of the
features in the suite have

very detailed customisation
windows that allow you to
tweak each component.

McAfee’s Internet
Security 2009 comes with
pretty much everything
required to safeguard your
system from everything from
virus and worms to hacker
attacks. Parental control is
also part of the suite.

Keywords and wildcards
can be used to block sites.
The McAfee Data Backup fea-
ture is one that lets you

archive data from your drive
to either a optical disc, a dif-
ferent location on your drive,
or one on the network.

Spams in mails are also
taken care of, as well as
files sent through instant
messengers. There are addi-
tional features like the
Password vault, which
allows you to securely store
your passwords.

There are other interest-
ing bits like the Shredder fea-
ture that permanently
deletes files or even an entire
partition or drive. The system
cleanup feature allows you to
delete all unnecessary items
such as temporary files from
installers, cache from
browsers, undeleted registry
keys and so on. With all its
features, it is a little bloated
and slow at times.

McAfee’s Internet
Security 2009 is at par with
the security software we’ve

seen, though not as polished
or as simplistic.

The price of Rs. 2,699 is
fine as you can use this to
protect upto three PCs. As a
security solution, it’s not
miles ahead of other suites.

Requirements:
Windows 2000 (SP4 and high-
er), Windows XP, Windows
Vista, 256 MB of RAM, 150 MB
of free disk space.

Contact: McAfee
Phone: 022-40291300
Email: hemant_baghel
@mcafee.com
Web site: www.mcafee.com
Price: Rs. 2,699 (Upto 3 PCs)

McAcfee Internet Security 2009
As good as the many others

Features
Performance
Build quality
Value for Money
Overall
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Over the years games have become
more demanding on our hard-
ware as they offer greater immer-

sion. One aspect of gaming remains
unchanged — your interaction with the
game. Most of us use a cheap keyboard
and mouse while gaming. While this
may do for playing the odd game, if you
care to call yourself a gamer, you will def-
initely feel the inadequacy of a common
keyboard and mouse. Customisable but-
tons, macro keys, high-sensitivity mice
and joysticks — are what you should look
to as tools of the gaming trade.

My hunt for new gaming gear began
with the demise of my two-year old
Logitech MX518. It had served me
through countless hours of Quake 3:
Arena, Warcraft III and Battlefield 2142;
not to mention a host of single-play-
er titles, including Crysis. The
impending release of Prince Of
Persia also had me seriously think-
ing about biting the bullet and
buying a game controller. So I need-
ed a new mouse and a game controller.

I already have a superb keyboard —
the Logitech G15 — which has beauti-
fully backlit keys; a must for after-dark
fraggers. The key spacing is a little
more than what most keyboards offer,
which is great for gaming. There are
also 12 macro keys; superb for hack-n-
slash and RTS games. The G15 is priced
at Rs. 4,400 and while that may seem a
lot, it’s a beautiful keyboard for hard-
core gamers. Razer’s Tarantula is
another good offering, although it has
less macro keys than the G15 and not
all its keys are backlit. The Tarantula
retails for Rs. 6,200 in India which is
way too much for what it offers. There
are a couple of options from the likes
of iBall and Zebronics but these are
half-hearted attempts at gaming key-
boards and not worth the premium.

When it comes to gaming mice
there are four major players — Logitech,
Microsoft, Razer, and Steel Series.
When looking at gaming mice, remem-
ber that there are two types of sensors —
infrared and laser. Laser sensors have
higher resolutions and offer greater
scrolling speed (not to be mistaken for
accuracy) than infrared mice. Logitech’s
MX518, an infrared mouse, costs Rs.

1,400 — and is a real steal for its price.
The Logitech G5 is a laser mouse with a
2,000 dpi sensor and is priced at Rs.
2,500. You can even configure the
weight distribution of the mouse using
provided weights. Logitech’s latest
offering; the G9 sports a 3200 dpi sen-
sor and has a customisable grip that
can be adjusted for width depending on
the size of your hand. It’s priced at Rs.
4,400. Razer’s Lachesis is a competitor
to the G9 and sports an identical sen-
sor; it’s a fair bit costlier at Rs. 5,400. It’s
the same size as their Copperhead, and
both are aimed gamers with slightly
smaller hands, in my opinion. The

Copperhead is priced at Rs. 4,000.
Personally I find both of these mice to
be very small for my hand and there-
fore uncomfortable, although their
lower profiles (compared to Logitech
mice) do help to alleviate stress on the
wrist. The Razer Diamondback is the
same size and shape as the Copperhead,
but sports a slightly lower resolution
(1600 dpi) infrared sensor; it’s priced at
Rs. 3,000. Razer’s Deathadder is my
favourite mouse from the Razer series.
It sports a 1600 dpi infrared sensor and
feels very close to the MX518 in hand;
but it’s slightly lower, and its more
rounded profile fits my hand perfectly.
Steel Series’ Ikari, a 1600 dpi mouse, is
priced at Rs. 2,000 and exudes a great
feel. The only drawback is that its clicks
are a little too soft for my taste.

Do not be fooled by resolutions — all
these mice track really well and a 3,200
dpi sensor might not always be better
than a 2,000 dpi sensor since the extra
precision means the mouse gets ultra-
sensitive to even minute movements —
not something most gamers are comfort-

able with. Microsoft’s Sidewinder and
Sidewinder X5 are other gaming options:
the former is costlier at Rs. 5,100, and the
latter sells for Rs. 2,500. In comparison to
Logitech and Razer, these feel a little
tacky, particularly the X5. The Habu is an
older option from Microsoft with a
slightly improved MX518 sensor under its
hood. It’s priced at Rs. 2,500. For me, a
mouse can’t get better than the MX518 —
superbly priced now, I bought mine for
Rs. 2,600 a couple of years back and
thought it decent value; at its current
price, well, it’s a steal.

I was also looking for a controller for
hack-n-slash games to use with my PC.
Microsoft’s Xbox 360 wired controller is
available for as little Rs. 1,650 these days.
At this price, it’s a steal as it comes with
force feedback. The wireless version of
the controller costs Rs. 2,700 but you
also need a wireless receiver unit if
you’re going to use it with your PC.
Sony’s PS3 controller (called DualShock
3) is also available; the wired version of
the same costs Rs. 2,900 while the wire-
less version is priced at Rs. 4,500. I did
see a Saitek wired controller priced at
Rs. 2,500; availability of this brand will

be an issue in most places although the
higher end Saitek products are very
good. I highly recommend the wired
Xbox 360 controller — it’s cheap, it’s
widespread and works well.

For racing games, Logitech’s G25
and Momo are available. The Momo is
excellent value at Rs. 4500. It has two
pedals, a 240-degree steering wheel
turn and force feedback. The G25 is a
premium offering and I must say it
looks lovely with a leather wrapped
wheel and its F1-style paddles. The
steering is ultra realistic with 2.5 turns
from end to end and the dual-motor
feedback ensures that you feel not only
bumps but also curves in the road and
embankments — this is the real deal
for racing fans. The only downside is
the price — Rs. 17,750 — although it’s
fairly priced in my opinion; for the
experience it offerss.

I ended up picking the Xbox 360 con-
troller and the Logitech MX518. Now
fraggers will once again quake; while I
get down and dirty with the prince. �

agent001@thinkdigit.com

Agent 001

Peripheral Vision
Agent 001 goes shopping for gaming peripherals



84 DIGIT FEBRUARY 2009 www.thinkdigit.com

Digital Tools l Agent 001

I wish to upgrade my PC. My PC configuration is
1.5 GB of DDR2 667 MHz memory, ATi Radeon

X1550 Series graphics card, Intel E4600 CPU, Asus
P5KC Motherboard and 400 watt SMPS. I want to
upgrade my memory and GPU first. I will also upgrade
my processor but a few months down the line. My
budget for the graphics card is Rs. 5,000 and for the
memory is Rs. 3,500. Which brand is good and what
sort of a performance increase can I expect with a
memory upgrade? Should i change my PSU for my con-
figuration? My budget for the processor is Rs. 8,000.

Ihsan Ibrahim

The weakest points in your configuration is
your CPU and GPU. You haven’t mentioned

what your usage pattern is, but I would recom-
mend DDR2 800 MHz memory in a dual channel
configuration if you’re on a really tight budget or
1066 MHz memory if you can spend a thousand
bucks more. Opt for two sticks of 2 GB each for a
total of 4 GB. For the graphics card I suggest you
invest in an NVIDIA GeForce 9600 GT-based
graphics card. EVGA’s 9600 GT is a good option.
Expect to pay Rs. 6,000 for this – which is a steal in
my opinion. Intel’s E8400 (3.0 GHz), is a good
processor for a powerful, multipurpose PC. It’s a
Wolfdale based dual-core processor with 6 MB of
L2 cache and is priced at around the Rs. 8,000 mark.
Expect a 10 percent increase in performance with
your memory upgrade and a much higher increase
in performance with the recommended CPU and
GPU. Change your PSU; Corsair’s VX 450 is a good
buy at Rs. 3,500 and will power your PC.

I am planning to buy a new machine with an AMD
Phenom X4 9550, JetWay HA-06, Seagate 1 Ter-

abyte (32 MB Buffer) HDD, Sony 20 X SATA DVD writer
and a 17-inch LCD monitor. I am a general home user
although I play the odd game. Please suggest a suitable
power supply and cabinet and also a good DVD writer
apart from Sony.

Cyrus Chowbey

Why don’t you go with a Core 2 Duo E8400
instead? It is faster than the X4 9550 in all

the tasks you’ve mentioned. If you want a quad
core, Intel’s own Q6600 will also be a better option.
Both of these cost the same as the X4 9550. For a
power supply I recommend a VIP 500 watt PSU
which will cost you around Rs. 3,000. Look at the
CoolerMaster 690 for a cabinet; it’s a great looker
and cools excellently. If you want a decent gaming
experience with older games look at a graphics
card – the GeForce 8600 GT is a good entry level
chipset; it should be priced at the Rs. 3,500 mark.
LG DVD writers are good alternatives to Sony and
I personally feel they’re more reliable.

I have decided to buy a camcorder that fits in a
budget of 20k. Please let me know about the 3

models: Samsung’s VP_DX103i, Sony’s DCR-DVD610 and

Ask Agent 001

Canon’s DC310, their IS and recording medium. Would
a 35x optical zoom be sufficient for shooting in the hill
stations? Which of the above models fits the best for
my purpose?

Chayan

First of all let me say that I find HDD-based
camcorders much better than disc- or tape-

based ones. They are also compact in comparison.
A 35x optical zoom is enough for most situations;
and in any case camcorders with a higher zoom
are rare and suitably price i.e. beyond your budget.
Please use the camcorder you intend to buy to
ascertain the effectiveness of its optical zoom;
which for me is the most important factor when
buying a camcorder for outdoor purposes.

I have planned to purchase Sony Ericsson’s W595
cellphone. It’s priced at Rs. 14,000. I want a

mobile with good music solution. Can you suggest
any other worthy mobiles around Rs. 14k to 15k?

Merbin Shyju

It depends on what exactly you’re looking
for. If you want a feature-rich Symbian

based cellphone then I would point you towards
the Nokia N73 Music Edition. Else if you wanted an
SE phone I’d suggest the K850i – which has a good
camera and also great music quality. This should
be priced at around the Rs. 15,500 mark and is
superb for the price. The SE K800i/K810i phones
are also good for you – they offer excellent music
quality and a very good camera. These phones are
cheaper and the K810i is actually priced around
the Rs. 9,000 mark; meaning you can pick up an
iPod Nano 4 GB with the remaining cash and get
yourself a good PMP as well.

I am planning to buy a PC. It will be used for lots
of business stuff, including the stock market

monitoring etc. You see I am very fond of gaming also.
I would like a gaming rig combined with a business
power machine. Could you suggest a good configura-
tion within a budget of around Rs 70,000?

Rohan Kumar
Here’s my recommendation:
Going for a quad core doesn’t make sense

unless you are willing to sacrifice on some other
component and get an Intel Q9550 (2.83 GHz)
processor which will cost Rs. 17,500. �

Components My Suggestion Price
Processor C2D E8500 (3.16 GHz) 9,500
Motherboard MSI P 45 Platinum 10,000
RAM 2 x 2 GB DDR2 1066 MHz (Kingston, Corsair) 5,000
Graphics Card ZOTAC GeForce 9800GTX+ AMP! 12,000
Hard Drive Seagate 1 TB 7200.11 6,800
Monitor Dell SP 2208 WFP 15,000
Cabinet CM 690 4,000
Power Supply Corsair HX 520 6,000

68,300

PC Configuration

Want a tech product, but
don’t know how to go

about buying it? E-mail
agent001@thinkdigit.com

with your complete
contact details, and he

might answer them here!
Please note that

Agent001 only answers
purchase-related

questions in this space.

Ask Away!
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There’s a lot you
can do to reduce
your operating
costs in these
days of econom-
ic turmoil —
from optimally
using your air
conditioners to
using your print-
ers efficiently

Digital
Digital Leisure l Touched By Tech

How Technology Can Help Your Organisation
Business
Digital

Second-hand PCs: A first-hand report 88

A
sh

w
in

i B
av

is
ka

r

that open to let out the heat. Have your meter
checked if you’re getting outlandish bills. It’s a
matter of filling out and submitting a simple
form at your electricity company’s office.

Here are things you can do on the IT front:
1. Switching to LCD monitors is a good idea.
Some quick back-of-the-envelope calculations
show that on an average you should recover the
additional investment of LCD over CRT in just
three years by way of accrued savings on elec-
tricity. Not to mention the space saving, and
hey — they look better. Incidentally, LCDs pro-
duce less heat, so a marginal decrease in air
conditioning costs cannot be ruled out.

2. Switch off the mains to your PCs before leav-
ing. Know that your equipment draws power
even when they’re off. So when you see the
small green light on any device, it’s drawing at
least a few watts. A recent UN-sponsored study
found that up to 10 per cent of your electricity

Siddharth Parwatay

In today’s economic turmoil, everyone’s look-
ing at ways to cut down on costs — small
businesses are no exception. In fact, small

businesses are probably hit the hardest as most
of them operate on limited rolling capital and
don’t have deep pockets to sustain themselves
in these times. And they say, desperate times call
for desperate measures. What can your business
do to save costs? Here, we look at some cost-cut-
ting measures that you can deploy. 

Cut your electricity bills
Utility costs can be a killer. For example, setting
the air conditioner to 26 degrees will help a
long way — the temperature remains pleasant
enough to work while drastically reducing your
electricity bill. During summers, reduce air-
conditioning costs by scheduling your work
around the hottest hours of the day, if you work
from a home-office. Use fans and ventilators

High in the meltdown
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bills can be reduced simply by switching off the
power to computers and other electronics such
as cellphone chargers.

3. Tweak the computer’s power manage-
ment for optimum savings. We’re often away
from our screens — coffee breaks, telephone
calls, and numerous other distractions always
keep popping up to pull you away from your
desk. Screen savers that usually kick in at such
times won’t save your screens and won’t do
much for your power bills either. Keep the set-
tings such that your monitor switches off after
five minutes, or less, of being idle. 

Cut your phone bills
Cutting down on phone costs can be a tricky
business considering the multitude of offers
and plans out there. The key is to analyse your
usage pattern. 

1. Find out what type of calls your business
is required make — whether more calls will go
out to cell phones or to land lines — whether
STD or local?

2. Find out from where most of the call-
ing happens — whether land lines or
mobiles? Once you know, choose a plan and
service provider to meet your requirements.

3. An increasing number of people are sav-
ing money by using Voice over Internet
Protocol (VoIP) clients, such as Skype. While
the quality of service varies, it can be more
cost-effective than landlines. Skype can be
used to make international as well as domes-
tic internet calls.  While international calls are
charged a nominal amount, the domestic calls
are free (Check the box ‘Setting up Skype’ for
details on how to install and use  Skype). There
are software such as TeamSpeak which will allow
you to host a voice-chat server for multiple users
to log into. So conference calls within the same
building or even branch offices can be achieved.

4. If you have a number of employees working
and you’re not constantly around to supervise, it’s
probably a good idea to keep STD active on only
some lines. Phone lock codes are also a good idea.

5. Use free SMS services such as
www.way2sms.com. After all, a penny saved is a
penny earned.

Cut your internet costs
Internet costs for your office can
be brought down through some
tweaking. 

1. Analyse your usage pattern. Is
it more of just email and light brows-
ing, or is a fair bit of downloading
required? If it is the former, we’d rec-
ommend going in for speed and
bandwidth as against high-data lim-
its. Any 256kbps connection these
days offers 500MB of data transfer.
This is more than sufficient for
browsing and email. The bandwidth,

too, is good enough to give you decent browsing
speeds when split into say three PCs over a net-
work. Firewalls and filters are a must unless you
want your employees to be loitering around on
Orkut and using up precious bandwidth and
data limits. If you’re on a limited data line, you
need to have a caching server / proxy, so that fre-
quently visited web pages are stored on local
drives for quick retrieval. This means that these
web pages are not downloaded each and every
time you visit them (Check the box ‘Cutting
internet costs’ to learn how).

2. If your usage is more download-intensive,
opt for the unlimited plans. Any good unlimit-
ed plan these days should be not be more than
Rs. 1,500 for a 256kbps line.

3. These days, for most businesses, however
small, having a web site is a must. Accordingly,
many small businesses do host simple web sites,
for which they end up paying a lot of money as
domain registration charges and web space.
While in fact web space is available for cheap

and at times, at zero cost.
You should not pay more
than Rs. 450 for domain
registration. If your web
site is hosted by one of
those web space resellers
that sprouted at every
corner during the dot-
com boom, then please
look elsewhere. Host your
website on, freeweb-
space.com or at least paid,

but cheaper Indian servers. Once your domain is
registered, all you need to do is redirect it to
where your web site is hosted. For example, buy
the domain www.yourbusiness.com but host it at
http://yourbusiness.freewebspace. com.

4. The same goes for email. If your friendly
neighbourhood web space reseller is charging you
for an email interface, you need to stop right
away. Zoho.com has solutions for small office users,
whereby your emails are pulled to Zoho’s servers.
You get the Zoho interface that is quite similar to
Gmail and migration is also pretty straight for-
ward. The best part — it’s free for up to ten users!
All you need to do is configure your domain and

e-mail information with
Zoho. Your email will
remain you@yourbusiness
.com, but you’ll now be
checking mails at some-
thing like http:// busi-
ness.mail.zoho.com/a/ your-
business.com/#inbox.

Google also offers a
similar service, and
they’re trying to hide it.
Go to www.google.com/a/,
click the big blue “See
details and sign up” but-
ton. Although it looks

Free Proxy: Setting up caching

FreeProxy: Setting up the proxy server
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like you have to pay for this service, look for a
link that says “Compare to Standard Edition”.
when you click this, you will see a “Get Started”
button under “Standard Edition”. From here on
you can just follow instructions, and get over 7
GB email space for up to 50 users. 

Other tips
There are other things you can try, like printing
on both sides of the paper. You save money and
the environment! Some printers automatically
print on both sides of the paper. If your printer
does not, use the “print on both sides” mode,
where you only have to manually reverse the stack
after one side is printed. Also, avoid
printing unless absolutely required.
If you must print, then print in
draft / economy mode by default.

So far we have told you what
you can, and should do, to cut cor-
ners. But while running leaner is a
must, not every penny-pinching
measure is a good one — so here are
some strict No-Nos. Certain things
are really based on common sense.
For example, if your business relies
on a web face then don’t compro-
mise on that front. Follow these set
of instructions and you should be
well on your way to frugality in
these trying times. 

siddharth.parwatay@thinkdigit.com

To share an internet connection between multiple computers, a proxy software is
required. Several solutions such asFreeProxy and AnalogX are available online.
Download and install FreeProxy from www.handcraftedsoftware.org. It is simple,
easy to use and also functions as a caching server and web site filter / blocker.

To Share a Connection using FreeProxy follow these steps:
Click on Define > Define Ports. Here you can define ports for Http,

socks, etc. (Usually 8080, 1080 etc). Click on Done.
Now enter this in the browser’s settings on the PCs connected to the net-

work. Click on Start/Stop to activate proxy server. All PCs will now access
the internet through this proxy server. 

To Activate Caching:
Click on Define > Define Cache. Tick the Activate the cache check
box. Select the control and data path. Enter the size limit of cache depending
on usage. 300MB should be fine. Set the expiry to around 7 days. Click on
Done.

To ban certain web sites:
Click on the Ban List button in the top bar. Click on New and create a cate-
gory, say Bad. Click on Manage Category Details and add the URLs that
you wish to block. Click Save, and then  Activate > Done. Double-click on
Ports and then on Permissions > Add Resource. In Resource type,
select Ban-List URL or IP Address. Under Permission, select
Forbidden for all users. Click Done. You can also add filters. To do
this in resource type, select Full URL or Path Filter. Under path, you
can type *download* to block all URLs containing the word download.

To communicate between branches of your
office, make sure you have Skype downloaded
and installed on the PCs  in your office. You can
also have conference calls between offices
using Skype. Upto 24 employees can join these
conference calls. Click on Call > Start
Conference Call. Add users from your con-
tacts and click on start.

Skype Setup

To change the power management settings for
your PC, go to Start > Control Panel >
Click Power Options. Set the Turn off moni-
tor to After 5 minutes, and turn off hard disks
to After 10 minutes, and standby to 15
minutes. This will significantly save electricity.

Using Power Management

TeamSpeak is an application that allows you to
host a voice server on your PC. You can connect
to this server and have a voice chat / conference.
The application is actually meant for gaming pur-
poses, but can be put to commercial use. It’s free
and works effectively on LAN. So in case you have
an office, which is on different levels or floors
this could be a useful utility. It’s like having a con-
ference call on, all the time which is something
not even possible on a telephone-based inter-
com, To setup, download TeamSpeak client as
well as TeamSpeak server from www.teams-
peak.com. While installing the server, you will get
a temporary username and password. Make a
note of both admin and superadmin passwords.
These passwords can be changed to your prefer-
ence later. Once installed, the TeamSpeak server
will minimise to the system tray. Right-click on it
and click on Administration. The server is
managed through a web interface, so a browser
page will open where you need to put in your
username as superadmin and password. Once
within the interface, click on SuperAdmin manag-
er in the left pane. Click on add client to create
user accounts for all your employees. Assign user
name and password for each employee. Once this
is done install the TeamSpeak client on all your
PCs. To connect to the server from another PC
click on Connection > Connect in the
TeamSpeak Client application. Add details of the
server such as server IP address and nickname.
Enter user name and password and click connect.
The server’s IP can be found out by right-clicking
on the server icon in the system tray and moving
the cursor over “Your IPs”.

TeamSpeak

Sharing the internet 

Teamspeak setup
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Today’s PCs may
be more power-
ful than ever
before, but
what about
affordability?
Second-hand
PCs offer the
perfect budget
solution for
your small
office.

Siddharth Parwatay

Can anyone’s scrapped system, be some-
one else’s dream machine? Well, this cer-
tainly holds true in the second-hand PC

market. Just because your PC can’t run the lat-
est game doesn’t mean it’s trash. It can possibly
perform mundane office tasks. Many don’t
know this, but there exists a large secondary PC
market out there — with its own set of rules of
participation and provision. A stream of such
so-called obsolete PCs form the foundation of
this market. Some consumers frequently
upgrade their PCs and sell their old ones in the
second-hand market — largely in the metros. A
significant portion of these proliferate to rural
areas, where people may not have the means or
inclination to invest in the latest configura-
tions. Such second-hand machines also find
their way to educational institutes, offices, and
businesses, in tier II and III cities. A Gartner
report states that “one in every 12 PCs in use
worldwide is a secondary PC.” An estimated 10
per cent is donated to NGOs and other non-
profit organisations. Let’s try to understand the
specifics of the second-hand PC market by
answering some fundamental questions.

Why would you want a second-hand
computer?
Well the simplest and quickest answer to that
question is price! People who buy a refur-

Second-hand 

A First-hand Report
bished or a second-hand computer generally
fall into one of two categories. The first cate-
gory of people need a computer for fairly stan-
dard tasks such as internet browsing, word
processing, spreadsheet work, etc.
Applications of this nature have not changed
much over the years in terms of the demands
that they make on a computer’s resources.
Therefore, a second-hand computer which
may be a few years old, would be quite capa-
ble of running even modern versions of these
programs and at a fraction of the price of a
brand-new machine. Besides, when you’re
running such mundane tasks, a brand new
machine can be an expensive overkill. The sec-
ond category of users might require a
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machine to do some specific task — as part of
an office or a home network — for example an
email, a database, or a web server. Again,
tasks which an older computer is quite capa-
ble of handling.

Gordon Moore, the former CEO of Intel
once observed that “the power of semicon-
ductor technology doubles every 18 months”,
and so the average computer manufactured
today has specifications which dwarf those
available just a few years ago. But the
resource requirement of day-to-day software
has not evolved at the same pace. A computer
made three years ago will run office, data-
base, accounting and other mainstream
applications, and browse the net, as effective-
ly as the latest PC. This is quite a blessing for
small businesses looking to purchase a few
additional computers, especially in these dire
economic times.

“Well what about durability?” you may
ask. Jitu Bhai who is the proprietor of Jitu
Bhai Joone Computer has some reassuring
things to say. As his company’s name sug-
gests, he deals exclusively in second-hand

computers and has been in the business for
over ten years. “Computers, although not
built to last forever, are certainly built to last.
Especially the older ones which had better
build quality”, Jitu opines. “[They] almost
never break down... if one does fail, chances
are that your new PC can also do just that”,
says Jitu Bhai. He also points out that it’s a
good step you can take to do your bit for the
environment. Remember that with very little
measure taken for proper disposal of e-waste,
most of the redundant PCs in India will be
dumped in non-environment-friendly ways.
Reuse and reduce is the formula.

Where do these PCs come from?
As we pointed out earlier, one source is the
home user, probably indulging in a two-year
upgrade cycle. But another important source
of these PCs are large companies that have
regular update cycles. Companies operating
in verticals such as IT, telecom, banking and

1. Avoid Branded PCs. Opt for assembled -
Branded PCs have customised motherboards
which are hard to come by. Their slots can’t
accommodate generic components, the SMPS
can’t be sourced and numerous other problems.
An assembled PC, on the other hand, is easily
upgradeable.

2. Avoid RD and SD RAM – Again, these compo-
nents are very difficult to source. Even if you
can source the RAM, it'll be expensive due to
non availability.

3. Opt for Samsung and LG screens – These,
according to dealers, are the most reliable and
they have a wide service network. Like most
things Chinese, avoid Chinese monitors.

4. Operate the PC to check if its in working
order - Look under the hood for components
that are within warranty. For example most
hard disk drives come with a 3 year warranty.
Also check for bad sectors in the harddisk. 

5. Check to see if the cooling fan is working
properly - Any abnormal whirring noises could
mean it has gathered dust and needs cleaning.

6. Give the specs a thorough look to make sure
they match with the ones advertised - Go to
Settings > Control Panel > System >
Device Manager to check the listed features. 

7. Try to get original documentation - Receipts
always come in handy.

8. Avoid Celerons - No explanation required!

Things to keep in mind while
buying second-hand PCs

When most people sell off their computers, they
do a simple formatting of their hard drive. This
is certainly not enough. They put themselves at
risk of being defrauded or of having their identi-
ties stolen because many disks are not properly
wiped of data. Second-hand computers are a
potential treasure-trove of personal informa-
tion, and can be exploited to devastating effect.
Professor Martin Gill of the University of
Leicester and his team, in a study purchased six
second-hand computers from various sources
and conducted a forensic data-analysis on each
one using off the shelf computer software. They
discovered half had not been securely wiped. In
one case, there had been no attempt to wipe the
contents! Make sure you use a data-shredding
software on your most personal files before sell-
ing your PC. A good data wiping software is
Erase v 5.3 which can be downloaded from
http://www.tolvanen.com/eraser/download.shtml

When you are the seller
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finance, where the criticality of IT infrastruc-
ture is very high, experience a high churn for
PCs that are phased out more rapidly. It is
here that the technology obsolescence factor
essentially acts as a driver for the second-
hand PC market. Until recently, banking and
finance companies could easily afford to be
slightly frivolous. Faisal of Star Infotech,
which operates out of Lamington Road and
deals in second-hand PCs puts it well — “large
companies will routinely go in for a yearly
revamp in hardware and sell the old comput-
ers to dealers for near scrap value.” However,
he is quick to add that “most of my stock
comes from home users”. Faisal is now look-
ing forward to expanding his sales reach by
targeting SMEs that require 15 to 20 comput-
ers for routine work. Jitu Bhai also offers
some interesting insights. “A lot of pieces
come from customs where auctions are regu-
larly held to get rid of unclaimed or seized
goods. Big businesses are a good source but
we get their used computers indirectly,
through large PC suppliers who are required
to buy back hundreds of PCs from their
clients as part of exchange schemes”, says Jitu
Bhai. Another source is imports. Some may
frown and call it e-waste dumping, but large
quantities of high-end used computers find
their way to Nehru Place in Delhi and sec-
ondary markets in Kolkata. These PCs are usu-
ally leased by rental companies abroad, and
after a pre-defined deadline are considered
redundant. Of course, they are far from
redundant. Many of Jitu Bhai’s components
come from PC manufactures who keep stand-
by pieces of components to cover replacement
guarantees. The buffers are quite high and
many pieces remain unused, and find them-
selves in the secondary market.

A standard configuration:
Intel Pentium 4, 2GHz , 256MB RAM, 40GB Hard
drive 
CD-Writer, keyboard, and mouse 
15-inchCRT monitor
Rs. 6,000

Web Resources: Classified web sites will help you
find individual products as well as second-hand
dealers in your city or town. Here are some
examples.
http://www.adpost.com/in/computers/
http://www.trademart.in/
http://dir.indiamart.com/cgi/compcatsearch.mp?
ss=second%20hand%20computer
http://www.sscomptech.com/used-computer.htm
http://www.secondhandmall.com/
http://www.jitubhai.com/

A standard configuration

Why does it make sense for SoHo’s?
According to Jitu Bhai, the propensity to buy
second-hand PCs for offices is less in the
Metros. This is because the gap between new
and second-hand has narrowed over the years.
Yet the thumb rule remains that a second-
hand machine can be bought at half the price
of a new one. As per current prices, a decent
second-hand PC can be bought for Rs. 6,000 to
8,000 as opposed to a new entry-level model
for around Rs. 13,000. This translates to
Rs. 5,000 saving on just a single PC — if your
business requires more than five PCs, you are
looking at a substantial saving.

People in the metros also have several
hang-ups regarding after-sales service. Anyone
trying to rubbish the entire second-hand busi-
ness PCs should know that most of the players
offer some form of warranty. The warranty
period may range from a week to a month and
most secondary sellers offer maintenance con-
tracts through partner firms. Most don’t offer
on-site warranty, but are happy to service the
faulty components if you’re willing to bring
the equipment to their office. Many others go
by the axiom, “Walk out of the door and it’s
your responsibility...” Avoid these guys.

Tier II and tier III cities are more open to
the concept of used PCs. Mr. Goyal, a cyber-
cafe owner in Jaipur had started off with three
PCs that he bought from Jitu Bhai. He has now
expanded to fifteen and is perfectly satisfied.
A woman in Mira Road, who does not wish to
be named, has several second-hand computers
that form the back-bone of her small medical
transcription business.

Where do you start from?
Your friendly neighbourhood assembler should
be able to get you a good deal or at least get you
in touch with a second-hand seller. You will also
find players like Jitu Bhai who have their own
web site (www.jitubhai.com) that offer compo-
nents, as well as fully set-up PCs. If you pick up
in bulk, most suppliers will offer some form of
discount and either a preferential or an
enhanced after-sales service. A simple Google
search will net you results on web sites like
Indiamart. Remember, some people will have
no qualms about calling a spade a spade — in
this case, a second-hand PC. But the
euphemisms are aplenty — pre-owned, used,
refurbished are some examples. All these terms
can be quite confusing and certainly inter-
changeable. Although refurbished ideally
implies that the computers have been thor-
oughly serviced and faulty parts have been
replaced by the dealer. Most dealers do this any-
way, so even if the computer has been lying in a
dusty office basement, it’ll look like it’s in a
fairly decent condition. ■

siddharth.parwatay@thinkdigit.com

Second Hand PCs- Feb-09:Second Hand PCs- Feb-09.qxd  1/24/2009  3:49 AM  Page 90



Digital Leisure l Lead Feature

Siddharth Parwatay

Welcome to the immersive world of 
Alternate Reality Games (ARG) — a form 
of gaming that uses the real world as 

a platform, while involving multiple media and 
game elements, a powerful storyline that may be 
affected by participants’ ideas or actions, all the 
while relying on the internet as the central binding 
medium. ARG is where the line between games and 
reality starts to blur, mainly as a result of its pri-
mary mantra — TINAG (this is not a game). Reminds 
you of an obscure Michael Douglas movie called The 
Game? Precisely! 

Lead Feature

Alternate 
Reality Gaming

Ever wonder what it would be like to be a part of 
an adventure like Indiana Jones or a story right 
out of a Ludlum thriller? We all have, right? And 
so we play hundreds of RPGs and MMOs to expe-
rience a little bit of that thrill.  But what if you 
could really be a part of something like that — 
really a part of it?

Technology Beyond Work
Leisure
Digital

100 Developing in 
India

Mirror's 
Edge

Games coming 
in 2009 10494
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also come up with newer puzzles and sub-plots to 
keep the players engaged. They have to continually 
keep up with the combined intellect of the player 
community and in fact, be one step ahead — so 
no more linear game play. Still, if all this doesn’t 
excite you and you ask “hey so what, why should 
I play?” well then maybe you shouldn’t. Or maybe 
you’ll try to give it a shot if we tell you that ARGs 
are popular amongst female gamers. Sound inter-
esting now?

In any case, if you’re not the puzzle solving type, 
there is a way out for you too. Thousands of enthusi-
asts lurk around on the periphery to just follow the 
plot, and put in an occasional forum post. The great 
deal of community interaction might just facilitate 
meeting some interesting people.

ARG as a marketing and promotion tool 
Unlikely beneficiaries of ARGs are filmmakers, 
who find that promoting movies through this 
form of interactive entertainment really gets the 
buzz going. Steven Spielberg’s AI did it with The 
Beast, one of the first mass AIGs attracting over 2 
million active users. 

And it’s not just film and TV; even the music 
industry is taking to ARGs. Year Zero was an alter-
nate reality game based on the Nine Inch Nails 
concept album of the same name. The game was 
launched just before the album was scheduled 
to release. In response to criticism regarding 
this form of promotion for the album, Trent 
Reznor, frontman of the band, stated “The term 
“marketing” sure is a frustrating one for me 
at the moment. What you are now starting to 
experience is “year zero”. It’s not some kind of 
gimmick to get you to buy a record — it is the art 
form... and we’re just getting started. Hope you 
enjoy the ride.”

So are these ads and gimmicks intrusive? 
Not really. Most usually don’t even mention the 
product that they’re promoting. It’s actually 
a brilliant form of viral marketing as it gets a 
bunch of people to spend a lot of time exploring 
a world related to the product. Take the case of 
‘I Love Bees’, a huge promotion for Halo 2. Those 
that did play it knew that it was a promotion, 
but not once did it scream, “Please buy Halo 2!”. 
Instead of flooding the users with Halo 2 banner 
ads, they were immersed in the back-story of the 
Halo 2 universe. Players spent months before the 
game was released interacting with some really 
cool fictional characters. For example, the game 
presented players with 210 pairs of global posi-
tioning system coordinates and time codes, with 
no indications to what the locations referred to. 
Players eventually figured out the coordinates 
referred to pay phones and the times to when 
the phones would ring; one player in Florida 
stayed by a phone while Hurricane Frances was 
minutes away in order to recite answers to prere-
corded questions. Other phone calls were made 
by live persons known as “operators”; these calls 
allowed players to interact with the characters 

of the games in spontaneous and occasionally 
humorous ways.

And all the interaction between players made 
finding friends to team up with on Xbox Live really 
very easy. So sure, there is marketing, but it was 
really cool marketing that gave players something 
to talk about, something to enjoy.

ARG in India
Is there really a scope for ARGs in India? Does the 
average Indian gamer want thinking games, or is he 
more into the shoot-em-up, high definition type of 
entertainment?

Not really. IIM Indore’s online puzzle game 
Kluless got 12 Million hits a month. It was a series 
of levels, which required the player not only to 
think but be resourceful by googling stuff and 
thinking laterally. Although a precursor, it wasn’t 
an ARG in the true sense of the genre.

Perhaps India’s first real ARG was hosted 
as a part of Malhar, the all India college fest 
of St. Xavier’s college, Mumbai. Dubbed the 
“Richard Burns Project”, participants had just 
as much fun as the Puppet-masters who were 
pulling their strings! Players were immersed in 
a plot involving disappearance, espionage and 
semi-paranormal elements, thinly connected to 
actual events in Mumbai’s history like the 26/7 
floods and the World War II era dockyard blast. 
All the while players were actively solving web-
based, audio and visual puzzles to progress to 
the next stage. The final leg had them running 
all over south Mumbai in the wee hours of the 
morning in search of cryptic clues. But since 
it was part of the fest, it was not open to the 
general public. n

siddharth.parwatay@thinkdigit.com

While being part of an ARG, say you encounter 
a bomb which is steadily counting down in the 
back seat of a car you’ve gone to investigate. As it 
nears zero you begin to wonder, if only for a brief 
second, whether it’ll actually blow up or a flag will 
pop up saying “boom” – that’s how real an ARG 
can feel to its participants. Some of the nascent 
ARGs had participants just stumbling upon a web 
site, claiming certain anomalous events have taken 
place or are going to take place, and from then on, 
clues would send them on an online adventure 
trail. But instead of presenting a chronologically 
unified coherent narrative, the story would be 
discovered in scattered pieces across the Internet 
and other media, allowing players to reassemble 
it, supply connective tissue, and determine what 
it meant. In effect, the players would themselves 
not know whether they’re part of a game, a hoax, 
a prank or just some wild goose chase.

The one thing that ties all ARGs together is 
that you interact with the fictional world using 
things that you interact with on a daily basis in the 
real world. Also, you aren’t interacting as a char-
acter, as you would in most computer and video 
games. You also don’t need any special equipment, 
as you would with most console games. Most ARGs 
take advantage of computers and the internet (web 
sites and emails) as well as phones and even the 
occasional live event - finding something hidden 
in your city, gathering around payphones, or even 
live parties with character interaction!

The bulk of the game-play happens online in 
the form of solving puzzles, conducting research, 
and interacting with in-game characters and com-
munity members. But since it’s often a collabora-
tive effort, there is no need for all players to do all 
tasks, which is good since some of the puzzles and 
clues are insanely difficult, making even seasoned 
players pull out their hair. 

How did all of this begin? 
Well, if you really want to trace it back it prob-

ably has its roots in the early television show 
promotion campaigns which sent viewers on so 
called “Treasure Hunts”. Then there was the whole 
Beatles “Paul is dead” controversy where thou-
sands of people believed that Paul McCartney 
died in 1966 and was replaced by a look-alike and 
sound-alike. People went about trying to prove 
this by uncovering hints among the Beatles’ many 
recordings that alluded to this fact, such as state-
ments heard when a song is played backwards, 
symbolic interpretations of obscure lyrics, and 
ambiguous imagery on album covers.

But the true seminal work in ARG was The Beast, 
so called because an early asset list for the project 
contained 666 files. 

The Beast was set in the year 2142, fifty years 
after the events chronicled in AI. There were a few 
overlapping entry points to the game, or “rabbit 
holes”. First, some trailers and posters for AI had 
a credit for Jeanine Salla as Sentient Machine 
Therapist hidden among the credits for Spielberg 
and the actors. Second, one of the trailers had 
a telephone number concealed in the markings 
on the promotional text; if a player called this 
number and followed the given instructions he or 
she eventually received an email stating in part 
that “Jeanine is the key” and that “you’ve seen her 
name before.” 

Each rabbit hole led to questions about Jeanine 
Salla, especially since one would not expect a 
film made in 2001 to require the services of a 
robo-therapist! Googling Jeanine brought up sev-
eral web pages set in the fictional world of the 
game such as the homepage of Salla’s employer, 
Bangalore World University. Reading Salla’s bio 
page, the player encountered a link to the personal 
page of Salla’s granddaughter, Laia Salla, as well 
as Jeanine’s phone number. Following these clues 
leads the player to the homepage of Evan and 
Nancy Chan, family friends of the Sallas. Jeanine’s 
phone message revealed that Evan recently died in 
an alleged boating accident on his A.I.-enhanced 
boat, the Cloudmaker. But it is learned from sev-
eral sources that Evan was a superb swimmer.

At this point the player joins the investigation 
into Evan’s death. Over the course of the three 
months that The Beast went on, it incorporated 
thirty diverse in-game web sites, from the Anti-
Robot Militia to the Coalition for Robot Freedom; 
from an architectural magazine to a sleep clinic, 
and from the coroner’s office to a hat store. As 
the game progressed, the players came across 
additional mysteries, such as who is killing AI-
enhanced houses, the location of the sexbot with 
whom Evan had an affair, and malfunctions in the 
weather-control system. By the end of the twelve 
weeks, players had completely immersed them-
selves in the in-game action.

Why should I care?
Unlike other games, this type of game reacts to the 
players moves. The Puppet-masters (creators) often 
are forced to change the story line mid-game and 

Puppet-master - A Puppet-master is an individual 
involved in designing and/or running an ARG. Puppet-
masters are simultaneously allies and adversaries to 
the player base, creating obstacles and providing 
resources for overcoming them in the course of tell-
ing the game’s story. 
The Curtain - The curtain is generally a metaphor 
for the separation between the Puppet-masters 
and the players. Puppet-masters generally remain 
behind the curtain while a game is running. The real 
identity of Puppet-masters may or may not be known 
ahead of time.
Rabbithole - Also known as a Trailhead. A Rabbithole 
marks the first web site, contact, or puzzle that 
starts off the ARG.
Trailhead - A deliberate clue which enables a player 
to discover a way into the game. 

Jargon

www.argn.com
You can find the currently running ARGs by visiting 
ARG Network, the best basic resource for ARG news 
and events. You’ll see a list of the most popular (and 
confirmed!) games at the top of the page with links 
to the forums where it’s being discussed as well as 
any other important resources (such as the game 
chat room).

www.unfiction.com
The forums at unfiction (uf) will update you on the 
latest independent games.	

www.cloudmakers.org
Cloudmakers now serves as a clearinghouse for 
online gaming. Members can find out about new 
games, find fellow players, and reminisce about and 
discuss The Beast.

Besides, we suggest you keep your eyes open; you 
might just chance upon something somewhere, you 
never know

Where do I start?
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out war against the Covenant. So all you RTS lovers
who really didn’t understand the hype behind
Halo, should now set yourselves up to get hooked.
Halo Wars’ web site is www.halowars.com.

Tom Clancy’s Splinter Cell: Conviction
(Xbox 360, PC)
Conviction, is the fifth among the popular Splinter
Cell series. This game is being developed by Ubisoft
Montreal. The story takes place two years after the
events of Tom Clancy’s Splinter Cell: Double Agent.
Sam Fisher is forced out of hiding because of an
unspecified danger to his friend and co-worker,
Anna Grímsdóttir. Upon his return to Third
Echelon, he discovers that the organisation has
fallen into disarray due to overbearing bureau-
cracy and internal power struggles. Incensed by
the inability of Third Echelon to do what’s right,
Sam strikes out on his own. In Conviction, Sam’s
involvement with the terrorists in Double Agent has
made him a wanted man, forcing him to go incog-
nito. For those of you who haven’t played any of
the previous Splinter Cell games, Sam is a part of
a special black ops team under the NSA, code
named Third Echelon and Anna Grimsdóttir is the
technical operations manager in the same depart-
ment. The game offers a good mix of stealth game-
play (think Metal Gear Solid series, and action). This
particular outing of Sam promises to be as excit-
ing as the previous
installments with
its interesting infor-
mation gathering
gameplay, stealth,
and covert
missions. For more
information about
this game go to
http://splitercell.us.
ubi.com/conviction/.

Street Fighter IV
(Xbox 360, PS3, PC)
Street Fighter lovers rejoice! The game is back with
added features, characters and game styles. Gear
up for new moves and combos including four new
characters — Abel , Crimson Viper, Rufus and El
Fuerte. Of course there are boss and hidden char-

acters that these arcade
games always hold —
Gouken, Seth and Akuma.
Even though the characters
are being rendered in 3D,
the gameplay is not going to
change. Street Fighter IV is
retaining the arcade style of
six button combat. There are

two more attacks that have been added to this
game — Focus Attack and Ultra Combo. The game
is already released on arcades, but will have more
to offer for the home version, which will be
releasing shortly. Street Fighter’s web site is
www.streetfighter.com

BioShock 2: Sea of Dreams
(Xbox 360, PS3, PC)
What can we say about BioShock? Those of you who
have played the
g a m e ,
absolutely love
it. If you
haven’t played
it, well, you are
missing out on
an award-winning title. Now it’s time to play the
sequel of the game coming out in 2009 titled,
Bioshock 2: Sea of Dreams. Here’s the problem though
— not much has been revealed about the sequel. So
much so, that there is speculation that the game
may be a prequel instead of a sequel. A teaser for
the Sea of Drems is available on popular video sites
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2008 saw some great titles being released, but
that’s old news now. It’s the New Year — let’s
move on. Games give us something to look

forward to, when you get home from school,
college, or even work. Enough talk. Let’s jump into
a list of the games that we are looking forward to
this year. These games are in no particular order,
because we definitely want to play them all!

Lord of the Rings Conquest
(PC, PS3, Xbox 260, Nintendo DS)
The Lord of the Rings: Conquest is an upcoming video
game developed by Pandemic Studios and
published by Electronic Arts. It is based on The Lord
of the Rings trilogy, and borrows many gameplay
mechanics from Pandemic’s Star Wars: Battlefront
games. This game allows you to play both the
forces of good and evil, but unlike
The Lord of the Rings:
The Battle for Middle-
earth, the latter
option is based
around Sauron
stopping the One
Ring from being
destroyed and
fighting back. All
sounds good on

Most

paper, especially as it offers a choice of a side to
pick in the epic war for the Rings, so let’s wait and
hope for the best. Go to www.pandemicstudios.com/
conquest/ to find out more about this game.

Halo Wars
(Xbox 360)
Halo is an all time favourite FPS game that has you
playing as the spartan warrior Master Chief, of the
UNSC. You have to battle the Covenant forces and
achieve victory. Halo Wars has not been created by
Bungie, but is instead more of an off-shoot of the
Halo franchise, and is created by Ensemble Studios.
The game offers a different perspective to the
world and wars of Halo. As an RTS game, you get to
control large armies and shrewdly direct them in
realistic warfare. Halo Wars is set during the
UNSC’s first deadly encounters with the Covenant,
allowing players to lead the crew of the UNSC’s
“Spirit of Fire” — from initial skirmishes to an all
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increased AI. And of course, this game introduces
an element of co-operative multiplayer—you can
either play locally over a split-screen, or remotely
with your friends. Head to www.residentevil.com
where you can find out more about this game.

Prototype
(Xbox 360, PS3, PC)
Here’s a rather challenging
game for everybody. Prototype
is a sandbox-style action game,
which basically means you
don’t have to follow a single
patch to reach your objective.
You have the freedom to choose the way you want
to play the game. Of course this freedom isn’t
without limit; you will have to follow the basic
story outline which goes like this: You play Alex, a
mutant shape-shifted with superhuman abilities
of strength, speed, agility, durability and healing.
You are also empowered with the abilities to
consuming fallen enemies... a bit creepy, that. As
we mentioned earlier, Alex can shapesift and take
on the guise of those he has consumed... getting
creepier... Alex, of course, has lost his memory and
is set out to regain it. He would also need to find
his sister to get the answers he is looking for. The
game throws two types of enemies at you: one is a
set of humans that have been infected with a virus
causing them to mutate, and the other are the
special squad of soldiers sent out to kill the afore-
mentioned mutants. The most interesting aspect is
the shape-shifting ability, a new concept as a mean
of destruction. We do hope that the gameplay is
not overly complicated due to this mechanic.
Radical (the developers behind this titles) claim
that there are 750 different combinations that can
be used through this power, so we hope they don’t
disappoint us. Head to www.prototypegame.com to
learn more about the game.

inFAMOUS
(PS3)
You play a college dropout named Cole, who is a
bicycle messenger. One day Cole delivers a package
which for some strange reason, causes a massive
electromagnetic explosion that kills everybody in
a six-block radius, except Cole. Cole is not the same
after the explosion and now has super powers (he
can control electricity) and is out for revenge, or
more likely, an answer. While the setup sounds a
bit overdone (remember the big green guy), the
core gameplay seems interesting. Oh and did we
mention that prior to the life-changing explosion
Cole was athletic and knew parkour? Parkour, or
free-running is getting quite
common in the gaming world,
with more and more games being
created with parkour as the core
concept. Another thing to watch
out for is the sandbox style of
gameplay offered by inFAMOUS

where you can choose to be either friendly by help-
ing out people in distrees, or just ignore them and
do your own thing. Through its great graphic and
cool powers, we hope that this new-age super hero
game will be a win. Visit http://www.suckerpunch.
com/detail.php/games/infamous for more about
this game.

Halo 3: ODST
(Xbox 360)
Formerly known as Halo 3: Recon, ODST is an expan-
sion of Halo 3, created by Bungie. The gameplay is
similar to the Halo trilogy but in this expansion
you do not play as Master Chief, but rather a lone
UNSC soldier in the city of New Mombasa, Kenya.
You play a soldier of the Orbital Drop Shock
Troopers (ODST) whose main objective is to find
out what happened to his missing squad members.

Since an ODST does not possess Master
Chief’s superhuman abilities and
armor, he is more vulnerable to
weapons fire, making for a more
cautious and tactful gameplay. But
don’t get the wrong idea—ODST is not
focused on stealth gameplay, however,
some elements of stealth will be incor-
porated. To learn more about Halo 3:
ODST head over to this web site
www.bungie.net.

StarCraft II
(PC, Mac OS X)
StarCraft II continues its epic saga where StarCraft:
Brood War left off. StarCraft II will present a cast of

new heroes and familiar faces
in an edgy sci-fi story filled
with adventure and intrigue.
Protoss, Terran and Zerg, the
three races in the game will
be battling it out once again,
only this time there will be
new units, new abilities and
new maps. StarCraft has
always been one of the fastest
RTS games around and be

assured that this sequel will continue that aspect.
This game caters to the veterans who love StarCraft
and also to those who are new to the RTS genre.
Blizzard will once again offer online play through
Battle.net their online service, which is expected
to offer new features to accomodate StarCraft II.
Learn more about Starcraft II by visiting this web
site: www.starcraft2.com.

Star Wars: The Old Repuplic
(PC)
This game is likely to attract a varied bunch of
people: from gamers, to geeks, to Star Wars freaks.
Firstly, the MMORPG world will want to get their
hands on this massively multiplayer title. Then
there will be those who have played and enjoyed
either of the two Knights of the Old Republic games,
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such as YouTube and Gametrailers. Well, whatever
the nature of the game, it is definitely another
gem to look out for.

F.E.A.R. 2: Project Origin
(Xbox 360, PS3, PC)
The nightmare has returned, Alma Wade is back.
The sequel to F.E.A.R. continues the supernatural
suspense story of Alma, a powerful psychic who
rages against those who wronged her. This triggers
an escalating paranormal crisis in her person, that
threatens to devour and replace the reality as we
know it, with her own. Her story is
told in F.E.A.R. through various means
such as sequenced flashbacks, snip-
pets of CCTV footage, and other
evidence found playing the game. In
Project Origin, you will encounter
Alma, we assume, in a similar way
they did in the first game — through
exploration of a city that was annihi-
lated by the cataclysmic explosion of
the previous game. This time you will
not be playing as the Point Man, but
will instead play a special forces oper-
ator called Michael Becket, whose
squad is sent in to arrest Genevieve
Aristide, based on the evidence gathered against
her by the Point Man in F.E.A.R. All of this will be
occuring 30 minutes prior to the ending of F.E.A.R.
The game’s teaser throws some great fight
sequences and some chilling moments. We can’t
wait. Visit http://projectorigin.warnerbros.com to
learn more about this game. This just in: at the time
of writing this, Project Origin’s demo has been released
on the PC and console platforms. So what are you wait-
ing for, go grab it!

Diablo III
(PC, Mac OS X)
Diablo III is another sequel to a very popular RPG
series from Blizzard. The game offers a new story-
line and of course, awesome graphics. Diablo III
takes place in Sanctuary, the dark fantasy world of
the Diablo series. For those of you who played
Diablo II, the world was saved by a handful of
unnamed heroes. The story goes like this: the
warriors that survived the onslaught of the armies
of the Burning Hells have gone mad from their
ordeals, and it is up to a new generation of heroes
to face the forces of evil threatening the world of
Sanctuary. Players will also have the opportunity
to explore familiar settings such
as Tristram. The three classes
which have been revealed so far
are the Barbarian, the Wizard
and the Witch Doctor. The
Barbarian is the one class that
has been preserved from Diablo
II. A scary fact about the Wizard
has been mentioned as on the
Diablo III website: “Imagine, a

headstrong nineteen-year-old youth, able to warp
time itself to her will!” Yeah, haven’t heard that
one before... Jokes apart, this sequel will give you
the chance to customize your character as per
gender, something thatwas previously not possi-
ble. Looking at the game trailers, this game looks
to be another great hit from the Blizzard stables,
and we are eagerly awaiting its release. You can
learn more about the game at www.diablo3.com.

God Of War 3
(PS3)
Not much is known
about the third and
the final part of the
God of War trilogy,
but it will defi-
nitely be as excit-
ing and as much
fun as the previous
two. The specula-
tions we have for
this game include
new and more
awesome weapons
that kill and rend in even cooler ways. Can there
ever be enough blood splatter? Surely not. The
previous titles did a great job as action games, but
we want more. We would especially like to see
more of the Kratos character buildup — here’s a
person who can stand up to the very Gods, some-
one without fear... we love that aspect of his char-
acter and can’t wait to see how the developers
improve upon him. The story arc of the game so far
is brilliant and going strong, we would definitely
want to know more. There has also been specula-
tion that God of War III will offer online gameplay,
definitely something to look forward to... The God
of War III website is http://www.us.playstation.com/
PS3/ Games/God_of_War_III/

Resident Evil 5
(PS3, Xbox 360)

Another sequel to another great fran-
chise; but this game is also a movie
series. Resident Evil 5 continues in the
same vein as its immediate successor.
The game is similar to Resident Evil 4
with the same ‘over the shoulder’
camera view. Instead of controlling the
character of Leon, as done in the fourth
game, you get to control Chris Redfield.
While RE:5 adds new weapons, it still

retains the classic handguns and shotguns.
Lighting plays an important part in this outing,
with dark and bright environments offering dras-
tically different styles of gameplay. For example: as
Chris moves from a dark area to a brightly-lit area,
the dilation of his pupils will cause you to see
extended black instead of a direct readjustment of
the environment around you. More human like
behaviour has also been given to the enemies with
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and finally anybody and every-
body who ever liked Star Wars
would, and must, defeinitely
try this game. Of course this
game has also recieved a lot of
criticism—there are those who
do not want their single-player-
only favourite to be converted
into an MMO, others say that
this game will not do well with
the prevailing market condi-
tion as the MMO market is currently dominated by
World of Warcraft. Warranted, or unwarranted criti-
cisms aside, this game will definitely be a delight
as it can be considered a step up from the tradi-
tional setup of Mages, Wizards, Nights, Elves and
Orcs, which is so common that it has begun to get
boring to some extent. www.swtor.com is where you
need to head if you’re interested to learn more
about this game.

BattleForge
(PC)
Okay, this game is just
amazing. It’s so good it
actually can’t be classi-
fied, but let’s try to do it
anyway. This game can
only be played online, so
let’s start off by saying
that it’s an online game.
But since many people
can play it simultae-
nously, it’s an MMO. It has PvP and PvE elements to
it which would then make it somewhat of an
MMORPG. Here’s the catch though: you don’t sit
and control a single character, but an army—which
makes it an RTS, so it’s an online RTS, or an
MMORTS, if you have been keeping tabs. You build
and control your own army and complete missions
in co-op, or fight against one another to improve
your own skills. Another innovation presented
through the game is that the way you build your
army is through a card-based system. You can
choose to build your army based on multiple
elemental types. Building units and killing creeps
and enemies will definitely need co-operation with
your fellow players and also macro-management of
your own army making this a very interesting
game to play. Keep up with the news about this
game at www.battleforge.com.

Fallen Earth
(PC)
The bar for MMORPGs have
been raised in 2008 with
the release of games like
Age of Conan, which takes
gameplay and graphics to a
new level, and through the
release of expansions for
games such as Eve Online

and World of Warcraft. MMORPGs are a unique genre
of games and call for dedicated gamers (some
might say obsessive to a fault) to play them. Hence,
the new games that are coming out need to avoid
the treaded path and break out with something
new. Well, we have found a really great game that
promises to offer just that. The game is called Fallen
Earth and the storyline actually seems half-plausi-
ble: There is a virus that has spread and destroyed
most of the Earth’s population and has mutated
through different stages. The virus was created
somewhere in South Asia and when it came in
touch with Pakistan, they immediately thought the
virus had origins in India; Pakistan then attacks
and through the attack starts the virus to spread
further. The virus, called the Shiva virus, then
mutates to different stages. Players can choose one
of many professions offered in this game, with
classes such as engineers, enforcers, travellers, and
so on, each of which with their respective factions.
This game offers a completely new story, a fresh
setting, new professions, and hopefully, new game
play. It is definitely one the MMORPG enthusiasts
should wait for. Learn more about Fallen Earth on its
official web site: www.fallenearth.com.

Killzone 2
(PS3)
Killzone is a sci-fi FPS game which follows the story-
line of Killzone: Liberation (for the PlayStation
Portable) and is the third game in this franchise
following the original’s release on the PlayStation
2 console. The story of Killzone 2 is quite straight
forward: two years after the Vekta attack by the

Helghast, the
I n t e r p l a n e t a r y
Strategic Alliance
(ISA) is taking the
fight back to the
enemy’s home world
of Helhgan. You play
as Sev, a hardcore
battle-monger who is
sent to capture the
Helghast Leader,
Emperor Visari, and
bring their war

machine to a halt. Killzone 2 aims to provide play-
ers with a realistic gameplay, dubbed “Hollywood
Realism” by the developers. There is also a new
cover system called “lean and peek” which will be
a great addition to this game. Visit www.kill-
zone.com for more information about the game.

Warhammer 40,000: Dawn of War II
(PC)
The Dawn of War II sequel in the Warhammer 40,000
universe is also an RTS which differs from its prede-
cessors. The campaign mode allows for a pick-up and
play experience by allowing you to select your army,
the mission and diving straight into the action. It
does away with the ‘distraction’ of base-building and

the boredom of micro-manag-
ing resources. This game will
thus offer a new style of RTS
by moving away from the
traditional building aspect as
it focuses more on the front-
line combat. The campaign
can be accomplished in single
player as well as in co-op
mode. Head over to www.dawnofwar2.com for more
details about the game.

Tekken 6
(Xbox360, PS3)
Tekken 6 will be the first
game based on the
System 257 arcade board
to be launched on the
PlayStation 3. It is the
latest in the Tekken series
and will retain all the
elements from Tekken 5 and Tekken 5: The Dark
Ressurection. This installment will also have an
online mode which will be great fun. You can now
challenge your arch-nemesis to a game without
him actually being in your house using your
console. New ‘item’ moves have also been imple-
mented where characters use special items to
attack the opponent. Also Namco has added a new
‘Rage’ system where on using Rage, your attack
increases by huge amounts to the cost of your
health reducing. There are a total of 42 characters
which essentially means all the characters from
Tekken 5: The Dark Ressurection are present with an
addition of new characters. Out of the new char-
acters, six have been confirmed: Zafina, Leo,
Miguel Caballero Rojo, Bob, Azazel (the final Boss
of the game) and NANCY-MI847J. For more infor-
mation check out http://tekken.namco.com.

Ghostbusters
(PS3, PS2, Xbox360, Nintendo Wii & DS, PC)
When there’s something strange in the neigh-
bourhood, who ya gonna call....Ghostbusters! You
heard the call right, Ghostbusters the game is
going to be released sometime in 2009, and will
be a continuation of the movie franchise. The
game picks up two years after the events in
Ghostbusters II. You play a new recruit who has
been hired to test some equipment created by
Egon Spengler and Ray Stantz because the para-
normal activity has increased in the city. This
activity is actually being
caused due to the release
of a Gozer exhibit. The
storyline doesn’t seem as
interesting as it is very
similar to that of the
actual movie, but the fun
part will definitely be in
playing through the
story. Also look forward

to is how the gameplay will actually work in this
game. Gameplay involves a third-person perspec-
tive on the HD consoles, similar to Gears of War.
The Nintendo Wii version will offer a cell-shaded
graphical appeal and will be played in the third-
person with the Wii Remote acting as the
Ghostbusters’ gun.

The Chronicles of
Riddick: Assault
on Dark Athena
(Xbox360, PS3, PC)
This science fiction
FPS was originally
anticipated to be a
remake of The
Chronicles of Riddick:
Escape from Butcher Bay,
but it has grown to such an extent that it now
being considered a sequel. There isn’t much infor-
mation on this game, but from what we have seen
it looks spectacular. Vin Diesel did an amazing job
in the movie franchise and he has been portrayed
brilliantly in the game as well, even his voice has
been used. This game is expected to have great
graphics and an advanced AI and also a multi-
player mode. We hope that this sequel does deliver
all that it has promised. More can be found out at
www.riddickgame.com.

Dragon Age: Origins
(PC, PS3, Xbox360)
Dragon Age is an RPG being developed by
BioWare; forged using a new game engine called

Eclipse. The reason why
this game is sub-titled
‘Origins’ is because the
game encorporates an
origins story for each
race and some classes. An
origin story will deter-
mine the background of
the main character prior
to the main storyline.
Which means, a Dwarf

Noble will begin the game as part of the royal
family in one of the Dwarven cities, and a Dwarf
Commoner will begin on the streets of the city.
This will give you many hours of gameplay and
these characters will reappear throughout the
game. The game is described as being a ‘dark
heroic fantasy’ story which will be portrayed on
an epic scale with mature themes. Players start
the game through one of the six Origin stories
and will be playing that character’s point of view.
On choosing the Origin, the game determines the
appropritae behaviour of the NPCs and their
consequent reactions with the player. With
BioWare at helm, this game ought to have an
interesting story. More information can be found
at http://dragonage.bioware.com.

kumar.j@thinkdigit.com
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know that Indian game companies have con-
tributed to games like Microsoft’s Forza motor-
sport, EA’s Battlefield Modern Combat, Atari’s
Asterix and Obelix XXL2, Project Gotham Racing 4,
Colin McRae Dirt, Guitar Hero and many more. So
where does India stand with all of this?

Some companies prefer to stick to a more
traditional approach of gaming, where in peo-
ple play games for leisure. Such games are
called casual games and one such company
present in India is Zapak. If you visit their web-
site (www.zapak.com) you will find a huge list of
games to choose from and these are mostly all
browser-based games with a multiplayer
aspect to them. Zapak has also won awards for
their games including the UN Award for
Excellence in Creativity for their game Laadli
and when asked about how long it took to cre-
ate the game, they claim, “It took more than
45 days to create Laadli and it cost us about Rs.
1.5 Lakhs.” Talking about creating their
games, “We have in-house developers and we
also outsource our projects.” Zapak has games
which is meant for the Indian audience but
Mr Saagar says that they have recently even
started Zapak World which is meant for the
world audience also. That’s a really good step
in India to create such a base. The platforms
Zapak uses to create their games are Flash,
Macromedia and Unity.

Recently FX Labs released the game
Ghajini, which is based on the movie with
the same title, with elements of the movie
present in the game itself. We spoke with Mr.
Sashi Reddi, Founder & CEO — FXLabs
Studios, and asked him about the status of
Game Development in India and he said,
“We, at FXLabs, believe that the gaming mar-
ket in India while still in its infancy is ripe
for growth. As a company, we are betting that
the market for top notch games based on rec-
ognizable Bollywood properties is the clear
path to success. We are confident that con-
sumers will perceive a high level of value in
the products that we make, and it should
serve to cement FXLabs in their minds as the
premiere developer of games for the Indian
market. FXLabs is making a significant
investment in this particular market oppor-
tunity.” Talking about Ghajini, we asked him
how long it took them to make the game and
also about the workforce that was used, he
replied, “We take about 9-12 months to pro-
duce a game like Ghajini from Concept,
Design to Implementation. The Ghajini game
was completely built out of our own studios
in Hyderabad. The main production team for
Ghajini game consisted of about 30 people
which included programmers, artists and
testers.” On asking him about the game
Ghajini and the technology involved he said,

“We have adopted the latest DirectX tech-
nologies for Graphics in our games. For
Ghajini we wrote a lot of good Shaders, but
we had to pull them out of the game to main-
tain compliance with lower configuration
graphics cards that are prevalent in India.
Our survey of Indian hardware market made
us aware that the masses don’t have advanced
3D graphics cards and if we were to reach the
mass audience we had to lower our specifica-
tion for Graphics card requirement to most
widely available Intel Integrated Graphics
Chipset(G965). We had to optimize our
Engine to run on low end graphics cards,
while not compromising on game play.
DirectX 10 and advanced graphics is available
to the Indian audience today with the current
generation AAA games, but the masses who
don’t have a 3D accelerated graphics card
would have to wait for about a year to be able
to play the current generation games.”

We also spoke with Mr. Anthony Whitaker,
the Technical Director of RZ2 Games, and asked
him how long and also about the costs involved
in creating a big budget game and he said, “It
takes anywhere between two to five years to
create a big budget title and can cost anything
upto even $13 million.” When asked about
what games have been created specifically for
the Indian audience, he said, “We have mobile
games like Jalsa and Ashta Chamma which are
games based on the movies with the same
name.” We also asked if RZ2 Games was doing
anything in relation to DX10 and Anthony
replied, “We are not looking at DX10 games for
India as that requires Windows Vista and a
more powerful machine. Also, it does not have
a large enough spread or even market share.
We use technologies upto DX 9 and also create
flash games. We create games for PC, PS2,
Nintendo DS and even the iPhone.” We also
asked about other Indian companies approach-
ing them for projects to which he replied,
“Other companies like Zapak and FX Labs has
approached us. Most of our development is in-
house only though.” He also spoke about RZ2
Games creating an MMOFPS, but couldn’t
reveal any information on that topic.

Dhruva Interactive is one of India’s oldest
Game Developers. When we Mr. K Rakesh Rao,
CEO, about how long and how much the Game
Development industry has improved, he
replied, “Yes 12 years is a long time indeed!
While the it was really slow for the first 5 to 6
years, things started picking up around 2003,
with the emerging mobile games market, and
the developer community has grown at a fast
clip in the last couple of years. The consumer
market is finally growing, thanks to the high
decibel marketing and promotion by portals,
console owners such as Microsoft and Sony,

Upcoming titles
from the Indian
Developers:
Dhruva
Interactive:
Conga Bugs, a
casual PC game.
FXLabs Studios:
Inferno - A game
based on
Dante’s Inferno.
RZ2 Games: A
secret MMOFPS
is in develop-
ment.
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Gaming is a great form of recreation and
is now even becoming a profession for
some. But has anybody wondered what

makes these games great and who is responsi-
ble for that? The credit goes to the game devel-
opers. A game developer is basically a software
developer who develops video games. There are
many platforms for games — these days, you
have PC games and console games. These are
further sub-categorised. PC games include sin-
gle-player games and online games, while con-
sole games have a wider range from Sony’s
Playstation series including the PSP,
Microsoft’s gaming console Xbox and Xbox 360
and even Nintedo’s Wii and DS. First thing a
developer needs is to narrow down on what he
/ she needs to specialise in.

A game cannot be made over night — it
needs great thought, planning and execution
before it can be made available to others. With
this comes the need for an efficient workforce
to back it all up. Typically, a game develop-
ment team consists of programmers, game
designers, artists and the management. India
has an abundance when it comes to program-
mers in the IT sector. Designers, artists, sound
engineers, producers and testers are the ones
that are mostly outsourced by companies
when needed. But before you even think about
getting into this field, you need to have the
passion and creativity for games and what
really goes on behind the scene. When it
comes to programming, you need to be profi-
cient with C/C++, have knowledge in 2D vector
math, 3D math, knowledge of Direct X and
Open GL. And yes, before all this, you need to
have a BE / BTech degree. You can’t expect to
approach a game developer by saying you have
an idea for a game. If you want to be a game
designer who works on levels and artwork, you
need to know Adobe Photoshop, CorelDraw,
3ds Max, Maya and other such 3D animation
software. Again remember, creativity must
come from within. If you do not want to join
the corporate world and want to stay inde-
pendent, you really need to prove yourself and
must have extensive knowledge in the above
mentioned. In fact, to even approach a game

developer, you need to have the proper paper
work including a game design document
(GDD) which could be anywhere between 2 to
200 pages a level. Just imagine the sizes of
GDDs for MMORPGs, the amount of work
going into each dungeon and level.

The game development industry is estimat-
ed to reach $65 billion by 2011 in the US. In
India itself, NASSCOM says, it’s expected to
value at $212 million. But the question here is,
when will India reach that level and are the
companies here moving at the same pace as
those in the US? Companies need to provide,
not only to the Indian market, but possibly
even a much wider user base, when it comes to
game development. There are several compa-
nies in India that have begun to tap this Gold
Mine. Outsourcing or off shoring has become
an integral aspect in the production of most
international game titles. Game development
studios across the world are looking to out-
source visual art elements such as game char-
acters, vehicles, racing tracks, sports arenas
and various game environments for games
that are being developed. Many Game compa-
nies in India cater to this need and are con-
tributing to some amazing upcoming games.
All of this may sound great though it doesn’t
come easy. Aspiring Game studios need to
match high quality expectations to be able to
deliver on such international projects. Did you

Game developers
in India

When it comes
to India, there is
definitely a
shortage, as
most opt for an
MBA or are not
even aware of
game develop-
ments as a
career option



102 DIGIT FEBRUARY 2009

Digital Leisure l Feature Digital Leisure l Feature

and mobile companies for whom gaming is
now an important revenue stream. The devel-
oper community is evolving and gaining matu-
rity, many companies are still young, they have
much to learn and it will take time to hit inter-
national quality benchmarks. Dhruva was
lucky to have international exposure right
from the beginning. We are working with six of
the top ten publishers and have contributed to
the development of over 30 AAA blockbuster
console & PC games.” About the technology
that Dhruva uses in games, he said, “We usual-
ly use a DX version between DX7 and DX9 for
our target spec, because the mass market con-
sumer in India is primarily using fairly low-end
systems and a version of Windows between 98
and XP.” We also asked about the games they
create, whether it is for the Indian audience or
the Global audience and he said, “We keep
both markets in mind when developing games,
but our primary source of revenue has come
from the international markets.”

When it comes to education, there is defi-
nitely a limitation in India with most stu-
dents looking for an MBA or not even know-
ing that the option for Game Programming or
Game Designing exist after their degrees in
engineering. We got in touch with Divij
Durvey from Mumbai, who is now studying a
Game Programming and Designing related
course at Pace University in New York and had
this to say, “I have always been a gamer and
since I was studying engineering I wanted to
pursue it further. When I spoke about my
plans to my professors at college, they really
didn’t have any advice for me, which lead me
to look for a course abroad.” SAGE, the School
of Advanced Graphics and Engineering, is an

institute where they teach you games pro-
gramming. SAGE is run by Mr. Priyadarshi
Chowdhary, who is the Founder and CEO. We
asked him about the courses offered at SAGE
and he replied, “We teach only Games
Programming and we also have an advanced
course where we teach students how to create
their own Game Engines. We normally teach
students on the OGRE engine.” On their web
site, www.sageinfolabs.com, it is mentioned
that SAGE has also started a course that teach-
es console game programming for the Xbox
360. Mr. Priyadarshi says, “We have started
the course for console game programming,
but people prefer to enroll for PC game pro-
gramming.” About getting a job in this line
he said, “There is a lot of scope and we also
have a placement program.” Mr. Anthony
Withaker of RZ2 Games said, “We hold many
workshops, sponsorship programs and events
for colleges like IIT. We have an internship
program going on where we currently have
three students with us also.” Mr. Sashi Reddi
of FXLabs Studios said, “ One of our main aim
is to nurture budding talent around this
industry. We have been running FX –
Learning Academy, where in we get freshers
on board and give them immense training
around game programming and Art side
before starting their actual work with us.”

Here is some advice Mr. Sashi Reddi has
given to young adults who wish to pursue a
career in this field, “For students who want to
get into gaming it is important to understand
what is it that they aspire to do in this field. If
they are interested in programming games,
they should learn programming languages
like C, C++ and be strong at Maths and Physics.
For people who would like to animate charac-
ters or make assets for games like vehicles,
buildings, etc they should learn 3D editing
software like 3Dmax and Maya. Students who
are interested in designing a game should play
a lot of games, understand the different gen-
res of games, posses good analytical skills and
be very creative at coming up with ideas for
games that would keep people engaged. Best
way to start a career in game design is to start
writing reviews and walkthroughs for the
games you are currently playing.”

We definitely know that this industry is
going to grow stronger but currently it is
moving at a slow pace as in comparison to
other countries and from the looks of it
India’s Game Developers are catering more
towards the casuals games meant for the
Indian audience. We still have hope that the
day will come when India will be the hub for
all Game Development with host to all types
of gamers.�

kumar.j@thinkdigit.comThe SAGE studios, where young minds of the country learn Game Programming.

Students who
are interested in
designing a
game should
play a lot of
games, under-
stand the differ-
ent genres of
games, posses
good analytical
skills and be
very creative at
coming up with
ideas for games
that would keep
people engaged.
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you see men with guns, you run. Some
of them are marked in red, so you can
knock them out and use their
weapons. More often than not, you will
not carry the weapons as they slow you
down. When you slip, fall and die, the
screen shakes, goes black and white for
just a second, and then blanks out.
Some primal trigger in your brain
makes you anticipate your death,
seconds before it happens, and we
wonder what kind of research the
developers did to come up with this
stuff. When you have to roll after a
long jump, you can see your body
rolling, and for a second you are actu-
ally disoriented and confused. When
you fall and get hurt, you actually
freeze for a second — just enough to
recover, and just enough to make you

appreciate how real the game feels.
The story makes you follow a trail

of contacts, betrayers, and bodies inch-
ing onwards to answer questions you
didn’t know you had. So when some-
one on screen starts running away
from you, using the same techniques
you do, follow them with all your
heart. But when animated cut-scenes
reveals scene-after-scene of needless
complications and conditions, you
don’t have the heart to take it all in,
and find it a serious distraction from
the game itself. Despite the very pretty
vector animation, we could not resist
the urge to skip the cut-scenes and
return to the meat of the game.

There are moments of very intense
action in the game. Snipers, for exam-
ple, have these shafts of red light
directed towards you, and you have to
neutralise them before they find you.
You are looking through the scope at
two snipers, who in turn are looking
through their scope, at you. You have
to take them out before their laser
sights seek you out. Another aspect are
the spatial puzzles in the game. You
will be forced to think out of the box,
look around and really think before

you can progress through a level. This
aspect of the game reminds us of
Portal.

Successive levels of the game make
you move in increasingly complicated
and innovative ways. The levels also
become tougher, with the jumps
getting wider, or higher. Timing, and
precision are required here. You have

to be very careful about when and how
you use your moves. Sometimes it is
preferable to fall and get hurt, because
rolling might make you fall to death. It
makes you feel as if the skills of your
character are developing as you play
the game.

However, one disappointing aspect
is that you never really find out all the
ways to neutralise the enemy. The
demos shown during game load depict

complicated maneuvers, all of which
you don’t end up trying out because
there is just not enough opportunity
for it — or so you think. During the
later levels, however, the game gets
boring. The focus shifts to neutralising
enemies, and an unrealistic number of
them, at that. Repeated restarts to get
the jump, roll and wall run right will
keep you focused, but repeated restarts
just to get away from a gunman you
are not allowed to neutralise makes for
an irritating experience. At the rare
instance that you need to use the gun,
you have to be dead accurate because
the guns usually have very little
ammo. But since gun-combat is rare,
you find that you don’t have enough
practice to get it right and you’ll often
need to repeat such sections. At this

point, the bugs also get to you — jump
onto a ledge with your hands on either
side of piping, and you cannot move
left or right. You cannot even jump off,
or climb up. You get stuck for no fault
of your own. Sometimes, your feet get
stuck inside the floor, disabling any
kind of movement.

The graphics are great. The envi-
ronment has a cyberpunk feel, with
bright, vibrant and effervescent
colours used. The entire city feels like
it’s bathed in light, even the sewers
have a halo. This is a very good looking
game. The soundtrack is mostly ambi-
ent loops, with the tone changing with
the mood and pace of a level. It lends a
sense of urgency when you have to
move fast, and encourages logic when
you need to solve a spatial puzzle.

This is a great game, and some-
thing that will go down in gaming
history as something truly special — as
Portal did before. However, the game
play is far from mature, and we just
hope to see more such titles around. At
least, a lot of first person games can
take cues from the creativity that flows
through this game. �

aditya.madanapalle@thinkdigit.com
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Aditya Madanapalle

We have been tracking this
game for a while now. From
the trailers and game play

videos we looked at before the game
was released, it promised to be a
different and innovative idea for a
first person adventure game. The
game released on consoles before it
did for Windows, and we could not
wait to get our hands on it. Those of us
who did try out the game on consoles
were enthralled.

When you start the game, the first
level is a tutorial that outlines the
gamut of moves that your player can
perform. Look down, and you see the
torso and limbs of your player, some-
thing unique for the first person
point-of-view games, which usually
contain phantom bodies and legs.
Unlike other games, the tutorial is a
very necessary step in playing the
game. The first level takes your breath
away. You are made to jump over
fences, slide beneath pipes, jump
across large gaps, roll when you fall

and learn to take away weapons from
enemies you might encounter. A
whole range of acrobatic actions can
be performed through minimal keys.

To even begin talking about the
very impressive gameplay, you have to
talk about the not-so-interesting story.
You are what the game calls a
“runner”. A runner is a messenger
that takes dangerous paths across the
city to deliver messages. This is
because the world (or at least this city)
is under a totalitarian regime, where
the government has put all forms of
communication under strict surveil-
lance. This serves to neutralise crime
and rebels. This is where the runners
come in, with their alternate medium
of communication. The second intro-
ductory level fleshes out the story for
the player and you see your charac-
ter’s (Faith) sister (some police officer)
getting framed for murder. She barely
has time to talk to you, when the
police burst in with guns a-blazing.
Fight is not a choice here, you are a
runner, and you can only run. So run
you do, through a complicated office
floor, into the vents, onto a terrace,
sliding down a ramp, and so on —
escaping bullets, instead of killing the
attackers with your own. It’s a refresh-

ing take on the platforming genre.
Your path forward is made known
through what is called “runner
vision”, which turns objects of inter-
est in the environment red, indicat-
ing that you need to make your way
towards them. At the end of the first
level, you find yourself on a terrace.
Just as a helicopter comes into view,
its landing skids blazing red with
runner vision. The police are firing at
you, and you hardly have time to
think. And like some cornered
animal, you instinctly jump to hold
on to the skids of the helicopter.
Impressive stuff, this.

There are spectacular props in
almost every level of the game. Over
the next few levels, you will dodge
bullets in sewers, jump between pipes,
climb on crates and cranes, learn that
some fences are electrified, navigate
through vents, spend some time in
elevators, and even take on a few
enemies by neutralising them with
your movements. The gamers have
taken the pains to make the experi-
ence very immersive. Not only is your
entire body visible, there are a lot of
small touches. Your heartbeat
increases when the game picks up
speed. The movement of the camera is
tracked to the movement of your head.
You can fail spectacularly, or slip and
fall. You can feel your weight, and the
momentum, just by looking at the way
the camera moves on screen. When

... and “neutralise” some enemies

...fall and die sometimes...

You get to dangle from a helicopter...

...steal some guns... ...slide down ramps...

Score : 6.5/10
Developer: DICE
Publisher: EA
Platforms supported: X-box 360,
Microsoft Windows, Sony Play Station 3
Web site: www.mirrorsedge.com
Price : Rs. 2,750
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In terms of game modes, you have an Arcade
Mode, a flimsy story mode that essentially entails
you running through the entire roster one after
another. This mode can be played against the CPU
and a second human player can jump in at any
time. You can also invite friends over Xbox LIVE
and PSN and compete with them. You also have
two one-on-one modes; one for offline, and one for
online. Unfortunately, we were unable to test out
the game’s online capabilities so early before the
game’s release. If you’re new to the series or feel-
ing a little rusty, the Training Mode will let you
hone your skills and practice your combos against
either a dummy or a skilled AI opponent.

There’s not that much to be done in Street
Fighter IV, but then again, beat ‘em ups are all
about one-on-one battles with your friends and
button mashing duels till your fingers bleed, and
there is plenty of potential for all of that here. As
you play along, you will also unlock artwork and
videos which can be viewed via the Gallery in the
main menu. Then of course, you have the cheesy
one-liners, over-the-top voice acting, and music
that will make you look forward to an NSync
reunion; but that’s the fun of it.

Bringing an old classic to a next-generation
format is a tricky situation for developers. They’re
expected to stay true to the series’ roots, and yet
push the boundaries and make use of the powerful
hardware at their disposal. Capcom have managed
to tread this fine line tremendously well. The new
arty visual style is breathtakingly realised in vivid
high definition, while the tight gameplay mechan-
ics, the classic characters, and traditional 2D
camera perspective will surely satisfy fans of the
older games. While there’s nothing truly revolu-

Digital Leisure l Game On

Sameer Desai

Many of the classic video game franchises
that have kept gamers entertained over
the years make their next-generation

console debuts in 2009, and the first of these is
Capcom’s stylish reincarnation of beat ‘em up
favourite Street Fighter. Street Fighter IV features a
refreshing art style, a few new characters, and
brings back the gameplay mechanics that made
Street Fighter II the pinnacle of this genre.

The most striking feature of Street Fighter IV
is its stylised 3D art direction. Environments
and characters are created in a uniquely arty,
comic book style, which somehow comes across
as both simplistic and intricately detailed.
Coupled with a resplendent colour palate and
presented in high definition, Street Fighter IV is a
visual treat that almost justifies the price of
admission all by itself.

But the game has a lot more going for it than
simply its eye-candy graphics. Most importantly,
Street Fighter IV is a thoroughly absorbing fighting
game, particularly when played against a human
offline opponent. The classic characters — Ryu,
Ken and co — return and the game also adds four
new fighters to the roster — Crimson Viper, Abel,
El Fuerte, and Rufus.

Is Vega throwing fire at Gouki Pyro style? Yes.

Is that the Incredible Hulk? No.

Is that an oriental fellow having a cup of tea? Maybe.

The classic characters bring with them their old
arsenal of moves and combos and all the characters
possess their individual strengths and weakness.
Learning them, mastering them and overcoming
them in your opponents is indeed a thrill and this
is the high point of the game. There are no two
characters in Street Fighter IV that can be considered
a mismatch; every fighter has within his/her arse-
nal the moves and combos required to beat every
other fighter and the key again lies in learning the
strengths and weakness, and of course, in memo-
rising the various combos. Unfortunately, blind
button mashing is also quite effective in this game,
but like every other fighting game, will only work
against an AI opponents, while a skilled human
opponent will break you down effortlessly.

One interesting aspect of Street Fighter IV is
that it still employs the traditional 2D camera,
while other recent beat ‘em ups such as Soulcalibur
IV and Virtua Fighter 5 allow side-stepping whereby
the player can switch the camera to a different
angle. This is absent in Street Fighter IV. Whether
that’s a good or bad thing is subjective, but you
will never miss being able to side-step in this game,
and that is a testament to Capcom’s ability to
deliver an immersive fighting experience even in a
2D arena. If nothing else, it will certainly please
the old school purists.

tionary here, Street Fighter IV is a fitting debut for
this much loved franchise on the PS3 and Xbox
360, and is sure to give the competition a run for
their money. �

Score : 4/5
Developer: Dimps/Capcom
Publisher: Capcom
Platforms supported: Arcade, Playstation 3, X-Box 360
Web site: www.streetfighter.com
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(or stances) from the last couple of releases has
been completely eliminated from the game as the
game seems to be moving closer to the original
system of kick and punches (high and low)
combined with special powers. The players in the
game are controlled using a combination of the
digital pad and the analog stick- for 2D and 3D
movement respectively. Overall, the game plays a
lot faster and the controls are well optimized to
work with game pads on both platforms. The most
significant additions to the combat system
however, are two new combat modes—namely,
‘Klose Kombat’ and ‘Aerial Kombat’. Grabbing the
opponent will zoom the camera close into the
action and triggers a mini-game where one player
has to anticipate the other player’s next move.
Similarly, certain attacks on your opponent will
cause him to free fall to the lower level of the
arena and you jump along to dish it out in mid-air.
Additionally, pushing the characters to the edge of
certain arenas will trigger the classic ‘test your
might’ mini-game, as you push your opponent
(breaking through walls) from one end of the
combat area to the other side.

One of the most enduring and iconic feature of
the Mortal Kombat games are the finishing moves.
These are however watered down mainly due to
the involvement of the DC characters (read Warner
Bros.) and their technique of bloodless fighting.
Each MK character (and the ‘bad guys’ of DC
universe) has two fatalities each, while the ‘good
guys’ of the DC world have something similar
called ‘Heroic Brutalities’. This is where the game
will make most MK fans feel wanting, considering
the fact that at one point, the developers were
thinking of eliminating finishing moves all

together to main a ‘Teen’ age rating for the game.
The guys at Midway have always maintained

that this release is not truly a MK release and this
fact becomes quite evident as you play the game.
The absence of other finishing moves (apart from
fatalities) and holding back on the blood and gore,
does make this game feel detached. Having said
that, the studio has done a reasonably good job of
blending the DC world into the MK universe— as
you can imagine it could have been a lot worse.
The new fighting engine is not perfect, but seems
to be heading in the right direction. One can hope
that they take the learning from this title and use
it effectively in the next true MK release.

Digital Leisure l Game On

Sameer Desai

Unlike most other fighting games, Mortal
Kombat (MK) has not shied away from re-
inventing itself significantly, every few

years or so. They did this with Mortal Kombat 3 and
the introduction of combo system and later moved
the game to a 3-D arena with Mortal Kombat 4. They
introduced fighting styles with Mortal Kombat:
Deadly Alliance and also released a couple of adven-
ture titles based on the MK characters and
universe. Now, although the latest iteration in the
series is technically not a pure Mortal Kombat title,

Ed Boon and company have once again changed
the fighting system of the franchise and

this time they seem to have nailed it
better than their last few attempts.

The single-player ‘Story Mode’
mode kicks off with a somewhat

plausible explanation of the
merger of the two universes.

Here the player has a choice
to fight on the side of either
the Mortal Kombat or the DC
universe. As you play

through the story mode, the game will pit you
against characters from both worlds and your play-
ing characters changes as the story progresses
through various levels (fighting arenas) set in both
worlds. This predictably continues till your battle
against the final boss of the game and true to MK
style, he deals out more damage and takes less of
it, compared to other characters in the game
roster. For beating the game, player is rewarded
with two unlocked character—one each for beating
the game on the MK and DC side.

In all, the game features a roster of 20 fighters
(ten on each side) and the two un-lockable char-
acters. Apart from the story mode, the game has
the customary single player arcade mode where
you fight your way up the ladder to encounter the
final boss. The game also supports head-to-head
two player fights, both online and offline. If you
have played MK games before, you’d expect plenty
of extra, un-lockable ‘kontent’; however, this title
has very little of that.

Coming back to the changes to the fighting
style, the developers claim to have completely
reworked the fighting engine. The fighting styles
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Score : 6.5/10
Developer: Midway
Publisher: Midway
Distributor: Milestone Interactive
Platforms supported: PS3, Xbox 360
Price : INR 2499/- (X360), INR 2799/- (PS3)

Pros:
Improved and promising fighting system
Good blend of two worlds
Decent collection of characters in the fighter roster

Cons:
Lack of extra content and limited single player
replay value
Watered down finishing moves

Ninjas make me really angry

I’d hit it... wait, I just did... pity its not a NinjaNINJAS.... MMMUSST.... DIE
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These protesters are
people who picket outside
the premises of any
building owned by the
Church of Scientology, over
issues like their
underhanded techniques
for curtailing protesters,
their belief of
homosexuality as a disease,
and providing financial
aids to anti-gay legislations.

The Church of
Scientology is by no means
harmless, and they have
powerful ways of stopping
protesters, both legal and
illegal. The Church of
Scientology has gone ahead
and enforce legal
restrictions on two
homosexual HIV+
protesters, one of whom is
himself an ex-Scientologist.
These protesters are not
anonymous and
anonymous, but Angry Gay
Pope and Happy Smurf. And

no, the aliens were not able
to cure Happy Smurf of his
“disease”.

GET PAID TO VACATION

Remember to
feed the fish

In what is dubbed the
best job in the world,
Australian Tourism

authorities will pay one
lucky person US $100,000
(Rs. 6,354,954) for blogging
about a fully paid six
month hiatus in Australia.
You can look up the details
and apply through
www.islandreefjob.com.
What are you expected to
do? Hang out at the beach,
get a massage or go
snorkeling in the great
barrier reef.
Understandably, the web
site received something like

two hundred thousand hits
within a day of going up.
The job itself has generated
a lot of publicity for the
employers. Your official
post will read out as “The
Caretaker of the Islands of
the Great Barrier Reef”, if
you get selected. Not only
will you be accommodated
on one of the important
islands, you will be given
permission to include
family or a friend. You can
apply for the job by sending
in a video presentation of
yourself. They have received
a bunch of submissions. The
deadline for entires is the
twenty second of February.
What are you waiting for?
We gave out the URL two
paragraphs ago. There is
one small catch though,
you have to have at least
one year prior experience,
but we are unsure how they
can expect that for a job
like this.

CENSORSHIP SO BIG, IT CAN
BE SEEN FROM SPACE

China almost
bans the web

China has a history of
a love-hate
relationship with

technology. What is normal
computer usage around the
world is invariably some
kind of a crime in China,
so every month has its
share of odd and
outrageous happenings.
This month’s China related
roundup includes a
massive crackdown on
porn, a crackdown on
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Those innovative guys
at Japan got together
and decided that the

internet did not give
enough of an olfactory
sensation to surfers. They
decided to take Google
maps, and add places to it
tagged with unique smells.
They are the Nio-Bu, the
connoisseurs of smell, and
they hang out at
www.nioibu.com.

The entire web site is in
Japanese, so you will have
to use Google’s translation
tool to make any sense of
it. Even in English though,
sense will be a difficult
thing to find. What you
will find though, is where
in the world you can smell
filthy roadside garbage,
cats with bad breath, spilt
wine on carpet, roasted
cow-dung or dry spit and

chai. For some reason, the
site assumes that all
grandmother’s houses
smell the same, but no one
has really taken the
trouble to refute their
claims. Not all the smells
are bad though, you can
check out a freshly
unboxed Mac, and
strangely enough, even
what our sun smells like,
right here on Earth.

You can add your own
odours to the list, and if
that does not occupy your
time, you can look at a list
of photos of people
“smelling the smell”. As of
now, there is no
mechanism by which the
website can actually let
surfers get a whiff of their
long list of strange odours,
but the Japanese act fast
when an idea strikes them.

ANONYMOUS COLLECTIVE
GETS REASON TO FLAME

Scientologists
against HIV+
protesters

Scientology has become
something of an in-
joke in the global

Internet community. Open
discussion across image
boards, forums and blogs
about the dubious
activities of the
scientologists, saw the
Church of Scientology
targetting individuals in a
number of cases. The
internet community
organised themselves into
the Anonymous Collective
(so that the Church of
Scientology could not play
hardball) and continued
circulating jokes online.
Also, real world protestors
(with hidden identities)
started displaying their
complete lack of sympathy
for the Scientologists.

The Church of
Scientology is notorious for
having a many-tiered
hierarchy, where you learn
and evolve towards your
inner immortal soul. The
Aliens have something to
do with it too, but no one
really knows exactly what.
By the end of it, you get to
be Superman, or Tom
Cruise, or something like
that. On the way there
though, you get a few
evolution points for
banning protesters against
their activities and beliefs.

Clean your teeth with photons
Throw out those tubes of toothpaste. That is what
Smart Miracle’s laser toothbrush suggests
anyway. Fry the germs and clean your teeth with
a laser beam - its just what all the cool people are
doing these days. And no, it won’t burn out your
eyes in case you cannot aim the beam properly.

WHAT’S THAT SMELL?

Smellists rejoice
Whatever
Happened To…

Google Lively

Most of us have now come
to accept that not
everything Google

touches turns to gold. Yes, there
are definitely some things Google
tried doing and well, didn’t quite
work out. One such ambitious
project was Lively a web-based
virtual environment launched by
Google sometime in July last
year. The idea was to create a
“chat experience” using avatars
in which one can communicate,
move around and interact in a
virtual world. Its almost as if
Google said “hey if Second Life is
doing it why cant we? Of course
there were differences — unlike
Second Life, the Lively users
could not buy and sell products.
Since there was no user-
generated content on Lively,
items such as hairstyles, clothing
and furniture were limited to a
catalog of pre-designed
selections. In Google Lively up to
20 people could occupy a room
and chat with one another. Text
appeared as cartoon-style
bubbles atop the avatars. Users
could design their own virtual
environments by hanging
YouTube videos and pics from
Picasa on the walls like pieces of
art. The rooms could be embeded
into blogs and Facebook pages.

But in November Google
announced on its blog that it
plans to shut down Lively by the
end of December. Calling it an
“experiment”, the blog goes on
to say “It has been a tough
decision, but we want to ensure
that we prioritise our resources
and focus more on our core
search, ads and apps business.
We’d encourage all Lively users
to capture your hard work by
taking videos and screenshots of
your rooms.”

Thieves in Japan, beware of the T-34
If the world is ever taken over by machines,
it is sure to start in Japan. Behold the latest
little toy that has rolled out from Japanese
factories - a robot patroller that throws a
net on any burgler that comes in its path.
The bot is controlled by a phone.

� HotOrNot.com becomes an iPhone app � Steve Jobs is hale and hearty, despite everything you have heard � Obama government relaxes privacy rules just for YouTube � Don’t know what to blog about? Go to www.plinky.com � Encyclopedia Britannica gets partially wiki-ised,

The ubiquitous touch
screen is seen in
almost everything

from ATM machines, PCs
to mobile devices to
perhaps even vacuum
cleaners! Well
refrigerators at least. Not
only did it make life easy,
it made everything fun.
Think of the i-phone.

Would it be the same
without its touchscreen?
Who doesn’t like a bit of
touchy-feely action right?
And we owe it all to Dr
Sam Hurst. He developed
the first “touch sensor” in
1971 while he was an
instructor at University of
Kentucky. This was not the
transparent touch screen
that we know of today.
This sensor called the
“Elograph” was patented
by The University of
Kentucky Research
Foundation. Dr. Sam Hurst
founded his company
‘Elographics’ (now Elo
TouchSystems) and
developed a transparent
touch screen in 1974 and
five wire resistive
technology in 1977, which
is the most popular touch
screen technology. In 1977
Elographics paired with
Siemens Corporation to
develop a transparent
version of the tablet on
curved glass so that it
could fit over a CRT
(cathode ray tube) screen.

People Who
Changed

Computing
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Dirty Sounding
Relax its only dirty sounding.
Dirty sounding names that is;
and a whole bunch load of
them! Visit
www.dirtysounding.com to
find a list of hilarious and
ahem dirty sounding names
arranged alphabetically; plus
militarily and foreign names
categories thrown in for added
enjoyment. Now the website
isn’t flashy at all, in fact its
nothing more than a gigantic
list. There’s “Dougie Style”,
“Harry S. Houle” “Harry
Ballsack” just to name a few.
We have a sneaking suspicion

that most of them are just
made up. But just imagine the
possibilities - prank phone
calls, radio phone ins, and
loads of other stuff, full Bart
Simpson ishtyle. Plus it can
keep you entertained for
hours. Well maybe not hours,
still an important resource to
bookmark.

Potty thoughts
Yeah we’ve all had them.
They’re ridiculous, of no real
use but yet surprisingly worth
thinking about. “Why do they
call him Donkey Kong if he is
not a donkey?” or “How come

all of the planets are
spherical?” Sometime’s
they’re downright twisted.
Take for instance – Do you
loose all of your hair in
chemotherapy? There are of
course no answers but head
over to
www.crazythoughts.com for
these and many more.

cybersex, and the Chinese
government recognising
web surfing as a “clinical
illness”. Read on.

China has some of the
toughest internet laws in
the world. However, despite
all the fine print, they
manage to leave out one
activity from the rulebooks.
A housewife by the name of
Li, decided to have a little
fun and teased people
online by showing them
video streams of herself in
the nude. She was dragged
into court because of her
activities, but was let free
when the judge discovered
that there was nothing in
the law they could actually
prosecute her with. Baidu
and Google, the two biggest
search engines in China
(surprisingly, in that order)
had to apologise to the
government for showing
too many links to porn sites
on their online portals. The
government had
specifically asked them to
remove all porn related
content from their web
sites, but the search
engines failed to remove
them. The government
retaliated aggressively,
threatening to punish and

shut down these web sites.
What followed was a string
of public apologies. The
Chinese government is
going right ahead with
plans to purify not just the
internet, but the mobile
networks as well.

While sending explicit
images and text over
mobile networks is already
an offence, what the
Chinese government is
looking to do now is to
implement a mechanism by
which they can actually
catch the offenders. How
exactly they will achieve
this is not clear.

A hospital in Beijing
probed 1,300 cases of
people too addicted to the
Internet (those who need
medication if they do not
go online), and decided to
define too much web
surfing as a clinical
psychological disease.

What is really scary
however, are the kind of
treatments those with this
disease can expect to
undergo. The Internet
addicted can expect
treatments like military
style discipline,
counseling, hypnosis and
electric shocks.

INSECURE MEN REJOICE

21 Century
Chastity
Belts

Gone are the days
when women’s
underwear had to

be secured with lock and
key to ensure their
chastity. Lucia Lorio, a
Brazillian lingerie maker
has rolled out a line of
lingerie with inbuilt
devices so that insecure
men can have their peace
of mind.

It looks as ugly as you
think it does (no, we are
not showing you pictures),
but is very functional on
multiple levels. First of all,
a man can program it and
keep track of the
movements of anyone who
wears the chastity belt.

Secondly (angry
feminists listen in), the
woman can turn the GPS
device off whenever she
wants. Thirdly, there is a
lot of demand for the
device... by women...
because they feel more
secure with it.

Wild Wild Web

Overclocking
Overclocking is the process of
running a computer component
at a higher clock rate than it was
designed for or was specified by
the manufacturer.
Clock Rate - Is the fundamental
rate in cycles per second -
measured in hertz - at which a
computer performs its most
basic operations.
FSB/HTT- FSB stands for Front
Side Bus, and refers to the speed
at which your processor can talk
to your memory.
In the AMD world, this is also
referred to as HTT, which stands
for Hyper-Transport Technology.
Multiplier - It denotes the speed
with which the processor does
its internal calculations. The
multiplier is a way of describing
the internal speed in relation to
the FSB. So if the FSB is 200 and
the multiplier is 10x, then the
processor runs at 200 x 10 =
2000mhz or 2ghz.
vCore - Is the voltage of the
processor itself. As overclocks
become unstable, you can use
this setting to increase the
processor voltage and make the
chip more stable.
vDimm - Is the voltage of the
memory. The memory can and
often will be overclocked as well,
and vDimm can be used to
increase stability in ram.
Monitoring / Stability Testing –
Tools such as RivaTuner, CPU-Z,
SpeedFan etc. allow you to
monitor things like
temperatures, voltages, fan
speeds, clock speeds, memory
settings, etc. Other software like
Prime95 and SuperPi, stress-test
the processor. These software
give you the necessary feedback.
Cooling - Overclocking leads to
high temperatures which must
be managed. Extreme
Overclockers rely on cooling
systems to bring down the core
temps. These systems include
include Liquid Nitrogen(LN2) and
Water Cooling etc..

allows user edits � It’s official — Vista’s biggest competition...is XP � Studies show that multiple cores slow down computing
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AMD Phenom II X4
After being thrashed by Intel
ever since the introduction of
their Core 2 Duo lineup in 2006,
AMD was never able to get back
on its feet. The infamous TLB
bug gave the Phenom
nightmares. Things started to
improve with the B3 revision of
Phenom. But the top end AMD
processors still competed with
Intel’s mid range processors.
Now, finally, AMD has released
the Phenom II 45nm based
processors. Along with Phenom
II, AMD has launched its
codename “Dragon” platforn, the
successor to the Spider platform,
which basically is a combination
of an AMD chipset and processor
and a ATi graphics card.
Compatibility.
Phenom II takes on Core i7
valiantly and does well too. It is
a great product and has plenty of
headroom for overclocking.
Dhruv Rajvanshi
http://think-tech.blogspot.com

Feature: 5 reasons to play
Dead Space
1. The Plot
The very story of Dead space is
wonderful. It is set in the future
where you battle re-animated
corpses while trying to repair a
space mining ship!
2. Graphics
The graphics of Dead Space
make use of the next generation
consoles and costly graphic
cards.
Each and every detail looks
good. The monsters look
awesome (in a gory and scary
sense) but it's the shadows
which make them really scary.
3. Limb Dismembering Action!
The gameplay involves lot of
cutting which really is fun once
you start getting used to
pouncing necromorphs. You get
to use your mining tools against
these monsters. Cutting limbs is
the fastest way to immobilize
them. There are also some
sequences when you get to do

the same in Zero Gravity! So
what’s the arm count?
4. Chill through your spine
This one of the games that
actually scared me.
Necromorphs are really
terrifying in the starting levels
but it goes to a whole new level
near the end. The sound effects
of the game are top notch and
play an integral role in
frightening you.
5. A true to life experience
There is no HUD in the game at
all which gives it a more
authentic feel. The health,
ammo, objective indicators are
integrated well into the game.
The camera is also very good
and you will hardly come across
problems with it. The physics of
the game also adds to the
experience.
So you're still reading this? Go
get your copy of Dead Space.

Vaishak V.K.
http://www.theregalgamer.com

Escape

KILLER I-PHONE APP

Runaway
snipers

Here is a little puzzle.
You get your hands
on a sniper rifle,

with the required
ammunition. You are also
given an iPhone, and a
target to eradicate.
Unfortunately, you have no
training in ballistics, and
you don’t know how the
ammo will behave over a
long range. How will you
eradicate the target?

You are right, it has
something to do with the
iPhone.

Runaway technologies,
has released an iPhone app
that gives you all the
experience you missed out
in sniper training camps
you never went to. The app
is called BulletFlight, and
this is how it works. You

feed in the distance to your
target, atmospheric factors
like wind speed, air
pressure and altitude. The
application calculates the
trajectory of the bullet and
gives you the results. The
app comes with three
common presets for Sniper
rifles, which are just letters
and numbers you have to be
crazy to recognise. OK, we
will throw them out here,
the M110, the SR16 and the
KAC PDW. If, however your

weapon of choice is a
different rifle, you can
manually configure the
application.

Increase the cool factor
of your iPhone by
purchasing the app from
the Apple iTunes app store –
for $11 (Rs. 540). The app
store is notorious for
removing and re-allowing
applications at random, so
if you want this one, get
your hands on it before
something develops.

� The Pope gives YouTube the thumbs up � Obama’s inaugration uploaded on Photosynth � Trolls crash into virtual wedding in AdventureQuest

Featured here are
snippets from some of
the best bloggers who
have registered at the
Blog Watch section on
thinkdigit.com.

If you wish to be
featured too, head to
www.thinkdigit.com/
blogger.php and
sign-up.

He-waste?
It was a pretty usual work day. Michael
and Siddharth(the new recruit) were on
one of their usual coffee breaks, when
Aditya walked very purposefully to a large
trash can. To the utter amusement of the
spectators, he started rummaging through
it furiously! It seems he was looking for a
DVD! Michael, never one to pass up such
an opportunity, told Aditya that there
were certainly a few DVDs in the trash
can, causing Aditya to dig even
deeper, and giving Michael a

chance to shoot a picture of the whole
thing. We’re not showing you the picture
here, but you can probably imagine it.

Issue closing was definitely not the
same this time, owning to the absence of
Vijay Padaya. He has emmigrated to USA
after eight long years with Digit. Vijay is
best remembered for keeping things on
track — usually by not letting us play Quake
3 when there was work to be done. He will

be sorely missed when we work,
and more so when we play.
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Which of these early
machines were

programmable?
a) A printing press
b) A Chinese incense clock
c) A textile loom
d) A mill

Software crackers packaging
audio-visual intros along

with cracked software gave rise to
which tech sub-culture?
a) Modscene
b) Artscene
c) Demoscene
d) Cargo Cult programming

In which work of fiction does
the word “nerd” originate

from?
a) Shakespeare’s Comedy of Errors
b) Lewis Carroll’s Alice in

Wonderland
c) Jean Cocteau’s The White Paper
d) Dr. Seuss’s If I ran the Zoo

What is the idea behind
pancomputationalism?

a) The universe is a computer
b) Open source, open standards,
and freedom based computing
c) All applications, games and user
data will one day be hosted
remotely
d) The eco-system on the earth is a
supercomputer

What are privacy-minded
individuals use cryptography

on a day to day basis for their on-
line activities known as?
a) Cyberpunks
b) Cypherpunks
c) Cyberphunks
d) Cypherphunks

Which of these operating systems
is based on Unix code?

a) Minix
b) Linux
c) FreeBSD
d) Mac OS

Which of these represents
the highest quality tag in a

pirated movie?
a) TELESYNC
b) R5
c) CAM
d) TVRip

Students and artists in
Denmark offer Vores Øl to

the internet community, what is
it?
a) Free Hardware
b) An open source car
c) Free Beer
d) Open source space satellites

What is the sci-fi title Anima,
released in 2007 based on?

a) World of Warcraft
b) Second Life
c) SIMS online
d) Naruto

7
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8

6

5
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3
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DOWN
1. Killing a player or a bot with a gun in a

combat FPS(4)
2. A beam of light that kills instantly (4)
4. A line of text in chat to indicate the

game is imbalanced(4)
5. Killing people with a single bullet in the

head in an FPS(8)
6. Very skilled player in a multiplayer

simulation game(4)
7. A sudden drop in gaming

performance(5)
9. Delay between a client computer and a

server (4)
11. A bunch of preset commands that

perform a particular or set of actions(5)
12. Strategy of staying in one place/hiding

and shooting(7)
14. An artificial opponant in a first person

combat shooter (3)
16. Ninjas in Pyjamas(3)

ACROSS
3. An bug or undesirable graphic error in a

game(8)
8. A contiguous environment for gameplay (3)
10. Intros put in by crackers before a cracked

version of a game(4)
13. A set of scenarios in a simulation or strategy

game(8)
15. The point on a map where a bot or player

appears when the game starts or during
gameplay(10)

17. A software that allows you to run a gaming
environment(6)

Crossword

Got an
interesting
question?
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area

When in doubt, go with option c.

What is the name of the
Penguin mascot for Linux?

a) Chuck
b) Tux
c) Pingu
d) Linus

1

Answers

1.a
2.c
3.c
4.d
5.a

6.b
7.d
8.d
9.c
10.b

Crossword by Nitaa Jaggi

Last month’s Winner
Kayomars Batliwalla

Send in your entries to
TQ@thinkdigit.com on or
by the 20th of this month.
One lucky participant
will win
Hacking for Dummies
By Kevin Beaver
Published by

Win!

January’s Solution

That Intel was
short for Intelligent

Electronics?

Did You
Know?
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You started the year on an excellent note.
It was one of the best issues of Digit.

The main story covering the evil face
of techonology was good. ‘Bomb alert’
included in Digital Business was mind
blowing. I really liked this issue and will
preserve it for a long time.

GPS devices tested are really
awesome. The ‘Agent 001’ is my special
favorite.

I am a regular surfer, so I have used
all the browsers, and I think it’s about
time you did a Fast Track to browsers.

Also, in the DVD, please try to
provide videos of the latest gadgets you
test. The games tested in this issue are
really good. Please don’t provide demo
games, as it drives me crazy and makes
me buy them.

Mayur Gaikwad

Those are some very valid suggestions, and we
promise to look into it. You might be surprised
with a few of your requests from the next issue
itself. As for your gaming enthusiasm, your let-
ter is sure to make some of our advertisers
very happy.

Team Digit

I am a Doctor in Anaesthesiology
working in the UK for last 5 years.

I came to India to visit my family
and had a long-ish stay this time. Hence
I found a bit of time to catch up with my
old favourites.

My brother introduced me to Digit
back when it was called Chip. Every
good thing seems to loose its quality and
looses its charm with time, but I am
quite pleased to see that Digit has
escaped this phenomenon. It is still as
good as ever! January issue was
absolutely fantastic and full of
information to keep us safe.

I was trying to buy the December
edition, but it was sold out. I am aware
that it can be ordered online, but it will
take about 5 to 7 days to reach me, and I
am leaving tomorrow, so I can’t buy it. I
do miss this magazine in the UK.
Although there are more such
magazines there, I love Digit for its
simplicity, easy language and its Indian
origins.

It will be very very useful for readers
like me to have an online subscription,
as then I could access the content from
anywhere in the world; plus I could save
some paper. The DVD content could be

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, KPT House, Plot 41/13, Sector 30,
Vashi, Navi Mumbai 400 703

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee iinncclluuddee yyoouurr ccoommpplleettee aaddddrreessss iinn aallll ccoommmmuunniiccaattiioonn.. 

For subscription queries 
send an e-mail to help@thinkdigit.com

downloaded from a member’s area as
well. Although some hardware
reviews might not be relevant for
overseas readers, all the rest of the
articles and information in the
magazine are absolutely priceless for
me as I am always short on time due
to my busy work schedule.  

Do you have any such plans in
pipeline? Please let me know.

Anyway, I must congratulate you
for your good work. Hope you manage
to keep it as good as ever.

Anurag Vats

We’re glad to hear from old readers, and
even happier when you still find us relevant,
after all these years.

We do have plans for online content
subscriptions, as well as international maga-
zine subscriptions, in the pipeline. You will
be the first to know when we do launch such
services.

Team Digit

I have been a regular Digit reader for
quite a long time... and I must say
that you are the best in the business. 

What i really like are the product
reviews especially the graphics card
reviews, but there is something more
that you can cover: you should also
state the minimum and maximum
power consumption of each graphics
card, so that we can choose the ones
that suit our needs best.

Apar Bhatnagar

That’s a very valid suggestion. Although we
do mention low-power consumption on
hardware (like motherboards), especially
where it is substantial, and also mention
when a card uses way too much power, we
will take your idea and start doing this on a
more regular basis. 

Team Digit

T hDigit — A Vector Quantity!

My first encounter with Digit
takes me three years back.
Then I was only interested in
the games hidden inside the CD.
As I grew, it was the freeware that
amused me. But now I have
realised that the greatest
knowledge lies in the precious
articles of the magazine. What
marvellous stuff you people
provide us with! The contents have
always been improving, and to a
large extent, after Mr. Henning
joined as the Editor-in-Chief. I
personally appreciate his
contribution. The web site content
together with the DVDs — all are
on the path of improvement.

Last month’s Fast Track on C++
immensely enhanced my
programming skills. The technical
help desk works perfectly in
accordance with its name, and has
given me full support whenever
needed. They too deserve a big
applause. 

But the greatest for me was the
January 2009 edition. Comparison
of the password strength with
entropy in “Pass the word...” was
excellent. I have always aspired to
become a System Security Analyst
in the future. I am already a hot
favorite among my classmates for
the security aspects of their PCs.
And now, at the crucial stage,
when I am in Class XII, the cover
story provided me with the right
direction.

Thus Digit has given me
magnitude and momentum to my
aspirations, as well as direction.
That’s why I called it a vector
quantity. I really thank you in
advance for shaping my career and
assure my best services to the
cyber community towards security.
Three cheers to Digit!

Manas Thakur,
Balaghat

M.P.

This is a fresh analysis of our content.
We always love to read e-mails from
our young readers, and are always glad
to help. We wish you all the very best in
your chosen profession. 

Team Digit

DIGIT FEBRUARY 2009 www.thinkdigit.com

I am a regular reader of Digit and it is
the first time I am writing to you. First
of all I congratulate you for being the
best tech magazine in India. You people
are really doing a great job. Your Tips &
Tricks, Q&A and Tech Talk are just
superb. I think the movies which you
give on your DVDs are too outdated and
are not worth watching, at least not for
me. You should provide some new and
popular ones if possible. Frankly I buy
your magazine only for the DVDs and
don’t much care about the magazine
except for a few sections. I appreciate
your packing which is better than
before. I have read many other tech
magazines but let me tell you, you are
far ahead of them.

Keep up the good work guys!!!

Varun Singh

We try to keep our content as fresh as possi-
ble. If there is a new movie from the open
source or copyleft community, you are sure to
get it from us first. However, most of the
films that are released into the public
domain, are old. That does not necessarily
mean that they are boring our outdated. The
Great Dictator we gave last time is an all time
classic, and Death Rides a Horse (this month’s
DVD) is a great western that can give contem-
porary cinema a run for its money. However,
your point is well taken.  

Team Digit

I am an avid reader of Digit, and have
been reading it for the past few years.

The best part of the magazine is
the “Your Questions, Our Answers”
section, which provides solutions to
the basic problems that most of us face
in our day to day life, while handling
our system.

Also, I liked the various articles on
preventing ourselves from getting
hacked, specially, the one named Social
Engineering Techniques.

Apart from that, This year, you
added a lot more stuff on your DVD also,
and that was quite impressive!

The softwares were fresh, and I
like trying new softwares. Being a
fresh Mechanical Engineer, I was
thrilled to find Auto CAD 2009 among
other CAD tools.

I would appreciate if you could also
arrange other reputed, basic yet
essential CAD tools for trial, such as
Pro/Engineer Wildfire, CATIA in your
forthcoming editions, and publishing
Fast Tracks on such tools, which could
help Mechanical Design Enthusiasts like
me, as well.

Another thing I noticed, some tools
marked as freeware turn up to be
shareware or trial versions, and have to
be uninstalled later.

Please take a note of that.

Shivanjan Choudhury

Thank you for the leg up. We will look into
including more specialist and enterprise soft-
ware in future releases of our DVD. 

Team Digit

A belated happy new year to you! Your
January issue was, as usual, awesome. I
am really terrified by growing use of
hi-tech gadgets like mobile phones, GPS
devices as reflected by your cover story.
The growing technology, which makes
me happy at times also terrifies me at
others.

You have also covered a similar
article in your December 2006 issue
named ‘You’re being watched’.

Please try to understand that your
mag is already expensive, and you
people are increasing the price even
more! But what to do? I’ll have to buy
it, even if you increase it to Rs 200, as I
love it so much!

Kshitij Rawat

Thanks for the vote of confidence, and
believe us, we really do not want to increase
prices unless absolutely necessary. We did
make sure to increase the number of content
pages, and also the extra DVD to ensure that
you still get complete value for money. 

Team Digit

I want you to please do me favour. I have
been a reader of Digit for 3 months, and
now my father and sisters have started
reading it too.    

But ours is a family of beginners in
the world of computers. I am the only
one who knows a little more than the
rest, and am often told that the many
computer related terms used in Digit are
Greek to them. Similarly, there are many
people who do not even know the ABCs
of computers.

I would like to see a new column in
Digit meant for beginners. If you do this, it
will be a boon to beginners everywhere.

‘Ravi Ranjan’ 

You have raised a very important point here,
and we can see why such a step is necessary.
All of us are aware about how confusing tech
terms can be to the non-initiated. You have a
great suggestion, and we will keep that in mind
for future issues. 

Team Digit

I am reading Digit since 2005, and
know firsthand how Digit achieved its
top position. Every change you have
done in the Digit is superb, but I still
want to suggest a few more. Your
procedure for taking feedback, by using
the feedback form was great, but make
it online as you all might know, no one
really posts anything anymore.
Secondly, please create a seperate
section for mobile phones in your
magazine, just 2 or 3 pages every
month. In this way, Digit will also
cover the needs of a mobile magazine,
since there are more mobile users than
PC users in India. 

I also must add that Digit is very
addictive magazine.

Shishir Priyadarshi
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January 2009 Issue

Letter 
of the
Month

Due to a clerical error, the contact details
for the XFX 9800GT on page 81, in this
month’s issue, are wrong. However, the
ratings for the product are correct. The
contact details were supposed to read:

Contact: Rashi Peripherals
Phone: 022-67090828
E-mail: response@rptechindia.com
Web site: www.rptech.com
Price: Rs. 10,000
We apologise for the error. 

CORRIGENDUM
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WITH ITS MOUNTAINS of petty and idi-
otic regulations, the European Union
(EU) is hardly my favourite organisation.
However, it sometimes get things right,
and recently started new legal action
against Microsoft for anti-competitive
practices. The focus of attention, as
before, is with Internet Explorer being
tied into the operating system.

This approach is the exact opposite of
the original vision described by Bill
Gates. Back in the days (18/19 years ago)
when a few journalists like myself used
to get to meet him and discuss these
things properly, Gates described his view
of the desktop of the future as being com-
ponent-oriented.

With this approach, instead of buy-
ing one or more large applications, you
buy much smaller ones, and then add
other “component” programs that pro-
vide the extra features that you need.

You might have a word processor as a
basic program that only formats text and
prints it out — very robust, with excellent
ease of use, good font-handling, etc. If
you should also want a spell-checker, the-
saurus, or some other add-on, you can
buy this separately, and it will integrate
fully with your basic word-processor.
These extra add-ons need not come from
the same software vendor.

You might well have a word processor
from Microsoft, a presentation applica-
tion from Corel, and a spell checker from
Adobe, that would work with the other
two and any other programs that needed
spell checks, such as your free-standing
(not OS integrated) web browser. The
operating system would provide the
object-oriented basis for this structure,
itself consisting of components.

There would be many benefits — you
would no longer clutter your hard disk
with functionality you don’t need, gener-
ally making much more efficient use of
system — i.e. your — resources; you could
tailor your system to precisely your own
needs, with large organisations creating
their own modules for specialist require-
ments. It would be highly scalable from
small portable systems to power-packed

workstations; this would stimulate
healthy competition and the smaller pro-
grams could be expected to be relatively
free of errors. We have instead been sold
inefficient bloatware.

Personally, I blame the hardware ven-
dors. They kowtow to the Microsoft line
far more than seems rational. Why?
Because hardware keeps growing in size,
far more quickly than genuine software
needs. By providing excessively bloated
software, Microsoft helps drive hardware
sales, and other application developers
have to follow suit because of the check-
box approach to functionality (feature
tables in magazines don’t exactly help in
this).

One trick that Microsoft and others
have used to force us to keep upgrading
has been constant changes in file format.
So, you are using last year’s version of
Word and you receive an email attach-
ment from somebody using this year’s
version. You can’t open it, and the pres-
sure is therefore on to upgrade, even
though the new version offers no new
functionality that you need. I am only a
very infrequent user of Word, and I can
honestly say that only two features useful
to me have been added to the software
since Word for Windows v.1.0a. We have
all fallen for this hook, line and sinker.

I used the word force in the last para-
graph because Microsoft has often been
accused of bullying tactics, and both the
news item about the EU and our current
review of netbooks highlighted this.

Scared of Linux — a much more flex-
ible and scalable operating system — tak-
ing over the netbook market, a few
months ago Microsoft made Windows
XP Home available together with
Windows CE for low-end devices. So why
only low-end? I once annoyed a Microsoft
person when I was testing Windows CE a
few years ago by saying that this was the
lean operating system I wanted on my
desktop. But that could not be allowed,
could it? It is not that Windows CE could
not easily be made to run on more pow-
erful machines than a netbook, or that
Windows XP could not run on the more

powerful PCs currently shipping with
Vista. Microsoft insists through its
licence agreements with hardware ven-
dors on strict limits to memory size, hard
disk size, and so forth. Have more than a
certain amount of memory, and you
can’t ship, for example, Windows XP, but
have to force your customers to take
Vista. To hell with customer choice. But
the effect is not always in Microsoft’s
favour.

As Linux improves and remains flexi-
ble and scalable, increasing numbers of
vendors are considering moving to it.
Give an average customer a Linux
machine with a Windows look-and-feel,
and most would hardly be able to tell the
difference. Microsoft’s bullying is begin-
ning to look like the best marketing tool
Linux could have. And Microsoft’s
response? Instead of more bullying, why
not go back to Gates’ original compo-
nent-oriented vision? Dream on...
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